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About This Manual 

This manual is divided into five sections, each describing a different 
application. 

~(DPY 

~ 
Copy II~ 

• Copy II is a utility that allows you to make disk backups of 
"copy-protected" software, as well as quickly formatting 
and copying non-protected floppy disks. It also features a 
powerful Track Editor for diagnosing and repairing disks, 
and allows technical users to find and examine copy 
protected tracks. 

~ 

~Hol 
Copy II@ Hard Disk 

• Copy II Hard Disk allows you to transfer some protected 
software to your hard disk, RAMdisk, or other Macintosh 
disk volumes. 

~ @ 0 
MacTools CPSDeleteTracking CPS TagFix 

• MacTools is a general disk and file utility with a variety of 
useful options, including three different kinds of file 
undeletion. MacTools can even undelete fragmented files. 

Mirror Rebuild 
'/,,, ",' @ 
, "',, '"' \, 

Mirror Rebuild CPSDeleteTracking 

• Mirror is an INIT and two applications (Mirror and Rebuild) 
that guard the data on your hard disk. Mirror automatically 



saves the "master plan" of your hard disk in a safe place. 
If your disk ever crashes, the Rebuild program can quickly 
reconstruct it from the master plan. 

LIJJ 
locatelM 

• Locate is a desk accessory that quickly finds files by 
name or keywords within the file. It allows you to copy 
and paste, append text to the clipboard, and create a list of 
found files. 

With both Finder and MultiFinder, Locate can search in the 
background while you use an application. With 
MultiFinder, you can launch the documents that Locate 
finds. 
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Installation Notes 

This manual assumes you are familiar with the basic concepts of the 
Macintosh, including such things as windows, pull-down menus, 
selecting with the mouse, etc. If you need to know more about 
these things, you should refer to your Macintosh owner's gUide. 

The program disk is not copy-protected in any way. You can make 
a backup of this disk using the Finder, Copy II, or any other 
standard Macintosh copy program. We encourage you to make a 
backup copy and put your original disk in a safe place. 

Note for Hard Disk Users: Don't copy the entire contents of 
your program disk onto your hard disk. Install the programs as 
follows: 

• All of the programs except CPS TagFix and CPS Delete 
Tracking can be copied to your hard disk in the usual way. 

• Install CPS Tag Fix and CPS Delete Tracking in the System 
Folder of your hard disk. 

Do not copy the System Folder of the program disk. 
Your Macintosh will start to misbehave if you install 
multiple copies of the System and Finder on your hard 
disk. 
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Introduction to Copy IT 

This manual describes Copy II, a disk backup application for the 
Macintosh computer. Copy II can make backup copies of your 
valuable software that have been "copy-protected," as well as 
copying standard unprotected Macintosh software. Copy II also 
features a powerful Track Editor for diagnosing and repairing disks, 
and allowing technical users to find and examine copy-protected 
tracks. 

What does CopY II do? 

Copy II makes quick, accurate copies of your disks. It's the same 
principle as using a tape deck to copy a record the first time you 
play it; you always have a clean backup if your original is damaged. 

Note: Under the copyright law, you are entitled to make backups of 
the software you own for your own use. You are not allowed to 
give or sell copies of copyrighted software to others. 

Some software companies, to prevent illegal duplication, "copy
protect" the information on their disks. Though the techniques used 
in copy protection are all quite complicated, the end result is that the 
protected disk cannot be copied using normal copy methods. This 
prevents illegal copies from being made, but it also keeps customers 
from being able to make legal, useful archival backups. 

Copy II is designed for copying these protected disks. It baSically 
transfers all of the information from one floppy disk onto another, 
so that the duplicate disk is a "carbon copy" of the original. If the 
original disk is copy-protected, the duplicate will be too. 

The Copy II application is prOvided to help you make backups of 
your copy-protected disks for your own use. It may not be used 
for illegal copying. 

Features of CopY IT 

Using Copy II is as simple as opening the Copy II application, 
clicking on the Start button, and inserting the original and duplicate 
disks. In most cases this is all you need to do to make working 
backups of your ,software. 
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You can make anywhere from 1 to 32,767 copies of an original 
disk. 

If you have a single drive and a megabyte or more of memory, 
Copy II copies disks without tedious "disk swapping." Copy II 
makes disk copying easy by making the best use of your 
computer's memory. 

If you have a second disk drive, you can copy from one drive to 
another; or use just one drive, if you like. 

Copy II provides two copy options. The Bit Copy option is useful 
for making backups of most protected software as it makes very 
few assumptions about the format of the disk it's copying. The 
Sector Copy option can make fast, reliable backups of standard, 
unprotected Macintosh disks, and is also designed to handle a few 
special, but widely used, copy-protection methods. [[he Backup 
List has information about which option to use in backing up most 
applications.) 

In a few cases, Bit Copy and Sector Copy can be used together to 
make a more reliable copy than either option can alone. A couple of 
other options are also available which can help back up a few 
specific disks, but otherwise slow the copy process down. 

Copy II cannot copy onto hard disks. Hard drives store and 
retrieve information in a different way than floppy drives. Disk 
copying from one to the other simply doesn't work. If you want to 
copy individual applications and documents onto a hard disk, you 
can use either the Copy II Hard Disk application or the Copy Files 
option found in the MacTools application. (See the manual sections 
on Copy II Hard Disk and MacTools.) 

System Requirements 

Copy II runs on any of the following machines with System 
Version 3.2 or higher: 

• Macintosh 512K, 512KE 
• Macintosh Plus 
• Macintosh SE 
• Macintosh II 
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MultiFinder™ 

Copy II is compatible with MultiFinder and RAM caching, but does 
require a megabyte of free memory to copy BOOK disks at full 
speed. 
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Installing CoPy II 

There are no special requirements for installing Copy II. It can be 
copied to a floppy or hard disk in the same way as any other 
program. 

Hard disk installation 

1. Insert the program disk and click on its icon. 
This opens the program disk window. 

2. Drag the Copy II icon onto the hard drive window. 

Note: If you are copying several applications onto your 
hard disk at once, do not copy the System Folder onto 
the hard disk. Your hard disk system will start to 
misbehave if you install multiple copies of the System and 
Finder by mistake. 

Backing up on a System disk 

We recommend you make a copy of Copy II on a disk with a 
System folder. Store the original program disk in a safe place. 
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Using CopY II 

To use Copy II: 

1. Double-click the Copy II icon. 
This starts the Copy II program. 

~(DPY ... ~ 
Copy II@ 

After showing an important notice, the Copy II main screen 
will appear. 

• Control Options 

COPY 118 fOI" the Rpple Mocintosh® 

Start :1 
''----It' 

S10JI 

0l"igin01 Drive: @ Intel"nol 

o EHtel"nol 

Duplicote Drive: 0 Intel"nol 

@ EHtel"nol 

Messoges: 

@ Bit Copy 

o Sector Copy with formot 

o Sector Copy no Format 

o Trocle Editor 

Stort Trocle :~ @ HOB 

End Tracie: [22] 0 H @ B 

~ BOOK Copy 

I I 
Copy Status 

1 0 1 2 3 4 5 6 7 8 9 0 1 2 3 4 5 6 7 8 91 

:~IIIIIII IIIIII1111111 
Note: The exact options you see depend on how many and what 
kind of drives (400K or BOOK) you have. The details are discussed 
in the next section. 
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CoPY II menu commands 

The first thing to notice is the menu bar at the top of the screen. If 
you choose the Apple pull-down menu, you can see that all of the 
usual Macintosh desk accessories are available. You will also see 
three new options. About Copy II is a copyright message for the 
Copy II application. About Features is a reminder of what 
options you have available in Copy II. And, About Backup List 
is a reminder to reference the Backup List program if you have 
problems backing up a particular program. 

The only command available from the control menu is Quit. 
Choose Quit whenever you want to quit out of the Copy II 
application and return to the Finder desktop. 

The Options menu contains several commands. The first two 
commands, Keep Track Length and Synchronize Tracks, 
allow you to configure the Bit Copy operation. The Multiple 
Copies. .. command allows you to select the number of copies to 
be created by Copy II. And, the Clear Status Display allows 
you to erase the information in the Copy Status box in the main 
screen. 

Making a Backup 

Copy II works by reading some of the information from the original 
disk it's copying, then writing that information onto the duplicate 
disk. It alternates this reading and writing process until the entire 
disk is copied. 

The amount of free memory is affected by MultiFinderts Size 
command or the amount of RAM cache that is allocated. For best 
results, turn the RAM cache off and run Copy II by itself. 

Before Copy II will back up a disk, it will first insist that the disk be 
locked or write-protected (which is not the same as copy
protected). To lock a disk, slide the small tab in the corner toward 
the edge of the disk, uncovering the hole. To unlock a disk, slide 
the tab back so the hole is covered again. 

Locking a disk guarantees that the computer cannot write or change 
any information on the disk. Suppose that, while using Copy II, 
you aCCidentally inserted the original disk at the wrong time, or into 
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the wrong drive. Even if this happens, the information on your 
original disk cantt be hurt, because the disk is locked. 

Start Copy 
In the top of the Copy II window, youtU see two buttons labeled 
Start and Stop. The Start button starts the copying. [fhe Stop 
button is 'dimmedt right now because there isntt any copying to 
stop.) 

Stop Copy 
If you want to stop the copying before if s finished, click the Stop 
button. Copy II may continue for a couple of seconds more if if s 
busy reading or writing, then stop and display the message: "Copy 
stopped!)! 

Copying 

To make more than one copy, select Multiple Copies ••• from the 
Options menu before starting. 

Copy II is already set up for you to begin copying most disks. 
When you want to copy a disk, click on the Start button and Copy 
II ejects any disks currently in the drives. To continue, refer to the 
One-drive and Two-drive procedures. 

One-drive Copying 

If you have one drive, a message appears in the messages box 
near the bottom of the screen: "Insert Locked Original Disk In 
Internal Drive.)! Make sure the disk you want to back up is locked. 

To copy a disk using one drive: 

1. Insert the locked Original. 
You hear Copy II read the disk. 

Copy II ejects the disk and prints a new message: "Insert 
Duplicate Disk in Internal Drive. n 

2. Insert the blank (or reusable) disk. 
You now hear Copy II write the disk. 
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• If you are only making one copy, the disk is ejected when 
copying is finished. You see the message: "Backup 
complete!" 

• If you are making more than one copy, you'll see a prompt 
to insert another destination disk. Continue inserting and 
removing new disks until you see the "Backup complete!" 
message. 

3. Select Quit from the Copy II menu. 

Note: Step 2 has several additional steps of "disk-swapping" if 
your Macintosh has less than a megabyte of free memory. Copy II 
prompts you for the Original and destination disks as necessary. 

Two-drive Copying 

If you have two or more drives, messages appear in the message 
box near the bottom of the screen telling you where to insert the 
original and duplicate disks. Make sure that your original disk is 
locked. 

To copy a disk using two drives: 

1. Insert the locked original. 
You hear Copy II read the disk. 

2. Insert the blank (or reusable) destination disk when you see 
the prompt. 
You now hear Copy II write the disk. 

• If you are only making one copy, both disks are ejected 
when copying is finished. You'll see the message: 
"Backup complete!" 

• If you are making more than one copy, Copy II ejects the 
first destination disk. 

You see a prompt to insert another destination disk. 
Continue inserting and removing new disks until you see 
the "Backup complete!" message. 

3. Select Quit from the Copy II menu. 
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CopY Status 

The information stored on a Macintosh disk is divided into 80 
circular tracks, numbered track 0 to track 79. (On 800K disks, 
each track is further divided into two sides, which we call side A 
and side B.) Notice that, as Copy II backs up a disk, it displays in 
the messages box: "Reading track ... " or "Writing track ... ," with the 
track number it's currently reading or writing. This keeps you 
informed of what Copy II is currently doing. 

If any errors or problems occur during the copy, an error message 
is also displayed in the "Messages" box. This message shows the 
block and track number where the error was found. 

In addition, information about all of the copied tracks is kept in the 
Copy Status box. The Copy Status box has positions for all 80 
tracks: 4 rows with 20 tracks per row. 

For every successfully copied track, a dot appears. (When copying 
800K disks, two dots appear for each track, one for each side of 
the disk.) If there is an error copying a track, a letter appears 
instead. 

For example, if tracks 0 through 23 have been copied and a read 
error happens on track 17, the Copy Status box would appear like 
this: 

Copy stotus 
0 1 2 3 4 5 6 7 8 9 0 1 2 3 4 5 6 7 8 

0 R 
20 
40 
60 

The letter indicates the nature of the error. 

R Read error 
If this happens on every track, it means the original disk is probably 
blank. 

9 
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If this happens on only one or two tracks, then a portion of the 
disk may be copy-protected, or there may simply be a problem on 
that part of the disk. 

W Write error 
This means the duplicate disk probably isn't formatted correctly on 
every track. Try Sector Copy with Format. 

V Verify or "Unable to format" error 
This usually indicates some kind of media problem with the 
duplicate disk. You should try a different disk. 
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CoPY II Options 

This section describes the other options available in Copy II and 
what they're used for. Additional options become available if you 
have one or two BOOK (double-sided) drives. These extra options 
are discussed at the end of this section. 

Bit Copy and Sector CopY 

When Copy II is first started, the Bit Copy method is already 
selected. You can switch to the Sector Copy method by clicking on 
either Sector Copy with Format or Sector Copy no Format. Clicking 
on Bit Copy will switch back to the Bit Copy method. 

@ Bit Copy 

o Sector Copy with Format 
o Sector Copy no Format 
o Track Editor 

Sector Copy matches the way the Macintosh usually reads and 
writes to the disk in everyday use. Because it 'assumes' that what 
it's copying is in a normal Macintosh format, it makes a special 
effort to be sure that everything on the disk is exactly as it should 
be. This makes for very reliable copies. It will copy some protected 
disks, but it cannot backup disks that differ too far from the normal 
Macintosh format. 

Since Sector Copy can write only onto formatted disks, you can 
select Sector Copy with Format or Sector Copy no Format. If 
you're sure that the duplicate disk you want to copy onto is already 
formatted, selecting no Format speeds up the copy process a 
little. Otherwise you should select with Format, so that Copy II 
formats the duplicate disk before it copies. 

Bit Copy is designed for copying nearly all copy-protected disks. 
Because of the widely varying protection schemes possible, Bit 
Copy makes very few assumptions about the information if s 
copying. 
It simply 

1) reads the information from the original disk, 
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2) makes enough sense of it so that it can write it correctly, 
3) then writes it to the duplicate disk. 

Bit Copy can copy many more disks than Sector Copy. 

Bit Copy formats the duplicate disk as it copies, so the disk does 
not have to be formatted ahead of time. 

Whenever you click on the Start button, Copy II uses the method 
you selected. 

Original Drive and Duplicate Drive 

Below the Start and Stop buttons are options for Original Drive: 
and Duplicate Drive:. The original drive is where you put the 
disk you're making a copy of. The duplicate drive is where your 
copy is made. What appears in the window depends on how many 
drives you have. 

Original Drive: @.Internal 

o EHternal 

Duplicate Drive: 0 Internal 

@ EHternal 

If you have one drive, then only one option labeled "Internal" 
appears on each line. Since only the internal (built-in) drive is 
available, Copy II uses it for both original and duplicate disks. 
Clicking on the options has no effect; they both remain selected. 

If you have more than one drive, you'll see choices for each drive, 
Internal and External (Internal Lower and Internal Upper on a 
MaCintosh SE with two internal drives, or Right Internal and Left 
Internal on a Macintosh II). Copy II displays options only for the 
drives that are actually connected to your Macintosh. 

Internal is usually selected for Original Drive, and External is 
selected for Duplicate Drive. This means Copy II copies from the 
internal (bUilt-in) to the external (second) drive. If you want to 
change this, just click on the options you want for original and 
duplicate drives. 
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Start Track and End Track 

The information stored in Macintosh disks is recorded in 80 circular 
"tracks," numbered 0 through 79. With a Start Track of 0 and an 
End Track of 79, Copy II copies all 80 tracks of the disk. You can 
also copy a range of tracks if you want, though you usually won't 
need to do this. 

Start Track :~ @ ROB 

End Track: 1791 0 R @ B 

To change the Start Track and End Track values, click the mouse in 
the box you want to change. The number becomes highlighted 
(displayed white in a black box). Type in the new track number you 
want, then either press the Return key or click the mouse 
somewhere else in the window. 

If you type a bad number, then the original value (either 0 or 79) 
reappears, the speaker beeps, and a message tells you what was 
wrong (for example, if you typed a number greater than 79 or 
typed something other than a number). The Start Track must also 
be less than the End Track. If the Start Track is greater, you'll get 
an error message when you click on the Start button. 

If you want to copy a single track, sirriply set both Start Track and 
End Track to that track number. 

The Options Menu 

The Options menu has several options available: 

Keep Tn.ck length 
Synchronize Trocks 

Multiple Copies ... 

Clear Copy Status 
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The Keep Track Length and Synchronize Tracks options are 
available only when you use the Bit Copy method for copying a 
disk. You'll see a checkmark beside an option if it's selected. 

Keep Track Length 

Because disk drives will not spin at exactly the same speed all the 
time, the number of "bytes" of information that can fit on a track 
(called the "track length") will vary slightly. When Copy II copies a 
disk, the track length on the duplicate disk it makes may be a little 
different than on the original disk. This is usually no problem, 
because normal reading and writing takes these slight variations into 
account. 

However, there are a few protected programs that check for the 
exact track length on one or more tracks of the disk. If the track 
length is changed, then the protected program "knows" that this is a 
copy and not the original disk, and refuses to run. 

If you choose the Keep Track Length option before doing a Bit 
Copy of the disk, Copy II will make subtle changes to the 
information as it writes, so that the track length will be correct even 
if the disk drive speeds are not exact. This will help copy those 
programs that check track length. 

Choosing Keep Track Length slows the copy process down a little, 
and the minor changes it makes could conceivably affect other copy 
protections (though this would be rare). In other words, you may 
not want to use the Keep Track Length option all the time. (See the 
note below, under "BOOK Drive Options," about using Keep Track 
Length with Apple-brand BOOK drives.) 

Synchronize Tracks 

Another thing that a protected program can check for is the 
positioning or alignment of the information from one circular track to 
the next. Most copy programs copy all of the information on a 
track, but do not maintain the alignment from one track to the next. 
A change in alignment is never noticed unless a protected program 
specifically checks for it. 

If you choose the Synchronize Tracks option, then do a Bit Copy 
of a disk, Copy II will maintain the track-to-track alignment as it 
copies. This will help copy those programs which check the 
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alignment. The Synchronize Tracks option also slows down copying 
somewhat, but does not cause any problems otherwise. 

Multiple Copies 

Select Multiple Copies ... from the Options menu and you see a 
dialog box asking how many copies you'd like. 

How many sector copies would you like to 
make? (1 - 32767.) 

I. 
OK Cancel 

Clear Copy Status 

The Clear Copy Status option clears out all of the status 
information from the Copy Status box. You may want to clear the 
Copy Status before copying a range of tracks so you're not 
confused by status information from a previous copy. 

800K Drive Options 

Copy II can accommodate any combination of 400K (single-sided) 
and BOOK (double-sided) drives. The disks you can copy are 
determined by your drives: 

• An BOOK drive is capable of reading, writing, and 
formatting both BOOK disks and 400K disks. 

• An 400K drive can work with only 400K disks. It cannot 
handle an BOOK disk. 

Since Copy II makes an exact duplicate of a disk (including its size), 
the duplicate disk must always be the same size as the original. 

If you have only one BOOK drive, then to make an BOOK backup, 
you'll need to use this BOOK drive for both Original and Duplicate. 
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If you have two BOOK drives, the SOOK Copy box is already 
checked for you to copy BOOK disks. Make sure this box is 
checked if you are copying an BOOK disk. If it isn't, the resulting 
duplicate disk will be missing much of the information it needs to 
work correctly. 

If you want to make a copy of a 400K (single-sided) disk, click on 
the SOOK Copy box to remove the check. If you leave this box 
checked, Copy II will remind you the BOOK option is not necessary 
to make a 400K copy. 

Note: Because of hardware differences, Apple's BOOK drives 
cannot carry out Copy II's Track Length adjustments as readily as 
400K drives or most third-party BOOK drives. If you're using the 
Keep Track Length option or if you're getting "L" errors when 
copying a disk, we suggest you use something other than an 
Apple-brand BOOK drive as the Duplicate Drive, if at all possible. 
This will produce a more accurate, reliable backup. 

If you need to recopy just a portion of an BOOK disk, notice that 
the Start Track and End Track options include selections labeled A 
and B. As mentioned earlier, on BOOK disks, each of the BO 
circular tracks is further divided into two sides, which we call side 
A and B. When doing an BOOK copy, Copy II must back up both 
sides of each track. 

Copying an entire BOOK disk involves copying with a Start Track of 
O-A and an End Track of 79-B. To copy just a portion of an 
BOOK disk, you can select which track and side to use for Start 
Track and End Track. 

Note: A common misconception about BOOK disks is that you can 
disk-copy two 400K single-sided disks onto one BOOK double
sided disk, one onto the top and one onto the bottom of the disk. 
The Macintosh drives don't work this way. For each physical disk, 
only one disk icon can appear on the Finder desktop. The 
Macintosh can't recognize "two-disks-in-one." It's better to think of 
double-sided disks simply as disks that can hold twice as much 
information, and not be concerned with when the top and when the 
bottom of the disk is being accessed. 

If, instead, you want to copy two or more application files onto a 
single disk, the Copy II Hard Disk application can back up a 
number of popular copy-protected applications onto a hard disk, 
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RAM disk, 400K or SOaK floppies. (See instructions on Copy II 
Hard Disk for more information.) 

Notes on Backing Up Disks 

When backing up a protected disk, the copy may run normally even 
if an error occurred while copying. Conversely, it's possible for a 
backup to fail even if there were no errors during copying. This is 
because of the complicated protection methods used on some disks. 
The best test in every case is to simply try running the program to 
see if it works. 

Possible Errors 

When the Sector Copy method is selected: 
R Read error 

If this happens on every track, it means the original disk is 
probably blank. 

If this happens on only one or two tracks, then a portion 
of the disk may be copy-protected, or there may simply be 
a problem on that part of the disk. 

W Write error 
This means the duplicate disk probably isn't formatted 
correctly on every track. Try Sector Copy with Format. 

V Verify or "Unable to format" error 
This usually indicates some kind of media problem with the 
duplicate disk. You should try a different disk. 

When the Bit Copy method is selected: 
R Read error 

Means that Copy II is having difficulty making sense of 
this track. Copy II will do its best to correctly write the 
track onto the duplicate disk anyway. 

This also occurs if the track is completely blank (has never 
had any information written onto it). 

V Verify or "Unable to format" error 
This usually indicates some kind of media problem with the 
duplicate disk. You should try a different disk. 
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L Keep Track Length error 
Means that Copy II could not maintain the track length on 
the duplicate disk after several tries. 

S Synchronize Tracks error 
Only occurs if the Synchronize Tracks option was selected. 
This usually means that track 0 hasn't been copied onto 
the duplicate disk yet. If you're copying different ranges of 
tracks, and using the Synchronize Tracks option, be sure 
to copy the range that includes track 0 first. 

Using Sector Copy with Bit Copy 

Most Macintosh applications on the market today use a strange 
copy-protection format on only a few tracks of the disk. The rest of 
the disk is usually in a standard Macintosh format. Then when you 
start up the application, it begins by checking those strange tracks 
to make certain they haven't been changed at all. 

What this means is that you can often use the Sector Copy method 
to make a fast, reliable copy of most of the tracks on a disk. If you 
copy a protected disk with Sector Copy and get Read errors on 
only one or two tracks, first try the backup. If that doesn't work, 
then go back and use Bit Copy to recopy just the bad tracks back 
onto the same duplicate disk. The backup may now work, and the 
copying was faster since Sector Copy was used for most of the 
disk. 

A Checklist 

A few commercial software products use particularly nasty 
protection schemes which a straightforward Bit Copy may not 
duplicate correctly. Here is a checklist of things to try in backing up 
these disks. 

1 . Refer to the Backup List on your Copy II disk to see if 
there are any special instructions for the program you are 
copying. Often these special instructions provide the only 
way to successfully make a backup of that particular 
program. 

2. Next try copying using Bit Copy, without changing any 
options. 
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3. If that copy doesn't work correctly, try Sector Copying the 
disk. Then, if there are errors on any tracks, recopy just 
those tracks onto the same duplicate disk using Bit Copy. 
([he Start Track and End Track options let you select a 
single track or a range of tracks to copy.) 

4. Try recopying those same tracks again using Bit Copy, 
after selecting Keep Track Length from the Options menu. 

5. Try copying the entire disk using Bit Copy, after selecting 
Synchronize Tracks and/or Keep Track Length from the 
Options menu. 

If none of these suggestions work, you might want to write us a 
quick letter about it, so we can continue to improve our product. 
Also, if one method for backing up a disk worked particularly well 
for you, you might want to let us know about that, too. Please 
include: 

• The name of the program you were copying 
• The publisher's name 
• The version number, if any 
• What you tried 
• Exactly what happened if the backup didn't work. 

Address your letter to: 
Central Point Software, Inc. 
15220 NW Greenbrier Parkway, Suite 200 
Beaverton, OR 97006 
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Track Editor 

The Track Editor is a special feature of Copy II which enables you 
to repair damaged sectors, and allows technical users to find and 
examine copy-protected sectors. The Track Editor reads and 
displays data contained on each track of a disk. 

About Recovering Using Resource Forks 

All levels of users can easily use the Track Editor to repair damaged 
sectors and to recover data on those damaged sectors. More 
advanced users may want to use the Track Editor to perform 
additional sector repairs beyond the scope of the built-in checksum 
recalculator. . 

The Track Editor documentation has two parts: 

• Repairing Damaged Sectors and Recovering Data 
This section gives the basic steps for repairing damaged 
sectors and recovering data from those sectors. 

• The Track Editor (for Technical Users) 
This section is for the more technical user who wants to 
perform additional sector repairs and wants to know how 
Macintosh disks are recorded. 

We recommend that you use the Track Editor to read off the locked 
original disk, and write onto a copy. If you write only to the copy, 
you are free to try something else if your first attempt at a repair 
doesn't succeed. 

Note: Whenever you select the write option of the Track Editor, 
confirm that you are writing the copy, not the original disk. 

Do not use the Track Editor to "repair" damaged tracks on a copy 
protected disk. Attempting to "repair" a copy protected track will 
probably modify the data in the track and make the disk unusable. 
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Repairing Damaged Sectors and Recovering 
Data 

Finding and repairing damaged sectors is easy with FastCopy's 
Track Editor. To find and repair damaged sectors you perform the 
following tasks: 

1. Lock the damaged disk, then copy it with Copy II. 

2. Determine the bad block, track, and sector number of the 
damaged disk. 

3. Start the Track Editor. 

4. Read the track off of the original and analyze it. 

5. Doublecheck that the error is on that track, using the 
Inspect Track command. 

6. Display the block. 

7. Correct the error. 

B. Write the corrected information to the copy, not to the 
original damaged disk. 

The following example walks you through the procedures for 
finding and repairing damaged sectors. 

Example - Repairing a Damaged File 

In this example, let's suppose an important file on one of your disks 
has become unreadable. You would perform the follOWing steps to 
repair the problem: 

Caution: Copying and moving track data from one disk to 
another is possible only when both disks are of the same type 
(400K to 400K, or BOOK to BOOK). Mixing disk types renders the 
data unreadable by any program. 
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To copy the original disk: 

1. Start Copy II by double clicking on the Copy II icon. 

2. Click Start. 

3. Lock the disk with the damaged block and insert it into the 
disk drive. 
Copy II reads the disk. Wait for Copy II to eject the 
original disk. 

4. Insert a blank disk. 
Use this copy for all further editing steps. 

5. Choose Quit from the Control menu. 

To find the damaged block: 

1. Start MacTools by double clicking on the MacTools icon. 

2. Insert the original disk with the damaged block. (Make sure 
this disk is locked.) 

3. Select the Verify Disk command from the Disk Menu. 
This command scans the disk for errors. 

As Mac Tools verifies the disk, you see a message similar 
to: 

~ Error in block number: 286. 

~ The error is: -72 . 

(continue) I[ EHit )) 

This tells you in which block the error occurred and the 
type of error. 

4. Using the "Track Sector Lookup Table" in Appendix A, 
refer to the table for your disk (400K or BOOK). Find the 
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block number in the chart, then look to the left for the track 
number and to the top for the sector number. 

On the 400K disk used in this example, block 286 is track 
24, sector 6. 

5. Exit MacTools. 
Select the Quit command from the Control Menu. 

Note: The following procedures describe how to correct error ID 
numbers -69 and -72 only. If you get a different error ID number, 
see the section "The Track Editor (for Technical Users}." 

To Start the Track Editor: 

1. Start the Copy II program by double clicking on the Copy 
II icon. 

2 . Select the Track Editor option on the Copy II startup 
screen. 

3. Click the Start button. 

When the Track Editor begins, the display shows the first 
track and side of the disk in the original drive. The default 
for the Track Editor display is the last track number and 
side selected. For information about relating tracks to 
sectors and blocks, see the "Track Sector Lookup Table" 
in Appendix A. 
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=0 T ... ock Edito ... 

~ Vol:System Disk Size:800K Drv:lnternal Spd:8mHz 

0000: 9C B7 07 B9 EF E9 AD FF 97 BO 94 F3 F6 96 F7 F9 ~ Track: 0 
0010: A5 BB EB AB AD FF FF 90 CE CF 9E F5 F6 FC F6 F5 Side:A 

0020: B3 CE BC AD FE FO F6 CE FB E5 9E F6 CF FB FA B7 
0030: AD BF 03 OF CD FO FF OF CB CF 03 E9 BC B7 B3 OA Track 
0040: CF FA CF FO 9B B3 BC BC 97 AD F9 CD B9 FO DE OF length: 
0050: 90 B3 E6 A6 EO F6 FO EE F8 9A 9E F7 B3 F3 96 9A 0 
0060: F5 FC E9 B3 FO OF AB F9 06 A7 9F F6 B2 BO EE BO 
0070: F7 EB B9 AC BA EC F5 C8 E8 EC B2 EC 97 B2 07 F4 Track 
0080: 9E 90 FC CD BB 06 BF BC BE DO 96 ED B4 07 DC BE Start: 

0090: OA AF E5 AB 9F F6 FO BO 96 F6 E6 AB A6 F7 E5 07 0000 

OOAO: B2 F7 E6 97 CF FA E6 9F BF DB OA B6 FA E9 E7 B4 Track 
OOBO: E7 ED E7 EF B9 CB F4 EC AD OF AB CF E7 07 CB F2 End: 

OOCO: BD B5 AB BF EA BF B3 B9 B4 E6 F6 BA AE B9 FF A7 
7130 

0000: B6 DB A7 DA FC BF CE B3 B5 F2 B2 F3 EB E6 E5 CB Write 
OOEO: EA 90 B6 OF EA ED B7 OA 9F 9E 96 96 B9 BF 03 A7 Track 

From: 
OOFO: 96 AC F6 B6 CB 9E FC DC 03 BA CB A6 EC EF A7 A7 ~ 0000 

The Track Editor screen shows the raw data read off the disk. For 
more information about the screen display, see the "Track Editor for 
Technical Users" section. 

To read the track that contains the damaged block: 

1. Confirm that you are reading the disk with the bad block. 
Does the name at the top match the disk name? Is the disk 
locked? 

• If it doesn't match, eject the current disk by pressing 
Command+E. Set aside the ejected disk and insert the 
copy of the bad disk. 

• If the name matches the copy of the bad disk, proceed 
with the next step. 

2. Select the Read Specific Track command from the View 
Commands menu. 

3. Type the track number in the edit box. In this example, 
24. 
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Type in TRACK NUMBER (0-79) and select the 
SIDE ,..ou wish to read. 

§] @R OB 

OK) Cancel) 

4. Click OK. 

5. Select the Analyze Track command from the View 
Commands menu. The track editor selects the beginning 
and the end track length and marks it for the track. 

D Track Editor 
~ Vol:0emo Size:400K Drv:lnternel Spd:8mHz 

0010: FFIIFF FF FF FF FF FF FF FF FF FF FF FF FF FF 
0020: IOFFIOFF FFIIFFIO 
0030: FFIIFFI"".'.IFFID 
0040: IilDFF'.I.I.I.IFFIiFFIDFF FFI".'.I 
0050: ID FF , ••• 1.1 FF FF ,.1.1.1.1 FF FF FF iii FF 
0060: FFI.'.'j'.IFF'jl.'j'.IFFIDFFIDFF FF 
0070: 1 •••• i'.IFF •••• ij'.IFFljijiiiFF FF FF 
0080: Ij'iiiIFF •• I.i.I.IFF'jiiliIFF FFIiID 
0090: IilDFFIDFFIiFF FF 05 AA 96 BO 96 96 9A BF 
OOAO: DE AA FF Ij'il.1 FF FF 05 AA AD 96 96 96 96 96 
OOBO: 96 96 96 96 96 96 96 96 96 96 96 96 96 96 96 96 
OOCO: 96 96 96 96 96 96 96 96 96 96 96 96 96 96 96 96 
0000: 96 96 96 96 96 96 96 96 96 96 96 96 96 96 96 96 
ODED: 96 96 96 96 96 96 96 96 96 96 96 96 96 96 96 96 
OOFO: 96 96 96 96 96 96 96 96 96 96 96 96 96 96 96 96 
OEOO: 96 96 96 96 96 96 96 96 96 96 96 96 96 96 96 96 

Track Editor screen after Analyze Track 

To double check that the error is on that disk: 

1. Select the Inspect Track command from the View 
Commands menu. 
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Track: 24 
Side:A 

Track 
Length: 
8491 

Track 
Start: 
0098 

Track 
End: 
2E38 

Write 
Track 
From: 
0000 



Copy II displays a screen verifying the error and its 
location. Make sure that the sector number you got from 
the "To find the damaged block" procedure is the bad 
sector. 

T.-act Inspection 

Addr@ss Fi@ld 

Track Sector Side Interleave Sides Checksum 
24 0 A 2 OS OK 
24 6 A 2 OS OK 
24 1 A 2 OS OK 
24 7 A 2 OS OK 
24 2 A 2 OS OK 
24 8 A 2 OS OK 
24 3 A 2 OS OK 
24 9 A 2 OS OK 
24 4 A 2 OS OK 
24 10 A 2 OS OK 
24 5 A 2 OS OK 

OK 

2 . Click OK to exit the display. 

To display the specific block: 

Data Fi@ld 

Sector Checksum 
0 OK 
6 BAD 
1 OK 
7 OK 
2 OK 
8 OK 
3 OK 
9 OK 
4 OK 
10 OK 
5 OK 

1. Select the Find Sector command from the View 
Commands menu. 

2. Type the sector number in the edit box. In this example, 6. 

3. Click OK. 
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What sector do you wish to find? (0-10) 

OK ) Cancel 

To correct a Data Checksum error (error #-72): 

1. In the track editor display, position the cursor on any data 
byte in the sector (anywhere after the D5 MAD-refer 
to the Sector Diagram in the "Track Editor for Technical 
Users" section). 

0 Trocle Editor 
<00 Vol:Demo Size:400K DrY:lnterm~l Spd:6mHz 

1010: 96 96 96 96 96 96 96 96 96 96 96 96 96 96 96 96 I Track: 24 
1020: 96 96 96 96 96 96 96 96 96 96 96 96 96 96 96 96 Side:A 

1030: 96 96 96 96 96 96 96 96 96 96 96 96 96 96 96 96 
1040: 96 96 96 96 96 96 96 96 96 96 96 96 96 96 96 96 

Truck 
1050: 96 96 96 96 96 96 96 96 96 96 96 96 96 96 96 96 length: 
1060: 96 96 96 96 96 96 96 96 96 96 96 DE AA FFIIID 6491 
1 070: III FF III FF II FF II FF FF liiiii.ii FF FF FF 
1060: iliFF FFii-i-iiFF FFIIDFFIliFFIIIDFF Truck 
1090: III FF DS AA 96 BO 9F 96 9A CD DE AA FF liiilii Sturt: 

10AO: FF FF DS AA AD 9F 9:\;6 96 96 96 96 96 96 96 96 0096 

lOBO: 96 96 96 96 96 96 96 6 96 96 96 96 96 96 96 96 Truck 
lOCO: 96 96 96 96 96 96 96 96 96 A7 96 96 96 96 96 96 End: 

10DO: 96 96 96 96 96 96 96 96 96 96 96 96 96 96 96 96 
2E36 

tOEO: 96 96 96 96 96 96 96 96 96 96 96 96 96 96 96 96 Write 
10FO: 96 96 96 96 96 96 96 96 96 96 96 96 96 96 96 96 Truck 

From: 
ItOO: 96 96 96 96 96 96 96 96 96 96 96 96 96 9696 96 Q 0000 

Cursor in data sector 

2. Select the edit mode by clicking the mouse button on the 
data byte. 
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3. Select the Recalculate Checksum command from the 
View Commands menu. 

Copy II recalculates the data checksum and places the 
correct value in the buffer. You should skip the next 
section and proceed ''To write the corrected information to 
the disk." 

To correct an Address Checksum error (error #-69): 

1. In the track editor display, position the cursor on any byte 
in the sector ID, or address (anywhere after the D5 M 
96-refer to the Sector Diagram in the "Track Editor for 
Technical Users" section). 

o Tracie Editor 
~ Vol:0emo Size:400K Drv:lnternel 

1010: 96 96 96 96 96 96 96 96 96 96 96 96 96 96 96 96 
1020: 96 96 96 96 96 96 96 96 96 96 96 96 96 96 96 96 
1030: 96 96 96 96 96 96 96 96 96 96 96 96 96 96 96 96 
1040: 9696 96 96 96 96 96 96 96 96 96 96 96 96 96 96 
1050: 96 96 96 96 96 96 96 96 96 96 96 96 96 96 96 96 
1060: 96 96 96 96 96 96 96 96 96 96 96 DE AA FF lID 
1070: IIIFFIIIFFIIFFIiFF FFI.I.I.I.IFF FF FF 
1080: iliFF FFI.I.I.IFF FF_FFIIFFIIDFF 
1090: III FF 05 AA 96 BD 9F 9119A CD DE AA FF '.1'1.1 
1 ORO: FF FF 05 AA AD 9F 96 96~'6 96 96 96 96 96 96 96 
lOBO: 96 96 96 96 96 96 96 96 96 96 96 96 96 96 96 96 
lOCO: 96 96 96 96 96 96 96 96 96 A7 96 96 96 96 96 96 
1000: 96 96 96 96 96 96 96 96 96 96 96 96 96 96 96 96 
10EO: 96969696969696969696969696969696 
1 OFO: 96 96 96 96 96 96 96 96 96 96 96 96 96 96 96 96 
1100: 96 96 96 96 96 96 96 96 96 96 96 96 96 96 96 96 

Cursor in address header 

Spd:8mHz 

~ Tracie: 24 I Side:A 

Tracie 
Length: 
8491 

Tracie 
start: 
0098 

Tracie 
End: 
2E38 

Write 
Tracie 

tQ: 
From: 
0000 

2 . Select the edit mode by clicking on one of the bytes in the 
sector ID. 
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3. Select the Recalculate Checksum command from the 
View Commands menu. 

Copy II recalculates the address checksum and places the correct 
value in the buffer. 

It is important to write the corrected information to the copy of the 
damaged disk, not the original disk. This prevents any possibility 
of further damage to the original disk. 

To write the corrected information to the copy disk (two 
drives): 

1 . Insert the copy of the damaged disk. 

2. Select the Toggle Drive command. 

3. Check to see that drive specified in the message box is the 
correct drive. If not, change it to the correct drive. 

4. Select the Write The Track command. 

5. Click OK. 

To write the corrected information to the copy disk (one 
drive): 

1. Press Command+E. This ejects the current disk. 

2. Insert the copy of the damaged disk. 

3. Select the Write The Track command. 

4. Click OK. 

29 



The Track Editor (for Technical Users) 

This section is for more technical users of Copy II who want 
additional information about finding and examining damaged tracks. 
This section is also for users who want to better understand 
diskette encoding and copy protections. 

How Data is Stored on Macintosh Disks 
The data on a Macintosh disk is stored on 80 circular tracks 
numbered 0 to 79. Most Macintosh 3.5" disks are formatted 
double-sided, meaning they contain information on both the bottom 
and top surfaces of the disk media. Each of these 80 .circular 
tracks is therefore divided into two "sides." The Macintosh 3.5" 
drive has two read/write heads, one for the top surface and one 
for the bottom. The drive can position these heads - as a unit -
over and under any track on the disk. 

The top and bottom surface of each circular track is further divided 
into several sectors, much like slices of a pie. Each sector stores 
512 bytes of usable data and 12 adjacent "tag" bytes. These tag 
bytes contain information about the file using the sector. 

The number of sectors per track is not constant across the disk, but 
varies depending on the track number. Because the outer tracks on 
the disk have a greater· circumference than the inner tracks, they are 
used to store more data. 

The tables in Appendix A list sectors (or blocks) per track for 400K 
single-sided and BOOK double-sided disks, starting at the outside
largest circumference-track on the disk. 

Blocks and sectors are actually the same thing, but numbered 
differently. An BOOK, double-sided Macintosh disk contains a total 
of 1600 blocks or sectors. (A 400K, single-sided disk has 800 
blocks, or sectors.) When thought of as sectors, they are 
numbered within each track and side. When thought of as blocks, 
they are numbered for the entire 800K disk: 0 to 1599 (0000 to 
063F in hex). 

Here are some examples: 

• Block 0000 is the same as track 00, side A, sector 0 on a 
400K or 800K disk. 
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• Block 12 (OOOC) is the same as track 00, side B, sector 0 
on an BOOK disk. 

• Block 12 (OOOC) is the same as track 01, side A, sector 0 
on an 400K disk. 

Because the number of sectors per track varies, the conversion 
from block numbers to equivalent track, side, and sector numbers is 
less than obvious. For details in converting block numbers, see the 
"Track Sector Lookup Table" in Appendix A. 

The following sector diagram shows how sector data is organized 
on a Macintosh disk . 

.. 'W ................. " ................. , ...... , ....... , ...... ' ................. " ..................................................................... . 

Sync 
Bytes 

Address 
Header 

Sync 
Bytes 

FF FF FF FF ... (40 or 50 sync bytes) 

D5AA96 
3 bytes 

FF FF FF FF ... (Approximately 10 sync bytes) 

---..;;...--'-------b .................................................... . 

~ __ OOO< Complete Sector 

It's important to note here that you can't view the actual data 
written on a Macintosh disk. Since not all possible byte values can 
be read correctly, information being written to the disk must first be 
"encoded" in some way so that only valid bytes are written. 
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Data is encoded and written to a Macintosh disk using a procedure 
called 6-and-2 encoded storage. For details on this encoding 
procedure, see the "Byte Encoding Methods" tables in Appendix B. 

Overview of the Track Editor 

Below is the Track Editor screen. The following describes the 
screen and its components. 

=0 T.-act Editor 

~ Uo I : Demo Si ze:400K Dru: Internal Spd :8mHz 

09EO: A6 96 97 BC A6 96 9A BC A6 96 90 BC A6 96 A7 BC I Truck: 
09FO: A6 96 B4 BC A6 96 06 BC A6 B4 96 BC A6 06 96 BC Side:A 

OAOO: A6 96 97 BD A6 96 9A BD A6 96 90 BO A6 96 A7 BO 
OA1O: 96 BO A6 A7 DE AA FEIIFF FF'ii'i'IFFDD Truck 
OA20: iii FF FF lillllill FF Illiilill FF 011 FF length: 
OAJO: III FF liiililil FF 1IIIIilii FF III FF III FF 9228 
OA40: III FF liiilil FF 1IIIIIiil FF IIIIliiil FF 
OA50: 011 FF iii FF lillillil FF IIililiil FF FF Truck 
OA60: IIIFFIIIFFlliililllFFlilililllFF 05 AA Sturt: 

OA70: 96 96 96 96 09 09 DE AA FF lililli FF III FF iii OA6E 

OA80: iliFF D5 AA AD 96 96 96 96 96 96 9B 9B 96 FC FF Truck 
OA90: FO 96 96 9A 9A 97 B4 AC 9E E7 F6 AE B2 AF DC DB End: 

OAAO: BO D7 B9 AB AB F3 BF 96 FA EB 9E FE 9A OF F4 BO 
2E29 

OABO: EC A7 9F B4 B3 DF E6 96 EC EB AB AD FF FF 90 CE Urite 
OACO: CF 9E F5 F6 FC F6 F5 B3 CE BC AD FE FO F6 CE FB Truck 

Fro.: 
OADO: E5 9E F6 CF FB FA B7 AD BF D3 OF CD FO FF DF CB lQ OA1D 

The Track Editor screen displays the bytes of information read off 
the disk. The bytes displayed in inverse are called Sync bytes. 
Sync bytes are unusual because they are 10 bits long, not the 
normal 8 bits. 

The top of the screen displays the following information: 

• Lock icon 
Displayed only if the current disk is write-protected. 

• Vol: 
Displays the name of the current disk in the drive. 
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• Size: 
Displays the current disk's size (400K or BOOK). 

• Drv: 
Displays what drive the next Read or Write command will 
affect. 

• Spd: 
Displays what the Reference Clock speed is set to. 

The right side of the Track Editor display shows track location and 
size information. 

• Track: 
Displays the current track number. 

• Side: 
Displays the current track side; A or B (400K disks are 
always side A). 

• Track Length: 
Displays how many bytes are on the track if an Analyze 
has been performed. 

• Track Start: 
Displays the track start address if an Analyze has been 
performed. 

• Track End: 
Displays the last byte of the track if an Analyze has been 
performed. 

• Write Track From: 
Displays where the write routine will write from if an 
Analyze has been performed. 

The Edit Mode 

Use the edit mode to edit selected bytes. You can also use the edit 
mode to: 

• Set the start and end of the track. 
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• Set where the track is written from. 
• Change a sync byte to a data byte. 
• Change a data byte to a sync byte. 

Once edited, the track can be written to a disk in any drive. 

To edit the track data: 

1. In the track editor display, move the cursor into the track 
display and select the byte you want to change by clicking 
on it. The selected byte is displayed in reverse video. 
Notice that the data is shown in hexadecimal numbering 
system format. 

2. Edit the byte by typing any 8 bit hexadecimal value (0-
9/A-F). Any other character is ignored. For help in 
translating hexadecimal to decimal, see the "Number 
Conversion Table" in Appendix C. 

To undo your edits: 

• Select the Re-Read This Track command. 

This command re-reads the track. As long as you have 
not yet rewritten the track, you can undo all edits you have 
made. 

Scrolling in the Edit Mode 
In the edit mode, editing the last byte in the display causes the 
screen to automatically scroll down a line. The screen scrolls up a 
line when you press the backspace key with the cursor on the first 
byte in the display. When you select the Find String command, the 
first byte of the found string flashes when displayed. 

Saving Edited Track Data 

The track data you edit is saved in the track editor display buffer, 
but is not written to the disk. You have to save the edited track to 
disk with the Write The-T~ack command. We strongly recommend 
writing to a copy of the original, not to the original. 
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To save an edited track to disk: 

1. Select the Write The Track command. 
Selecting this command displays a message asking if you 
want to write the track to the disk in the specified source 
drive. 

2. Click OK to write the edited track to the drive it was read 
from. 

To write the edited track to a different drive: 

1. Select Toggle Drive. 
This changes the selected drive (shown in the track editor 
display). 

2. Select the Write The Track command. 

3. Click OK to write the edited track to another drive. 

Note: Editing the data in a sector causes the data checksum to be 
incorrect (bad). For information on checking the condition of data 
and header checksums, see the Inspect Track command. For 
information on correcting a bad checksum, see the Recalculate 
,...L __ L __ .. __ _ __________ J 

\.A 1~Ct\~U111 CUl11111dllU. 

Exiting the Edit Mode 

To exit the edit mode: 

• Press Return or Enter. 

Track Editor commands 

The Track Editor commands are contained in two menus: View 
Commands and Edit Commands. The commands and functions 
described in the following section enable you to find, view, edit, 
and write the data on any track of a program disk. 

View Commands 

The following section gives information about the specific View 
commands. 
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Lliew (ommands .. Control Options Edit Commands 
Read Specific Track XR 
Read NeMt Track XN 
Read Last Track XL 
Re-Read This Track XT 

Find string XF 
Find neMt occurrence XG 
Find sector XZ 

Rnalyze Track XR 

Inspect Track XI 
fJe( n((:ul<lt(! CtHH kSlIW ~lr~M 

Write The Track XW 

Eject the Disk XE 

Toggle Driue XD 

Read Specific Track 
Reads any side of any track on the disk when you specify a track 
number, 0-79 decimal, and side, A or B. When reading 400K 
(single-sided) disks, the B-side selector button is disabled. 

Note: The Read Specific Track command defaults to the last track 
read. 

Once you specify the track number and select a Side, the track 
editor reads the track into the display buffer and displays track data 
as raw data. Use the scroll bars to move through and display the 
track data. 

Read Next Track 
For 400K disks, this command reads the next track on the disk. 

For BOOK disks, this command reads the next side on the disk. 
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Read Last Track 
For 400K disks, this command reads the previous track on the 
disk. 

For BOOK disks, this command reads the previous side on the disk. 

Re-Read This Track 
Reads and displays the current track. When you select this 
command, the track editor re-reads the current track and positions 
the display at the beginning of the display buffer. 

Find String 
Searches for a hexadecimal text string on the displayed track. The 
Find String command defaults to the last text string found. 

Find Next Occurrence 
Finds the next occurrence of the string found with the Find String 
command. 

Find Sector 
Finds and displays any sector on the track when you specify a 
sector number. The track editor displays the sector specified, or 
notifies you that it can't find the sector . 
... ___ 1__ _ FT' ___ 1_ 

.cu.J.'U.rL.~ ... J.Cl\,;A 

Finds the beginning and end of the track, the track length, and 
where the track is written from. 

Copy II locates the beginning of a track by searching for the data 
bytes immediately following the largest group of sync bytes on the 
track. Copy II then searches for a pattern matching these data 
bytes. When it finds the match, Copy II defines it as the end of 
the track. 

When you select the Analyze Track command, the track editor 
performs the analysis and displays the track information. 

• Track Length specifies the length of the track analyzed. 

• Track Start and Track End specify the start and end of the 
track in the buffer. You may use the editing mode to set 
the start and end of the track and where the track is written 
from. 
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For detailed information on editing track data, see the section titled 
The Edit Mode. 

Inspect Track 
Selecting this command displays the following information for the 
current track: 

• track number 
• side. A or B 
• a list of all sector numbers 
• sector interleave 
• type of disk (single or double sided) 
• condition of the address header and data checksums for 

each sector. The condition will be either "ok" or "bad." 

Trock Inspection 

Address Field Data Field 

Track Sector Side Interleave Sides Checksum Sector Checksum 
24 0 A 2 OS OK 0 OK 
24 6 A 2 OS OK 6 BAO 
24 1 A 2 OS OK 1 OK 
24 7 A 2 OS OK 7 OK 
24 2 A 2 OS OK 2 OK 
24 8 A 2 OS OK 8 OK 
24 3 A 2 OS OK 3 OK 
24 9 A 2 OS OK 9 OK 
24 4 A • 2 OS OK 4 OK 
24 10 A 2 OS OK 10 OK 
24 5 A 2 OS OK 5 OK 

OK 

If the track editor is unable to locate a data field sector (for example, 
if a protection scheme has changed the data header), the condition 
of the data checksum will be flagged as "bad." 

The Inspect Track command allows you to quickly inspect a track 
for incorrect checksums. Inspect Track also enables you to verify 
a disk error without having to exit Copy II and start the Verify 
option in MacTools. 
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Recalculate Checksum 
Recalculates a bad checksum. If you have edited the data in a 
sector, or if the data on the disk has been electronically damaged, 
the checksum will be bad. Some applications won't load a file if it 
contains a bad checksum, or it will only load the data that isn't 
affected by the bad block. The Recalculate Checksum command 
enables you to repair the bad block and to recover most of an 
otherwise unloadable file. 

The Recalculate Checksum command is most useful for recovering 
data for which MacTools has displayed error ID numbers --69 and -
72. The Recalculate Checksum command minimizes the task of 
replacing bad data by enabling you to recover the entire file
possibly including some of the data in the bad block. For more 
information on error ID numbers, see the Error ID Numbers in the 
MacTools section of this manual. 

For example, you have a file comprised of five blocks and an error 
occurs in the fourth block. You can use the Recalculate Checksum 
command to recover the data up to the error, possibly some of the 
data around the error, and all of the data in the fifth block. 

File comprised of Data Blocks 

To correct a Data Checksum error (error #-72): 

1. In the track editor display, pOSition the cursor on any data 
byte in the sector (anywhere after the D5 AA AD-refer to 
the Sector Diagram). 

2. Select the edit mode by clicking the mouse button on the 
data byte. 

3. Select the Recalculate Checksum command from the 
View Commands menu. 
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Copy II recalculates the data checksum and places the 
correct value in th~ buffer. 

To co-rrect an Address Checksum error (error #-69): 

1. In the track editor display, position the cursor on any data 
byte in the sector ID or address (anywhere after the D5 
AA 96-refer to the Sector Diagram). 

2 . Select the edit mode by clicking the mouse button on one 
of the bytes in the sector ID. 

3. Select the Recalculate Checksum command from the 
View Commands menu. 

Copy II recalculates the address checksum and places the 
correct value in the buffer. 

Write The Track 
Writes the modified track to the drive specified at the top of the 
display. After making changes to a track, this command lets you 
copy the track to another drive. Once copied, changes can be 
tested without corrupting the original version of the program. 

Note: It is much safer to do this procedure with a copy of the 
original. 

To write the track: 

1. Make sure that the correct disk is in the drive before you 
write to it. If the wrong disk is present, eject it by pressing 
Command+E. 

2. Select the Write The Track command. 
Selecting the command displays a message asking if you 
want to write to the specified drive. 

3. Click OK. 

To write the modified track to a different drive: 

1. Select the Toggle Drive command. 
This changes the selected drive. 
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2. Select the Write The Track command. 

3. Click OK to write the track to the new drive. 

Eject the Disk 
Ejects the disk in the selected drive. 

Toggle Drive 
Changes the drive selected for reading and writing data. 

Edit Commands 

The following section gives information about the specific edit 
commands. 

Control Options Diew Commands Edit (ommands 
Display Track start XJ 
Display Track End XK 

Set Track start XB 
Set Track End XH 
Set Byte to Write From XC 

Toggle Sync XS 
........................................................................... ~ ................... . 

Toggle Ref. Speed XH 
../ Toggle Cleanup XU 

Display Track Start 
Moves the display window to the beginning of the track. When 
you choose this command, you see the address field and the first 
part of the data field for the first sector on the track. 

Display Track End 
Moves the display window to the end of the track. When you 
choose this command, you see the bottom half of the data for the 
last block on the current track followed by the sync bytes. 
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Set Track Start 
Manually sets the start of the track. Technical users can use this 
command to mark a track for writing only a part of the track to a 
disk. 

Set Track End 
Manually sets the end of the track. Technical users can use this 
command to mark a track for writing only a part of the track to a 
disk. 

Set Byte to Write From 
Enables you to determine where a Write will begin. 

Toggle Sync 
Changes the current byte from 8 bit to 10 bit (sync bits are 10 bit 
bytes), or vice versa. Selected sync bytes appear reverse video -
white on black. 

Toggle Ref Clock 
Allows you to change the reference clock rate and then read or 
write using the new setting. 

The Diskette Controller chip (IWM inside the drive has an "internal 
data separator" which needs a "reference clock" to properly read 
data from the disk. The Macintosh allows setting this reference 
clock to either 7mHz or 8mHz. 

Normally, the Macintosh sets the reference clock in the IWM to 
BmHz, however some protected programs have one track (usually 
track 79) written with the IWM reference clock set to 7mHz. When 
a normal BmHz read is then attempted, the information on the track 
has many incorrect values. 

Use the Toggle Ref Clock command to change the reference clock 
speed in the IWM and then read or write at that speed. 

Note: This reference clock rate is different than the disk drive 
speed. Also, as this option toggles an internal Copy II flag, it will 
have no effect on the displayed information for the track until you 
do a read or a write command. 

Toggle Cleanup 
Cleans the buffer after you perform a read. 
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While doing a read, the Copy II read routine decides if the byte 
read off the disk is an 8 bit byte or a 10 bit byte (sync byte) and 
then flags the byte in the buffer. Sometimes, due to the limits of 
the Macintosh hardware for measuring such small periods, the read 
routine makes a mistake in flagging a byte. Copy II has a built-in 
routine which clears these errors. 

To see the track data as it was read from the disk without the 
cleanup, turn this option off. 

Examining Protection Schemes 

The following is an example procedure for examining a copy
protected disk. Also included are some examples of various 
protection schemes you may come across while examining copy 
protections. 

Example procedure for examining a protected disk 

The steps in the following example outline one approach you can 
take to examine copy protection. 

1. Start MacTools and verify the protected disk. 

2 . Locate all errors on the disk, and note the error numbers 
and block locations. 

3. Exit MacTools and start the Copy II Track Editor option. 

4. Choose one of the errors and convert its block number to 
a track and sector location. See the "Track Sector 
Lookup Table" in Appendix A. 

5. Use the track editor to read and display the track and 
sector. 

Now, compare the sector with one from a file that you know to be 
correct. 
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Protection Schemes 

Following are some examples of various protection schemes: 

Example #1: MacTools gives error #-67 on· every block 
on track 79. 

Performing a Read Specific Track of track 79 shows a track with no 
sync gaps, and no address or data headers. 

~ Control Options Diew Commands Edit Commands 

r0- D Track Editor 
No Volume in drive Drv:lnternel Spd:8mHz 

0000: 9F FF FF FF FF D9 BE Bi 9B B5 Be B7 FB FD FE FF ~ Truck: 79 
0010: FF DB FA D2 DO A9 F2 OF EF F3 FO FE FF DB FA 02 Side:A 

0020: DO A9 F2 DF EF F7 FB FO FF B6 FA 02 DO A9 F2 OF 
0030: E7 F9 FE FF FF DB FA 02 De Oi Be B7 FB FO FE FF Truck 
0040: FF OB FA 02 DO A9 F2 OF E7 FB FO FE FF DB FA 02 Length: 
0050: DO A9 F2 OF EF F3 Fe FF FF DB FA 02 De D4 Be B7 0 
0060: F9 FEIOFF FF DB FA 02 DO A9 F2 DF EF F7 F9 FE 
0070: FF 09 BE Bi 9B B5 Be B7 FB Fe FF FF FF D9 BE B4 Truck 
0080: 9B B5 Be B7 FB FO FE FF FF DB FA D2 DO A9 F2 DF 5turt: 

0090: E7 F9 FEIIFF OB FA 02 DO A9 F2 OF EF F7 FB FO 
0000 

OOAO: FF B6 FA D2 DO A9 F2 OF EF F3 FO FE FF DB FA D2 Truck 
OOBO: DO A9 F2 OF E7 FB FO FE FF DB FA D2 DO A9 F2 DF End: 

ooeo: EF F3 Fe FF FF DB FA 02 DO A9 F2 DF EF F7 F9 FE 
7130 

0000: FF OB FA 02 DO A9 F2 OF E7 FB Fe FF FF DB FA 02 Write 
OOEO: DO A9 F2 OF EF F3 Fe FF FF DB FA 02 DO A9 F2 OF Truck 

From: 
OOFO: EF F7 F9 FE FF DB FA 02 DO A9 F2 OF EF F3 FO FE Q 0000 

8mHz track read 

If you change the Reference Clock speed and then Re-read the 
track, you will see a repeating pattern throughout the read buffer. 
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• Control Options Diew Commands Edit Commands 

r-::D Track Editor 
No Volume in drive Drv:lnternel Spd:7mHz 

0000: B7 04 Be B7 F9 FE FF FF FF 09 BE B4 9B 9A 97 96 ~ Truck: 79 
0010: FF III FF FF FF 09 BE B4 9B 9A 97 96111 FF FF III Side:A 

0020: FF 09 BE B4 9B 9A 97 96111 FF FF III FF 09 BE B4 
0030: 9B 9A 97 96 FF FF FF FF FF 09 BE B4 9B 9A 97 96 Truck 
0040: FF FFI&FF FF 09 BE B4 9B 9A 97 96 FFIIIFF FF Length: 
0050: FF 09 BE B4 9B 9A 97 96 FFIIIFF FF FF 09 BE B4 0 
0060: 9B 9A 97 96 FFIIFF FF FF 09 BE B4 9B 9A 97 96 
0070: FF FF FFIBFF 09 BE B4 9B 9A 97 96 FF FFIOFF Track 
0080: FF 09 BE B4 9B 9A 97 96 FFIIFF FF FF 09 BE B4 Sturt: 

0090: 9B 9A 97 96 FFIIFF FF FF 09 BE B4 9B 9A 97 96 0000 

OOAO: FF FF FF FF FF 09 BE B4 9B 9A 97 96 FF FF FF FF Truck 
0060: FF 09 BE B4 9B 9A 97 96 FF FF FF FF FF 09 BE B4 End: 

OOCO: 9B 9A 97 96 FFIIFF FF FF 09 BE B4 9B 9A 97 96 
7130 

0000: FF FF iii FF FF 09 BE B4 9B 9A 97 96 FF III FF FF Write 
ODED: FF 09 BE B4 9B 9A 97 96 FFIIIFFIIIFF 09 BE B4 Truck 

From: 
OOFO: 9B 9A 97 96 FFIIFFIIFF 09 BE B4 96 9A 97 96 0000 

7mHz track read 

The repeating pattern in this example is: 

$9B 9A 97 96 FF FF FF FF FF D9 BE B4 

This is the pattern the copy protection is looking for. 

This is a case where the copy protection scheme uses the 7mHz 
reference clock on a track. When you try to read it with the normal 
8mHz rate, the data is bad. But when you change the rate to 
7mHz, it reads OK. 

Copy II's bitcopy option automatically reproduces this track. 
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.t.;xampJe #2: MacTools verify option shows error #-70 on 
one or more blocks. 

In this scheme, the normal data prolog bytes ($05 M AD) are 
replaced by some other bytes. You wUl find the address prolog 
(05 M 96) and address epilog bytes (DE M) followed by sync 
bytes (FF FF FF) followed by non-normal header bytes. (In the 
example shown, an AB CD AD.) 

~ Control Options Uiew Commands Edit Commands 

t- O Tracie Editor 
No Volume in drive Drv:lnternel Spd:8mHz 

ODFO: EB EC BD F9 BC CO AC DB DB A7 AC 07 E5 FA F5 F2 [Q Tracie: 49 
OEOO: E6 F4 B6 E6 F5 DO 9E F9 9A E5 97 B4 BC DB CF 97 I Side:A 

OE1O: 09 CE DB AF FF FO OF FE 90 E9 96 DE B3 FF 09 OD 
OE20: 9F 90 AC BF F2 AD FB F9 EA D9 9B F9 97 AF A6 90 I Track 
OE30: DC AB EB BA F2 E7 FB B2 FB BE AE DC 96 BC BC B5 length: 
OE40: 9F EE F6 BE D6 EB F2 96 FO E5 B9 E5 F9 EE DE AA 6922 
OE50: FF lilillill FF II FF Iillillillill FF III FF IiID 

~ OE60: FF lillllill FF II1I1I1II FF IiID FF III FF 
OE70: IilDFFIDFFlIIIIIIIIFF 05 AA 96 EE 97 ~ Start: 

OE80: 9A EF DE AA FF IIII1II FF FF FF FF lAB CD AD 197 
087C 

OE90: 96 96 96 96 AC BO CB 9B 96 96 07 DC EB F5 DB 06 Track 
OEAO: EC FA 96 EA ED E6 DO FF CE E6 AE FF F2 BA DB F9 End: 

OEBO: CB CB 96 F7 F4 9F CF CE FF CD 66 E7 E7 E7 AC DB 
2352 

OECO: FC AF 96 FA E9 BC A6 BC 07 EC EB BD AB BA AC B6 Write 
OEDO: DE AF B7 B4 CB 90 9E EA AE FE FA FE FD BA E9 A7 Track 

OEEO: F7 ES E7 EC EF AD OA B5 EA 03 ED BC F4 EC F5 DC l<J 
From: 
0848 

Reversed Data Prolog bytes 

Copy II's bitcopy option automatically reproduces these reversed 
data headers. 
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Example #3: MacTools verify does not detect any errors. 

In the example shown, the normal sync bytes (FF's) have been 
replaced with a different byte: M's. This makes the sectors 
slightly unreliable (because the M, as a sync byte, violates the 
GCR 6-and-2 encoding scheme) and the read routines on the 
protected disk simply double check that the bytes before the 
address and data prologs are M's. 

f$ Control Options Diew Commands Edit Commands 

- 0 Track Editor 
No Volume in drive Drv: Internal Spd:8mHz 

1720: F3 AC AB AE F3 A7 66 AE OF AE F3 B6 OE AA FF B8 ~ Track: 1 
1730: AA AA lilililililililil AA lilililililililil AA AA lilililililll I Side:A 

1740: AA lilililililililil AA AA AA AA AA AA liIil;lililililii AA 
1750: hlilmlillllill AA lilililillillilil AA AA AA AA AA AA III Track 
1760: hUlmlml AA UIII='=llld AA AA blilmlmlilil AA ImIID 

I 
length: 

1770: ImIID AA Ulilililillillil AA AA 1IIIIilllil;l AA hlililililn 9233 
1780 : III AA hlililililililil AA blililililllilU AA nlililililililn 
1790: AA liIililililllilil AA lilililililil AA AA AA AA ImIID AA Track 
17AO: Ublmldil=ld AA '=I=I=IIIIIII=ld AA 05 AA 96 97 96 96 Start: 

17BO: 9A 9B DE AA FF UIIII'=II':II'd AA 05 AA AD 96 96 96 
17AA 

!7CO: 96 96 AC 9F A6 97 96 96 CD 98 AC DA E? FF 85 A? Tn~G!( 

1700: BE AF 07 B4 BE AF 97 07 BF AF B5 9A BF AF 07 90 I 
End: 

17EO: BF AF 97 AB CB AF 97 B6 CB AF 97 DB CB AF B5 A7 
3B49 

17FO: CB AF 07 B4 CB AF 97 07 CO AF B5 9A CD AF 07 90 Write 
1800: CD AF 97 AB CE AF 97 B6 CE AF 97 DB CE AF B5 A7 Track 

From: 
1810: CE AF 07 B4 CE AF 97 07 CF AF B5 9A CF AF 07 90 ~ 1738 

AA's in sync gaps 
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Example #4: MacTools verify does not detect any errors. 

Using the normal Macintosh ROM format routines, the gap between 
the address header and the data field are usually 10 - 16 bytes 
long. In the example shown, the gap fields are all exactly 6 bytes 
long. 

• Control Options Uiew Commands Edit Commonds 

r- 0 Track Editor 
No Volume in drive Drv: Internal Spd:8mHz 

lA20: AD 9E B9 B7 AE 9E 08 DO AE 9E B9 AF AF 9E DB BF ~ Track: 1 
lA30: AF 9E 90 F4 82 9E 89 E6 82 9E F3 B9 B2 9E DB E5 I Side:A 

lA40: B3 9E B9 87 84 9E 08 DO 84 9E B9 AF B5 9E DB BF 
lA50: B5 9E 90 F4 86 9E 89 E6 86 9E F3 B9 B6 9E DB E5 Track 
lA60: B7 9E B9 87 89 9E 08 DO 89 9E B9 AF BA 9E DB BF Length: 
lA70: BA 9E 90 F4 88 84 88 9E F4 DE AA FFljlil'jjFF 9250 
lA80: FFIDFF FF'iijijiFF FFljijljjFF FFIIID 
lA90: IIIDFF FF'jijljiFF'jlj'jjFF FFljljljj Track 
lAAO: III FF 05 AA 96 97 9F 96 9A 9E DE AA FF Ijljlilj Start: 

lABO: FF FF 05 AA AD 9F 96 96 96 96 AC 97 9A 9B 96 96 17A6 

lACO: 9B 86 B4 FS EE BE 88 A7 FC BD DB DE CD F2 AE BE Track 
lADO: DE B4 AC 9F 97 C8 84 AE E6 F3 09 EA B2 03 AC BA End: 

lAEO: BA FC 9E 97 CD 9F EC 9A FS EB AF B4 B9 A7 F4 OF 
385A 

lAFO: CF E7 FF DB FS EE ES AD 07 EB F6 EA FF B5 DE DB Write 
IBOO: FB EC DE F6 FA DE 80 DA 96 B6 E7 F5 9B E7 DE BC Track 

From: 
IBI0: FC E7 FB CF 90 DR DC FF FD DA BC FE FD DA F6 FC ~ 1738 

Small gap 

When the copy protected program runs, it checks that all the gaps 
before data headers are exactly 6 bytes long. 
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Example #5: MacTools verify shows -67's on every 
sector on a track. 

When the protected disk was created, a 64 byte pattern was written 
to cover the entire track. (All the valid 6&2 encoded byte values in 
ascending order.) The protection uses special "Key" bytes to mark 
where they started writing the track and where they finished writing 
the track. In the example shown the "key" bytes for the last bytes 
written to the disk are "D6 AB." 

• Control Options Uiew Commands Edit Commands 

- 0 Track Edi,or 
No Volume in drive Drv:lnternel Spd:BmHz 

23BO: 05 07 09 DR DB DC DO DE OF E5 E6 E7 E9 ER EB EC 

I 
Truck: 4 

23CO: ED EE EF F2 F3 F4 F5 F6 F7 F9 FR FB FC FO FE FF Side:A 

2300: 96 97 9R 9B 90 9E 9F R6 R7 RR RC RO RE RF 62 B3 
23EO: B4 B5 B6 67 B9 BR BB BC BO BE BF CB CD CE CF 03 Track 
23FO: 05 07 09 DR DB DC DO DE OF E5 E6 E7 E9 ER EB EC length: 
2400: ED EE EF F2 F3 F4 F5 F6 F7 F9 FR FB FC FO FE FF 

I ~ 
f- ,-Ke 

2410: 96 97 9R 9B 90 9E 9F R6 R7 RR RC AD AE AF 62 B3 
2420: B4 B5 B6 B7 B9 BR BB BC BO BE BF CB CD CE C~ Track 
2430: 05 07 09 DR DB DC DO DE OF E5 E6 E7~97 FF sturt: 

2440: E7 E9 EA EB EC ED EE EF F2 F3 F4 F5 F6 F7 F9 FA 
0000 

2450: FB FC FD FE FF 96 97 9R 9B 90 9E 9F R6 R7 AA AC Track 
2460: AD AE AF B2 B3 64 B5 B6 B7 69 BR BB BC BO BE BF End: 

2470: CB CD CE CF 03 05 07 09 OA DB DC DO DE OF E5 E6 
7130 

2480: E7 E9 EA EB EC ED EE EF F2 F3 F4 F5 F6 F7 F9 FA Write 
2490: FB FC FO FE FF 96 97 9R 9B 90 9E 9F A6 A7 AA AC Track 

From: 
24AO: AD AE AF B2 B3 B4 B5 B6 B7 B9 BR BB BC BD BE BF Q 0000 

Repeating - Splice marked by key bytes 

It is very hard to determine the track start and end. Copy II has 
been hard-coded to handle many of these protection schemes. 

49 

y Byte~ 



Example #6: MacTools verify shows error #-71. 

In this scheme, the sector starts out looking normal - D5 M AD 
data prolog bytes, followed by what looks like normal bytes. But 
then the sector hits some unusual bytes. What happened is that 
when the block was originally written, there was a zero byte written 
out. When the drive tries to read that byte back in, it will read it in 
different ways on different reads. Reading it as a zero byte will 
cause the hardware to "lose sync," since it violates the GCR 
encoding rules. The protection scheme checks to make sure that, if 
it reads the block several different times, it gets several different 
checksum values returned. 

~ Control Options Uiew Commands Edit Commands 

o Track Editor 
No Volume in drive Drv: Internal 

2260: FF DC FC 96 CB FE EB 9A EC B5 EA EF 06 9E CE CE 
22CO: EB DE F2 54 09 ED EE AF B9 B9 F4 03 03 6F ED 03 
2200: DE AA FF IIIIIII FF FF FF IIID 
22EO: iliFF FFllljljljlFFljijlllFF FFIIII'II 
22FO: IIIFFlillijijlFF 05 AA 96 CF 9A 96 9A CF DE 
2300: AA FF Ililiji FF FF 05 AA AD 9A 96 96 96 96 96 
2310: 96 96 96 96 96 96 96 96 FF FF FF FF FF FF FF FF 
2320: FF FF FFIIIFF FF FF FF FF FF FF FF FF FF FF F3 
2330: FF FF FF F3 FF F7 FF F5 FF FF FF FF FF F6 FF FF 
2340: FF FC FF FF FF FF FF FF FF FF FF FFIIIFF FF FF 
2350: FF FF IDFF FF FF FF FF FF FF FF FF FF FF FF FF 
2360: FF FF FF FF FF FF FF FF FF FF FF FF FF FF FF FF 
2370: FF FF FF FF FF FF FF FF FF FF FF FF FF FF FF FF 
2380: FF FF FF FF FF FF FF FFIIIFF FF FF FF FF FF FF 
2390: FF FF FF FF FF FF FF FF FF FF FF FF FF FC FF FF 
23AO: FF FF FF FF FF FA FF FF FF FF FF FC FF FC FF FF 

Zero in sector 

50 

Spd:8mHz 

Track: 30 
Side:A 

Track 
length: 
8419 

Track 
Start: 
170F 

Track 
End: 
3782 

Write 
Track 
From: 
16CF 



Example # 7: MacTools verify shows no errors. 

A normal data field is the D5 AA AD prolog, followed by the sector 
number, followed by 698 bytes of encoded data, followed by 4 
checksum bytes, followed by a DE AA. In this scheme, two extra 
bytes are attached to the end of every data epilog (DE AA BB AA). 
Then, when the program runs, it double checks that the extra bytes 
are at the end of every sector it reads. 

.. Control Options Uiew Commands Edit Commands 

- 0 Tracie Editor 
No Volume in drive Drv:lnternel 

1600: E9 BB 9F FB BO BB 9F E7 EE BC 9F CB OA BO 9F FB 
16EO: 9F BO 9F E7 AF BE 9F AD CB BF 9F AD F5 BF 9F CB 
16FO: E9 BF 9F FB BD BF 9F E7 EE CB 9~ 
1700: 9F CD 9F E7 AF CE 9F AD CB CF 9F F BO 
1710: E9 CF EA CF 9F E9 DE AA~FF FE FFIJIFFIJI 
1720: iii FF lilllilli FF ImI FF III FF IIIIIIlil 
1730: FFIiIFFImIFFIIIFFIIIFFFFImIFFIDFF 
1740: ImI FF iii FF II1II FF III FF Ijljljlil FF ID 
1750: FF ID FF FF Ijljljljl FF FF III FF ID FF ImI 
1760: FF ID FF ImI FF III FF Ijljljlil FF li'jlill 
1770: FF FF IIljljljl FF III FF ImI FF Ijliljljl 
1780: FFliiiijiilFFIDFFIDFF FFIDFFIDFF FF 
1790: 05 AA 96 97 96 96 9A 9B DE AA FF lilliil FF FF 
17AO: 05 AA AD 96 96 96 96 96 96 96 96 96 96 96 96 96 
1760: 96 96 96 96 96 96 96 96 96 96 96 96 96 96 96 96 
17CO: 96 96 96 96 96 96 96 96 96 96 96 96 96 96 96 96 

Extra bytes after data epilog 

Spd:BmHz 

~ Tracie: 1 

I ~ 
Tracie 
Length: 
9245 

Tracie 
Start: 
1790 

Tracie 
End: 
3840 

Write 
Tracie 

Q 
From: 
1723 

-Extra bytes 
after data 
ep;log bytes 

Copy II's bitcopy option automatically reproduces these extra bytes. 
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Example #8: MacTools verify shows no errors. 

The very last block of this disk contains a very special set of bytes. 
When you read it in the Track Editor, you will see 96 bytes, then 
at the end of the sector you will see about 150 bytes of ETs. The 
protection scheme is complicated in that the first part of the E7' s 
are not all 8-bit bytes. They are sometimes 10-bit bytes (Sync) 
and 9-bit bytes (short sync). The Track Editor will sometimes 
display 9-bit bytes as 10-bit sync, and sometimes the track editor 
will display the 9-bit byte as an 8-bit byte. 

~ Control Options Diew Commands Edit Commands 

r- 0 Tracie Editor 
No Volume in drive Dry: Interne 1 Spd:BmHz 

2400: 96 96 96 96 96 96 96 96 96 96 96 96 96 96 96 96 ~ Tracie: 79 
24EO: 96 96 96 96 96 96 96 96 96 96 96 96 96 96 96 96 I 

Side:A 

24FO: 96 96 96 96 96 96 96 96 96 96 96 96 96 96 96 96 
2500: 96 96 96 96 96 96 96 96 96 96 96 96 96 96 96 96 

Tracie 
2510: 96 96 96 96 96 96 96 96 96 96 96 96 96 96 96 96 length: 
2520: E7 E7 E7 E7111E1 E7111E7 E7 E1 E7 E1IBE7 E7 6455 
2530: E7 E7 E7 E7 E1 E1 E1 E1 E7 E7 E7 E7 E7 E7 E7 E7 
2540: E7 E7 E1 E1 E7 E1 E1 E1 E7 E7 E7 E7 E7 E7 E7 E7 Track 
2550: E7 E7 E1 E7 E1 E1 E1 E1 E7 E1 E7 E7 E7 E7 E7 E7 Start: 

2560: E7 E7 E7 E7 E7 E1 E7 E1 E1 E7 E7 E7 E7 E7 E7 E7 
OD1B 

2570: E7 E7 E1 E7 E7 E7 E1 E1 E7 E7 E7 E7 E7 E7 E7 E7 Tracie 
2580: E7 E7 E1 E7 E1 E7 E7 E1 E7 E7 E7 E7 E7 E7 E7 E7 End: 

2590: E7 E7 E7 E7 E7 E1 E1 E1 E7 E7 E7 E7 E7 E7 E7 E7 
25C3 

25AO: E7 E7 E7 E7 E7 E7 E1 E7 E7 E7 E7 E7 E7 E7 E7 E7 Write 
2560: E7 E7 E1 E7 E7 E7 Be ED B1 EF OE AA FE 1.'.lill Track 

From: 
25CO: FF FFI.I.I.I.IFF FFIDFF FFIDFFIDFF FF ~ OCBC 

96-E7 on last sector of disk 

Copy II is hard-coded to handle this scheme. 
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Copy II® Hard 
Disk 

~ 

~Hol 
Copy II® Hard Disk 





CoPY II Hard Disk 

Copy II Hard Disk is an application on your Copy II disk that 
allows you to transfer some copy-protected software to your hard 
disk, RAM disk, BOOK HFS disk, or 400K MFS disk. All hard disk 
and RAM disk brands are supported. Not all protected software, 
however, can be transferred. Copy II Hard Disk is updated often to 
support additional protected programs. You can choose the option 
"Copyable Programs" from the Information menu to see what 
programs Copy II Hard Disk can transfer. 

System Requirements 

Copy II Hard Disk runs on any of the following machines with 
System Version 3.2 or higher: 

• Macintosh 512KE 
• Macintosh Plus 
• Macintosh SE 
• Macintosh II 

MultiFinder™ 

Copy II Hard Disk is compatible with MultiFinder. Copy II Hard 
Disk will use all available memory for the copy process, so if you 
turn RAM cache off before you start, the copy process will be 
faster. 
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Installing CopY II Hard Disk 

There are no special requirements for installing Copy II Hard Disk. 
It can be copied to a floppy or hard disk in the same way as any 
other program. 

Hard disk installation 

1. Insert the program disk and double-click on its icon. 
This opens the program disk window. 

2. Drag the Copy II Hard Disk icon onto the hard drive 
window. 

Note: If you are copying several applications onto your 
hard disk at once, do not copy the System Folder onto 
the hard disk. Your hard disk system will start to 
misbehave if you install multiple copies of the System and 
Finder by mistake. 

Backing up on a System disk 

We recommend you make a copy of Copy II Hard Disk on a disk 
with a System folder. Store the original program disk in a safe 
place. 
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Using CopY II Hard Disk 

Before starting Copy II Hard Disk, you must have already turned 
on the Macintosh and your hard disk, and performed whatever 
steps are required for the Macintosh to recognize and work with the 
hard disk. We recommend that you create a new folder for each 
program you wish to transfer to the hard disk. (Some older MFS 
hard disks are segmented into "volumes." If your hard disk is one 
of these, you may want to create a new volume for each program, 
and make sure it is "mounted.") 

To use CoPY IT Hard Disk: 

1. Double-click the Copy II Hard Disk icon. 
This starts the Copy II Hard Disk program. 

~ 

~Hol 
Copy II@ Hard D;sk 

After showing an important notice, the Copy II Hard Disk 
main screen will appear. 
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" Control Information 

Copy II ® Hard Disk 

Original: 

I Copy II® Disk 

(Eject Original J 

I Messages: 

The first thing to notice is the menu bar at the top of the screen. In 
the "Information" menu is an item called "Copyable Programs." To 
see a list of the programs that can be transferred to hard disk, 
choose the Copyable Programs item from the Information menu. 
When you later want to leave the Copy II Hard Disk application, 
choose the "Quif' option from the "Control" menu. 

If you started Copy II Hard Disk from your Copy II disk in the 
internal drive, the Original Volume will display "Copy II Disk." If 
you started it from the hard disk, the Original Volume will most 
likely be blank, or will contain the name of whatever disk is in the 
internal drive. 

The disk to be copied needs to be in the Mac's internal drive. If 
another disk is already in the drive, remove it now by clicking on 
the "Eject Original" button. Insert the new disk into the internal 
drive. The disk's name will be shown in the Original Volume box. 
In the above example, this is the Copy II program disk. 

Once this is done, click the "Start Copy" button. (The Macintosh 
may ask you to swap disks. Don't worry; Copy II Hard Disk will 
make sure it has the correct disk before it begins the copy.) A 
dialog will appear for you to choose where to transfer the protected 
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application. The actual appearance of the dialog depends on which 
file system (HFS or MFS) you are working with. You'll notice that it 
is similar to the usual "Save" dialog you see in many other 
applications, except that there is no space to enter a filename. This 
is because Copy II Hard Disk will be copying a number of files, 
keeping their original names. 

Click on the "Drive" and "Eject" buttons to select which drive or 
volume you want to copy to. (If you're using HFS, you can also 
select which folder to copy into.) If you want to copy to an BOOK 
diskette, simply select it as the destination volume. When you have 
the proper volume/folder selected, click on "Continue." 

The GOpy process itself will take from a few seconds to a couple of 
minutes as it moves all the application and data files from the 
Original Volume to the destination volume or folder you've selected. 
When it is done, you will see the message "Copy Complete!" 

Important Considerations 

Copy II Hard Disk will not automatically transfer files normally 
found in the system folder (Le. System, Finder, Desktop, 
Imagewriter, Clipboard, Scrapbook, etc.). This is done to conserve 
space (as it is not necessary to have many copies of the same files 
on the hard disk) and to avoid problems with certain brands of hard 
disks that get upset about having "unpatched" versions of the 
system files around. 

However, in some cases it is helpful to transfer these files to the 
hard disk volume. Some applications, such as Jazz, require their 
own "patched" system files in order for certain features of the 
application to work right. If an application does need a special 
system file, hopefully a note in its manual will mention this. You 
can then use either the Finder desktop or MacTools' Copy Files 
option to copy system files from the original disk to the hard disk 
volume, if necessary ... except that: Some hard disks also need their 
own speCial system files to operate correctly. If you replace the 
hard disk's system file with another, the hard disk may develop 
problems working with files. 

In the case of Jazz, you can get around this problem: After you've 
used Copy II Hard Disk to move Jazz to a new hard disk volume or 
folder, copy the hard disk's system files into the volume or folder. 
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Then use the "Jazz System Update" application (as described in 
the "Jazz Update Sheet" that accompanied your Jazz package) to 
modify the system files on the new hard disk volume or folder. 

There are a few applications which Copy II Hard Disk can back up 
to another 3.5 inch disk, but not to a hard disk. These applications 
have inherent disk-access limitations, which, unfortunately, prevent 
them from working correctly from a hard disk. 

Occasionally you may find that Copy II Hard Disk won't 
successfully transfer a program to hard disk, even if the program is 
listed as one of the "Copyable Programs." Keep in mind that the 
software publishers who copy-protect their products will sometimes 
- without fanfare - change the protection scheme used on the disk. 
When this happens, the methods used by Copy II Hard Disk may 
not work with the new scheme. Central Point Software periodically 
updates Copy II Hard Disk to work with new programs and new 
protection schemes. 

If there is a program you'd like to transfer to a hard disk that Copy 
II Hard Disk cannot handle, you might want to write us a quick 
letter to let us know about it, so we'll know which products are in 
demand. If it was listed as a "Copyable Program," also let us know 
what happened when you tried to use the hard disk backup. 
Address your letter to: 

Central Point Software, Inc. 
15220 NW Greenbrier Parkway, Suite 200 
Beaverton, OR 97006 
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~ 
MacTools® 

(j) 
CPS De lete Tr acking 

o 
CPS TagFix 





Introduction to MacTooIs 

Thi$ manual describes MacTools, a disk and file utility program for the 
Macintosh computer. MacTools does many of the same things the 
Finder does, including copying, renaming, and deleting files (documents 
and applications) or entire disks. MacTools provides these featu;es as 
pull-down menu options. To select which files you want to work with, 
you can click on the files with the mouse, or use the Select Files option 
to select a number of files at once. 

In addition, MacTools provides several useful features not found in the 
Finder. MacTools can often recover files that have been aCCidentally 
deleted, and can repair some damaged disks. It can make files 
"invisible/' so that they don't appear at all when you're in the Finder, 
and can "lock" files so they can't be renamed or deleted. 

MacTools includes these features: 

• Copy files 
• Copy disk 
• Rename files 
• Rename disk 
• Verify that a file has no errors 
• Verify that a disk has no errors 
• Format a disk 
• Delete files 
• Lock and unlock files 
• Make files visible or invisible to the Finder 
• Protect or unprotect files from normal copying 
• Change the 'startup' application on a disk to something other 

than the Finder 
• Recover deleted files and repair some damaged disks 
• Look at or change the information stored on disk 
• Prin t a list of files on the disk 

This manual is intended to give you a quick start on the features of 
MacTools. The first portion, "Using MacTools," tells you how to start 
up MacTools. 

The five main menus in MacTools are: 

• Disk Options 
• File Options 
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• Control Options 
• ViewEdit Options 
• Miscellaneous Options 

Each of the menus has its own section. These sections give a step-by
step description of how to use the basic features of MacTools. 

The more complex "ViewEdif' and "Undelete Files" options are 
discussed next. The "Notes" section at the end gives you a few helpful 
hints about MacTools, including information about hard disks. 

A short note about the two file systems for the Macintosh - the original 
Macintosh File System (MFS) and the Hierarchical File System (HFS): 
On the original MFS system, folders were a convenient illusion created 
and maintained by the Rnder. The Finder was responsible for storing 
the names and positions of the folders in an invisible file called 
"DeskTop." These folders were "transparent" to most Macintosh 
applications, including MacTools. On the newer HFS system, folders 
are real. You are able to store documents inside a folder, and unless 
you open the folder, you never "see" the document. Applications 
recognize these folders and allow you to open or close them to select 
where you wish to store your file. 

A few words need to be said about copy-protected files. Under the 
copyright law, you are allowed to make backups of software for your 
own use, so that if a disk is damaged or aCCidentally erased, the 
information is not lost. You are not allowed to give or sell copies of 
copyrighted software to others. 

System Requirements 

MacTools runs on any of the following machines with System Version 
3.2 or higher: 

• Macintosh 512KE 
• Macintosh Plus 
• Macintosh SE 
• Macintosh II 

MultiFinder™ 

Mac Tools is fully compatible with MultiRnder. 
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Installing MacTools 

Mac Tools has three parts: 

• The MacTools application. This should be installed on your 
hard disk, although it will run from a floppy. 

• The Delete Tracking INIT. This should be installed in the 
System Folder of your system disk if you want Mac Tools to 
support file undeletion on floppy or hard disks. 

• The CPSTagFix INIT. This should be installed in the System 
Folder of your system disk if you want MacTools to support 
file undeletion on floppy disks. 

The CPSTagFix program corrects a bug in Macintosh 512KE 
and Mac Plus tag creation, and speeds up the upper drive in 
the Macintosh SE. 

To install MacTools on your system 

1. Insert the program disk and click on its icon. 
This opens the program disk window. 

2. Drag the MacTools icon onto the hard drive window. 

3. Drag the Delete Tracking icon and the CPSTagFix icon from 
the program disk into the System Folder of your system disk. 
Do not copy the System Folder of the program disk. 
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Using MacTools 

Starting MacTools: 

1. The Mac Tools icon resembles a disk under a magnifying glass. 
Open MacTools by double-clicking the icon or selecting Open 
from the File menu. 

2. After a moment, the Disk Window will appear. MacTools is 
now ready to work on your disk. 

The Disk Window 

You'll see a display similar to the following: 

_0 IEEE) Hard Disk I 

~ Amt. Used: 6936K Amt. Free: 12235K 

Size Name Modified Date Prtct Lckd Inyis 

D Apple Utilities Mon, Aug 22, 1988 g 
253K ~ C Sat, Oct 24, 1987 0 0 0 

D CPS Applications Thu, Sep 1, 1988 

10K [) CPSDe lete Info Thu, Sep 1, 1988 0 0 • 
32K [) Desktop Thu, Sep 1, 1988 0 0 • 
f1? D Manual Thu, Sep 1, 1988 

D Manual @o 72S Thu, Aug 25, 1988 

350K ~ Micro Mon, Aug 1, 1988 0 0 0 
5K [) MS9D109 ArtYork Thu, Sep 1, 1988 0 0 0 
5K Q Program Fri, Ju115, 1988 0 0 0 
9.5K D Screen 0 Thu, Sep 1, 1988 0 0 0 

~ 6.5K n Screen 1 Thu SeD 1 1988 0 0 0 

This is the main MacTools display, which shows you information about 
the disk currently in the drive. 

Title Bar 
The top of the window is called the title bar. Within the title bar are 
three items that provide information about the drive, the disk name, 
and its format: 

62 



• The icon just left of the title indicates either an internal or 
external 3.5 inch drive, any hard disk volume, or an open 
folder on an HFS disk. 

• The center of the title is the name of the disk or the name of 
the open folder. 

• If there is a box around the title, then the disk is an HFS disk. 
If the title appears without a box around it, then the disk is 
MFS. (See section later on Open Folder for more information 
about the HFS title box.) 

Underneath the title bar are three more items: 

• A lock icon, which shows whether or not the disk is write
protected. 

• The amount of disk space that is used. 

• The amount of space that is free. 

Below the line of disk information is a list of all the files and folders on 
the disk or inside the folder. Each line includes: 

• The size of the file. (Note: folders do not take up separate 
space on the disk, so the size field is replaced by " __ n.) 

• An icon representing whether the entry is a folder, an 
application, or a document. 

• The name of the file. 

• The date the file was last modified. 

• Boxes which show if the file is currently 
• protected (Prtct), 
• locked (Lckd), or 
• invisible (Invis). 

(Note:these status flags make no sense when applied to a 
folder, so they have been replaced with "_n.) 

When the mouse is pOinting inside the window, the pointer appears as 
a hand. With the hand pOinter, you can select which files you want to 
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work with. Outside of the window, the pointer becomes the usual 
arrow. 

If there are more files on the disk than will fit in the window, the scroll 
bar on the right will become active so you can scroll through the 
window to see all the files. 

Desktop File 
You can see there is a file on the disk called DeskTop. The "Invis" box 
for this file is blacked out, which means that this file is invisible. If you 
look at other disks with MacTools (we'll tell you how to do this shortly), 
you will find that most normal Macintosh disks have an invisible file 
called DeskTop. The Finder uses this DeskTop file to keep track of how 
the icons and windows for the disk are supposed to be arranged on the 
screen. However, the DeskTop file itself doesn't appear when you're in 
the Ander, because it's marked as invisible. 

Status Flag 
If the Protect (Prtct), Locked (Lckd) or Invisible (Invis) boxes for any files 
are blacked out, it means those files have that status flag set. 

Protect (Prtct): A protected file cannot be copied either from the Ander 
or with the Macintosh Disk Copy application. However, MacTools can 
copy these files using the Copy Files options. 

Locked (Lckd): A locked file cannot be renamed or deleted (thrown in 
the Trash) from the Ander. It must be unlocked first. (You can lock or 
unlock files one at a time when you're in the Finder, using the Ander's 
Get File Info option.) 

Invisible (Invis): An Invisible file cannot be seen from the Ander, or by 
Macintosh's Standard File Package. As discussed earlier, the Ander 
uses the invisible "DeskTop" file to keep track of where the icons, 
windows, and folders appear on the screen. If you make this file visible 
with MacTools, it will show up as another icon from the Ander. 

You can set or clear these status flags by pointing to the box with the 
"Hand" pointer and clicking the mouse button. The status will be set to 
the reverse of what it was. (Le. If the prtct box is blacked in - protected 
- then it will become just an outline box, which means the file is no 
longer protected.) 

Note: The Macintosh will not let you protect/unprotect files on the 
disk that you started up from. 
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Changing Disks 
To work with disks other than the MacTools disk, you simply eject the 
MacTools disk and insert the disk you want to work with. There are 
three ways to eject a disk: 

• Click the Close box in the window. 

• Select the Eject option from the Disk pull-down menu. 

• Hold down the command key and type the letter "e." 

All three methods do the same thing: They eject the disk from the drive 
and remove the disk's window from the screen. When you insert 
another disk, a new disk window for that disk will appear. 
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If you have two or more disk drives connected to your Macintosh, you 
can insert disks into any drive. If, for example, there are disks in two 
drives at the same time, there will be two windows on the screen, one 
for each disk. Only one window can be "active" at a time. The active 
window is the one MacTools uses when you select to rename, delete, 
eject, etc. You can bring any window to the front and make it active 
simply by clicking on it. Remember that the icon to the left of the 
window title shows you which drive the disk is in. 

pillllJJC:IIC.'tOIn niC' .... ~ 

r-_D .1 r!J Write/Paint Disk: I 
r- <00 Amt. Used: 104K Amt. Free: 675K 

P= Size Name Modified Date Prtct Lckd Invis 

3K D Clown picture Moo, D~c 7, 1987 0 0 0 ~ 
6.5K D Desktop Tue, Ju112, 1988 0 0 • 
3K D Doggie picture Thu, D~c 1 0, 1987 0 0 0 
3K D Happy Birthday Tue, D~c 22, 1987 0 0 0 
2K D Horse picture Thu, Feb 4,1988 0 0 0 
3.5K D Letter to Mom Thu, F~b 4 I 1988 0 0 0 
58.5K <$ MacPaint l1r Fri, Apr 5,1985 0 0 0 
-- CJ MacP aint Docs Tue, Ju112, 1988 -- -- --
-- CJ MacYrite Docs Tue, Ju112, 1988 -- -- --
24.5K D Option Menu Tue, Feb 16, 1988 0 0 0 

... ~ 

Disk Options 

By choosing the Disk pull-down menu, you can see what disk options 
are available. 
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Verify Disk 

• Control nh~ Mise 
Uerify Disk: 
Format Disk: 
Copy Disk: 
Rename Disk: 

UiewEdit Disk: 
UnDelete Files 

Eject Disk: SCE 

Create New Folder 
Open Folder SCD 

Tree Display SCT 

The first option, Verify Disk, lets you verify that all of the information 
on an initialized Macintosh disk is readable. Sometimes a disk, or the 
information on the disk, can become damaged. If you accidentally tum 
off the Macintosh (or the power fails) while the Macintosh is writing 
data to the disk, a portion of that data can become unreadable, even 
though the disk itself is not damaged. If you drop a disk into a pot of 
hot coffee, however, the entire disk is most likely ruined forever. The 
Verify Disk option cannot determine whether just the information is 
bad or the disk itself is damaged; it simply tells you whether or not all of 
the information was readable. (Verify Disk does not work with 
uninitialized disks, because there is no information to read.) 

To use Verify, make sure the disk you want to verify is in the drive, 
then choose the Verify Disk option. (Point at the Disk menu, press and 
hold the mouse button while dragging the pointer to Verify Disk, then 
release the mouse button.) The pointer changes to a wristwatch and the 
disk whirs for several seconds as MacTools verifies the disk. 

If there are no errors in reading the disk, a dialog box appears, saying 
"The verify action was successful!" Click the "OK" box to continue. If 
any part of the disk is unreadable and an error occurs, a dialog appears 
giving the "block number" of the error, and an error ID number. (The 
errors are rather technical in nature. A list of possible error numbers 
appears in the Appendix.) You can choose to either continue verifying, 
or cancel the verify option. 
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If a disk that doesn't verify contains any important files, you should try 
to copy the files onto another disk using the MacTools Copy Files 
option. Then try to re-format the bad disk. If the format fails, then the 
disk itself is probably damaged and should be discarded. 

Note: Many copy-protected disks contain errors and will not verify. 
The errors are part of the copy protection and are normal. 

Format Disk 
The Format Disk option is used to reformat (or "initialize") a Macintosh 
disk, completely removing any old information and preparing the disk 
for storing new files. Any normal disk which does not verify (see above) 
should be reformatted with the Format Disk option, so you won't be 
plagued with disk errors later. 

To use Format Disk, make sure the disk you want to format is in the 
disk drive, then choose Format Disk from the Disk menu. A dialog box 
will appear, asking what size you want to format the disk. If the disk is 
in an BOOK drive, you will have the option to format the disk as a 
400K or BOOK disk. Click on "Cancel" if you don't want to format the 
disk. (Note: 400K disks are formatted MFS and BOOK disks are 
formatted HFS.) The disk will keep the same name it had before it was 
formatted. You can use the Rename Disk option if you want to give it a 
new name. 

Note: If you want to format a brand new unformatted disk, simply 
insert it into the disk drive. MacTools will notice that the disk is 
unreadable, and ask you if you want to initialize the disk. If you want to 
reformat an already formatted disk, then use the Format Disk option 
from the Disk menu. 

Copy Disk 
You can make backups of entire disks with the Copy Disk option. The 
copied disks are given the same name as the original disk (unlike copies 
made with the Finder, which keep the name they had), and copying 
takes fewer disk swaps than with the Finder. In addition, Copy Disk can 
make backups of many protected disks. When a copy of a protected 
disk is made, the copy is still protected in the same way as the original 
disk. The directions for copying a disk vary slightly, depending on 
whether you have one disk drive or two. 

Note: If you have one 400K drive and one BOOK drive and you insert 
an BOOK disk in the BOOK drive and ask it to do a Copy Disk, you will 
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be doing a one-drive copy. The reason is that the 400K drive cannot 
read or write an BOOK disk! 

Copy Disk (one-drive) 
To use Copy Disk with one-drive systems, insert the disk you want to 
make a copy of, then choose Copy from the Disk menu. MacT ools will 
briefly read the disk and eject it, then display a dialog box asking you to 
insert the disk you want to copy to. Insert this new disk. If the disk has 
never been used, MacTools will begin copying immediately. If the disk 
is already initialized, another dialog box will appear, asking you to 
confirm that it's OK to completely replace the old information with the 
new. 

As copying progresses, MacT ools will tell you when to insert the 
original disk you're copying and when to insert the copy disk. 

To speed up copying, MacTools makes use of as much memory in the 
Macintosh as possible by "purging" everything it doesn't need. When 
the copy is finished, the Macintosh will ask you to insert the MacTools 
disk so that it can reload this information. If you were copying a disk 
other than the Mac Tools disk, you should then choose Eject from the 
Disk menu, and reinsert the disk you want to work with. 

Copy Disk (two-drive) 
To use Copy Disk on a two-drive system, insert the disk you want to 
copy into either drive and, if necessary, click on that disk's window to 
make it the active window. Then choose Copy Disk from the Disk 
menu. MacTools uses both drives when copying disks. If there is no 
disk in the other drive, MacTools will first display a dialog box asking 
you to insert the disk you want to put the copy onto. If this disk has 
never been used, MacTools will begin copying immediately. If the disk 
is already initialized, a dialog box will appear asking you to confirm that 
it's OK to completely replace the old information with the new. 

To speed up copying, MacTools makes use of as much memory in the 
Macintosh as possible by "purging" everything it doesn't need. If you've 
copied a disk other than the MacTools disk, the Macintosh will ask you 
to insert the MacTools disk so it can reload the purged information. 
You should then choose Eject from the Disk menu, and reinsert the 
disk you want to work with. 
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Rename Disk 
To rename a disk, insert the disk and choose the Rename Disk option 
from the Disk menu. A dialog box appears asking what you want to 
name the disk. The current name of the disk is also shown. 

Please enter the new name: 

OK ( cancel) 

You can either type in a whole new name, or edit the current name 
using the Macintosh mouse features. (If you change your mind and 
don't want to rename the disk, you can click the Cancel button.) When 
you've finished entering the name, either press Return or click on the 
OK button. The disk will be renamed to the new name. 

ViewEdit Disk and Undelete Files 
The ViewEdit Disk and Undelete Files options are described in a later 
section of the manual. 

Eject Disk 
As described earlier, there are three ways to eject a disk: choose Eject 
from the Disk menu, click the close box for the disk window, or hold 
down the command (cloverleaO key and type the letter "e." 

Create New Folder 
The Create New Folder option allows you to create a folder on an HFS 
disk. ([his option is disabled for MFS diskettes, because MFS disks 
don't have real folders!) A dialog box appears asking what you want to 
name the new folder. 
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Please enter the name for the new folder: 

/1'14 iii IN a i4 
OK [oncel 

You can either type in a whole new name, or edit the current name 
using the Macintosh mouse features. (If you change your mind and 
don't want to create the folder, you can click the Cancel button.) When 
you've finished entering the name, either press Return or click on the 
OK button. A folder with the specified name will be created on the 
disk. 

Open Folder 
There are three ways to open a folder on an HFS disk. 

• Click on the folder name and select Open Folder from the 
Disk menu. 

• Click on the folder name, press and hold command (cloverleaf) 
key and press the "0" key. 

• Double-click on the folder name. 

The disk window will be updated to show that you have a folder open, 
and it will display information about all the files and folders contained in 
the folder just opened. 

Remember that for HFS disks, a box appears around the title at the top 
of the window. If you are done looking at the information for the folder 
and you wish to see the information from the previous folder or from 
the main volume, move the mouse pointer inside this box and press 
and hold the mouse button. You will see a pull-down menu appear, 
showing the names of all the folders you opened to get to the one you 
are currently displaying. Here is an example: 
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;;0 CSlFunny Pies 

~ Amt. Us.d: 109K CSlMaePaint Does 10K 

Siz. Ham. ~ Write/Paint Disk I Prtct Lckd Inyis 

fQ 
You may select what previous folder to display by using the standard 
Macintosh menu selection features. The information for the folder you 
select will now be in the window. 

Tree Display 
Tree Display is a new MacTools option that enables you to see the 
organizational structure of your HFS volume in a "tree" display. You 
can make changes to that structure by moving folders. The Tree 
Display example shows folders at five hierarchy levels. You may have 
more or less levels depending on your volumes. 

0 I ~ Write/Paint Disk I 
~ Amt. Us.d: 104K Amt. Fr •• : 675K 

LMa.paint D ••• LFunny Pi., 

Old Pics 

Ma ..... m ... - -Meeti"'l no ... fTy Meeli ... -Project ov ... 

June Meeli ... 1Phone Prob ... 

The Big Move 

Topics for ... 

May Meeti ... 

-Personal Info 

-Phone Lists 

K;11 IQ 

The Tree Display screen shows the following information: 

• Lock icon: 
Displays whether or not the volume is write-protected. 

• Amt. Used: 
Displays how much space on the volume is used. 
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• Amt. Free: 
Displays how much space on the volume is available. 

To start the Tree Display: 

1. Select the Tree Display command from the Disk menu. 

The first Tree Display screen highlights the top level of 
hierarchy (your hard drive's name) in the upper-left comer of 
the display. 

2. Use the horizontal scroll bar to view more hierarchy levels, if 
any. 

3. Use the vertical scroll bar to view other folders at the level 
currently being displayed. 

To move a folder to another folder on your hard drive: 

Note: You cannot drag the selected folder to a location that 
is not another folder. You must move the folder to another 
folder. 

1. Click and hold the mouse button on the folder to select it. A 
dotted outline of the folder appears. 

2. Drag the selected folder to the new folder. 
MacTools highlights the folder as you drag it over the top of 
the destination folder. This helps you determine the correct 
destination folder. 

3. Release the mouse button to complete the move. 

The selected folder and any folders attached to it at lower 
levels are moved into the new folder. 

Note: If you select a folder and begin dragging it to a new location and 
then decide you don't want to move it, you can drag the folder into the 
white space or outside of the window. This stops the moving 
procedure and the folder remains where it was. 
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To list the contents of a folder: 

1. Select the folder by clicking on it or use the arrow keys to 
move the selection point. 

2. Select the Catalog Display option (Command + T) from the 
Disk menu. 

This option toggles between the Catalog display and the Tree 
display. Notice that the option name changes depending 
upon which display you are currently using. 

Selecting any folder in Tree Display and returning to Catalog Display 
lists the contents of the selected folder. Selecting Tree Display from 
any folder in Catalog Display highlights that folder when the tree is 
displayed. 

File Options 

If you click on one of the files in the window, then choose the File 
menu, you can see what file options are available. 

Selecting Files 

iii Control Disk . Mise 
Uerify Files 
Copy Files 
Rename Files 
Delate Files 

UiewEdit Files 
InfoEdit Files 

When working with the MacTools file options, you first select which file 
or folder you want to work with, then choose the appropriate option 
from the File menu. When you select a file, it is shown as white letters 
over a black bar. There are several ways to select files using the 
Macintosh mouse: 

• To select just one file, click on the desired file with the hand 
pOinter. (It can point anywhere in the line.) 

• To select several adjacent files, press the mouse button and 
drag the hand pointer over those files. 
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• To select additional files, hold down the shift key on the 
keyboard while clicking on the new files. [[his is called shift
clicking.) 

• If you change your mind and want to deselect a selected file, 
then shift-click on that file. Just keep in mind that shift
clicking on a deselected file selects it, and shift-clicking on a 
selected file deselects it. 

• If you decide you don't want to select any files, then click the 
mouse in either the free space in the window below the last 
file or in the file header bar where it shows "Size Name 
Prtct," etc. 

Notice that the File menu is dimmed until you select one or more files 
to work with. This is because you need to select the files before you can 
choose what you want to do with them. 

Verify Files 
Verify Files works much like Verify Disk. (See the Verify Disk discussion 
on bad blocks.) 

To use Verify Files, click on the file you wish to verify and choose 
Verify Files from the File menu. The pointer changes to a wristwatch 
and the disk whirs for a few seconds as MacTools verifies all blocks in 
that file. 

If there are no errors in reading the file, a dialog box appears saying 
"The verify action was successful!" Click the "OK" button to continue. 
If any part of the file is unreadable, a dialog appears giving the relative 
block number of the file (the 3rd block of the file, for example) and an 
error ID number. (Error numbers appear in the Appendix.) You can 
choose to either "Continue" verifying the file, or to "Cancel" the verify 
option. 

If you select a folder to verify, then a dialog will appear asking if you 
really want to verify all files and folders inside the selected folder. Click 
on OK to continue, or Cancel to exit. If you click on OK, the Verify 
Files option will proceed to verify every file and folder it finds inside the 
selected folder. 
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Copy Files 
You can back up individual files with the Copy Ales option. MacTools 
can copy files more quickly than the Finder, and it can copy files that 
are marked as protected. 

To use Copy Files, insert the disk you want to copy files from, select 
the files or folders you want to copy, then choose Copy Files from the 
File menu. A dialog message will then appear asking you to select 
where you want to copy to. Use the options provided to get to the 
destination volume/folder. (If you insert a disk here and the Macintosh 
doesn't respond, try clicking in the scroll bar area of the dialog. This 
should get the Macintosh to "wake up!" and recognize the disk 
insertion. You may then proceed.) When everything looks good, click 
on the Continue button to continue with the copy (or click on Cancel to 
stop the copy process). 

1'01 New Folder I 
L:l Empty Folder 

Select Destination 

~ (g) Write/Poi ••• 
~ 

Eject 

Driue 

(Continue] 

( Cancel] 

When you click on the Continue button, MacTools begins copying the 
selected files, prompting you for disk inserts when and if it needs any. If 
it finds that the file you are copying already exists on the destination 
disk/folder, Mac Tools will display a dialog asking if you want to replace 
the file on the destination disk. If you've asked MacTools to copy 
folders, it will display a dialog asking if you really want to copy all files 
and folders inside the folder. Folders can be copied only onto HFS 
disks. If you select an MFS volume as the destination disk, then 
MacTools will display a dialog telling you that it cannot copy folders to 
that volume, but it will copy any other files you may have selected. 

To speed up copying, MacTools makes use of as much memory in the 
Macintosh as possible by "purging" everything it doesn't need. When 
the copy is finished, the Macintosh will ask you to insert the program 
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disk so that it can reload this information. If you were copying from a 
disk other than the program disk, you should then choose Eject from 
the Disk menu, and reinsert the disk you want to work with. 

Rename Files 
To rename one or more files, select the files you want to rename, then 
choose Rename from the File menu. For every file that you select, a 
dialog box will appear in tum, asking what you want to name each file. 
You can either type in a whole new name, or edit the current name 
using the Macintosh mouse features. If you change your mind and don't 
want to rename this file, click the Cancel button. If you decide you 
don't want to rename any more of the files you've selected, click the 
Exit button. 

Please enter the new name: 

OK ( cancel) EHit 

When you've finished entering the name, either press Return or click 
on the OK button. The file will be renamed to the new name. If there 
are more files to rename, another dialog box will appear for you to 
rename the next file. 

Delete Files 
You can delete one or more files with the Delete Files option. Deleting 
a file from Mac Tools is the same as throwing it in the trash from the 
Finder, then emptying the trash. 

Select the file or folder you want to delete, then choose Delete from 
the File menu. A dialog box will appear, asking "Are you sure you want 
to delete the selected files?" If you click on the OK button, MacTools 
will delete the selected files and folders from the disk. Note: If you 
delete a folder, MacTools will delete any files or folders inside the folder 
before it will delete the selected folder. 

ViewEdit and InfoEdit 
The ViewEdit and Infc;>Edit options are described in a later section. 
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Control Options 

By choosing the Control pull-down menu, you can see what Control 
options are available. 

Quit 

Disk: File Mise 
Transfer To 
Set Startup 

Printer Set Up 
Print 

Quit seQ 

When you're finished using MacTools, use the Quit option from the 
Control menu to quit out of MacTools and return to the Finder. 

Transfer To 
If you want to go from MacTools directly to another application without 
returning to the Finder first, you can use the Transfer To option. Insert 
the disk you want to use. With the MacTools window for that disk on 
the screen, use the mouse to select the application file to go to, then 
choose Transfer To from the Control menu or double-dick on the 
application- file. The application you selected will be opened and run. 

Set Startup 
Whenever you tum on your Macintosh and insert a disk, the disk will 
"start up" an application. With most disks, this application is simply the 
Finder. With the Set Startup option, you can change this so that a disk 
will start up with any application. Simply click to select the application 
file you want the disk to start up with, then choose Set Startup from 
the Control menu. MacTools will make a change to the startup 
information on this disk: The next time you turn on your computer to 
use this disk, the application you selected (rather than the Finder) will 
start up. 

Printer Setup 
This option lets you set up the page size and other options for printing 
in Mac Tools. The most common paper settings are already set. If you 
want to change them, choose Printer Setup and click on the 
appropriate buttons. To save your changes for printing, click on the 
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OK button. If everything was already set up correctly, click on Cancel 
to leave everything as it was. 

I mageWriter v2.6 n 
Paper: @ US Letter o R4 Letter 

OK tt D 
o US Legal 
o Computer Paper 

o International Fanfold ( Cancel) 

Orientation Special Effects: 0 Tall Rdjusted 
o 50 ~ Reduction 
o No Gaps Between Pages 

Print 
The print option allows you to print out a copy of the catalog screen 
(the list of files) to your printer. Insert the disk that you want a printout 
of and select Print from the Control menu. A dialog will appear asking 
whether you want a high quality copy or a normal quality copy. Select 
the options you wish and click the OK button to continue with the 
printout. (Clicking on the Cancel button will abort the print process.) 

I mageWriter 

Quality: 

Page Range: 

Copies: 

Paper Feed: 

@Best 

@RII 

o 
@ Rutomatic 

v2.6 n 
o Faster 0 Draft 

o From: D To: D ( cancel) 

o Hand Feed 

When you press the OK button, another dialog appears telling you that 
MacTools is busy printing out the information. There is a Cancel button 
available if you wish to stop the printer before it is finished with the 
printout. 
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Rm busy printing. 

Press Cancel to eHit. Cancel 

Miscellaneous 

There are two options available in the Miscellaneous menu. 

• Control Disk File 
Select Files 

Install Delete-I nto File 

Select Files 
The Select Files option provides a convenient way to select a number 
of related files with similar names before selecting one of the File menu 
options. For example, suppose you have a disk with the files "Screen 
0," "Screen 1," "Screen 2," etc., and you want to delete these files. 
You can use the Select Files option to select all files that begin with the 
word "Screen." You could also select the files "PICTURE. BAS, " 
"PAYROLL.BAS," and "INVENTORY.BAS" by using Select Files to 
select all files that end in ".BAS." 

To select files by filename, choose Select from the Miscellaneous menu. 
A dialog box will appear: 
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II 
in 

Select the files thot haue the string 
segment: 

First ) port of its name. 

Rny ) 
Last ) RII ) ( Cancel ) 

First type the letters or characters that you want to match with the files 
on the disk. Then click on the appropriate button. If you click "First," 
then every file that begins with the characters you typed will be 
selected. If you click "Any," then every file that contains the characters 
anywhere in the filename will be selected. If you click "Last," then 
every file that ends with the characters you typed will be selected. 

You can click on the "All" button without typing anything to select 
every file on the disk. If you change your mind and don't want to select 
any files, you can click on the Cancel button. 

After you've used the Select Files option to select a number of files, you 
can still shift-dick to select additional files or deselect some of the 
selected files before choosing a Ale menu option. 

Install Delete-Info File 
This option is described in the "About the Delete Tracking Method" 
section. 

ViewEdit 

The ViewEdit options in MacT ools allow you to look at the contents of 
any file or any block on a disk, and make changes to the information if 
you want. This can sometimes be useful for double-checking what is in 
a file before copying it, deleting it, etc. Experienced Macintosh 
programmers will also find ViewEd it a powerful tool for debugging, 
repairing disks with damaged files, etc. 
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The ViewEdit option is easy to use, but much of the information it 
displays is technical in nature. If you want to change the contents of the 
disk (or to better understand what information you are looking at), you 
should be familiar with such things as disk blocks, bytes, hexadecimal, 
and ASCII. 

The ViewEdit option appears in both the Disk menu and the File menu. 
If you want to view or edit any block on the disk, choose ViewEdit from 
the Disk menu. If you want to view or edit a particular file on the disk, 
first select that file by clicking on it with the mouse, then choose 
ViewEdit from the File menu. 

When you choose either ViewEdit option, a new window and a new 
menu will appear. The new menu, titled ViewEdit, contains all the new 
options available to you while using ViewEdit. These options are Read 
Next Block, Read Previous Block, Read Specific Block, Write Block, 
Undo, Resource Fork, and Data Fork. The new window that appears 
displays information about the disk volume or the file that you want to 
look at. The display will be similar to the following: 

-0 Mac Tools 

Volume Name: Mac Tools 
Creation Date: 9F2C Ao05 8/15/88 2:30 PM 
Last Backup Date: 9F49 CAAF 9/6188 5:02 PM 
Attr i butes: 0000 
Number of Fi les: OOOB 11 
Directory Start: 0003 3 
Directory Length: 0000 0 
Allocation Blocks: 063A 1594 
Allocation Blocksize: 0000 0200 512 
Allocation CI ipsize: 0000 0800 2048 
A II ocat i on Start: 0004 4 
Next F i I e Number: 0000 0085 133 
Free Blocks: 0128 296 

Two columns of numbers appear. The first column contains the actual 
values (in hexadecimal) that the Macintosh stores for each item. The 
second column shows the same numbers in (more readable) decimal 
form. This information will usually be of use only to programmers. 
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The usual MacTools file window will still be lurking behind the ViewEdit 
window. Anytime you want to exit the ViewEdit option, just click on 
the Close box in the upper-left comer, or click back in the file window. 

At the bottom of the window is a horizontal scroll bar. If you click on 
the arrow on the right, then a new display will appear, showing the 
contents of the first block in the file or disk. If you drag the white 
SQuare at the bottom, you can move quickly through the entire disk. 

Note: All information on the disk is stored in "blocks." Each block 
contains 512 bytes of data. Therefore it takes two blocks to make one 
"K" of information. A normal 400K disk contains 800 disk blocks 
numbered 0 through 799, while a normal800K disk contains 1600 
disk blocks numbered 0 through 1599. 

o Mac Tools 

8lck: 1241 Part A 
Tags: 0000 0082 8100 0043 0000 0379 
0000: ~79 7465 2062 6C6F 6368 2E20 4966 2079 
0010: 6F75 2063 6C69 6368 206F 6E20 7468 6520 
0020: 7269 6768 7420 6172 726F 7720 6167 6169 
0030: 6E2C 2079 6F75 056C 6C20 7365 6520 7468 
0040: 6520 7365 636F 6E64 2068 616C 6620 6F66 
0050: 2074 6865 2062 6C6F 6368 2C20 5061 7274 
0060: 2042 2E20 4966 2079 6F75 2063 6F6E 7469 

. 0070: 6E75 6520 636C 6963 6869 6E67 206F 6E20 
0080: 7468 6520 7269 6768 7420 6172 726F 772C 
0090: 2079 6F75 056C 6C20 7365 6520 7468 6520 
OOAO: 6669 7273 7420 616E 6420 7365 636F 6E64 
0080: 2070 6172 7473 206F 6620 626C 6F63 6820 
OOCO: 312C 2074 6865 6E20 626C 6F63 6820 322C 
0000: 2065 7463 2E20 5369 6069 6C61 726C 792C 
OOEO: 2063 6C69 6368 696E 6720 7468 6520 6C65 
OOFO: 6674 2061 7272 6F77 2060 6F76 6573 2079 

byte block. If y 
ou c lick on the 
right arrow agai 
n. you. II see th 
e second half of 

the block. Part 
8. I f you conti 

nue c lick i ng on 
the right arrow. 
you. II see the 

first and second 
parts of block 

1. then block 2. 
etc. Simi larly. 
cl icking the Ie 

ft arrow moves y 

Notice the "BIck: 1241 Part A." The window shows the first half (256 
bytes) of the 512-byte block. If you click on the right arrow again, 
you'll see the second half of the block, Part B. By clicking on the right 
arrow, you can move forward through the disk or file a half-block at a 
time. Similarly~ clicking the left arrow moves you backwards through 
the disk or file a half-block at a time. 
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(Note: If you selected ViewEdit from the Disk menu, the block number 
shown is the actual block number on the disk. If you selected ViewEdit 
from the File menu, the block number shown instead tells you how 
many blocks from the beginning of the file this block is, not its real disk 
block number.) 

All of the values in the window (except for the block number) are 
hexadecimal. Each line includes an offset number followed by a colon, 
then 16 bytes from the block (2 digits per byte, shown as 8 groups of 4 
digits each), then those same 16 bytes interpreted as ASCII characters. 
The offset number simply shows how many bytes into the block each 
line is. For example, byte number $10 is the first byte after the 
"0010:" Byte number $11 is the byte after that, etc. 

If words or text appear on the right, then those bytes in the block are 
strings of valid ASCII characters. However, the characters on the right 
will often be meaningless. This means that the bytes are more likely 
part of a program or numeric data area. Any byte which is not a valid 
ASCII character is shown instead as a period. 

You can change any byte in the block by typing either new 
hexadecimal values or new text characters. Notice that the first digit of 
the block is inverse (white-on-black). If you type one or more 
hexadecimal digits (0-9 or A-F), those digits will change and the 
inverse cursor will move to the right. The corresponding text characters 
on the right will also change, depending on what you type. (Feel free to 
experiment. The changes you make are strictly temporary until you 
choose the Write Block option, which is described below.) 

To change bytes somewhere else in the block, move the mouse pointer 
to the digit where you want to start the changes. The pointer will 
appear as a small box. Put the box around the digit, then click the 
mouse button. The inverse cursor will move here, and you can start 
typing new values. 

Similarly, if you want to change bytes by typing new text characters, 
move the pointer over one of the characters in the text area and click 
the mouse. The inverse cursor will move here. Any characters you now 
type will replace those already in the block. (As you type, the 
corresponding hexadecimal values on the left will also change.) 
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The ViewEdit Menu Options 

Read Next Block 

Read NeHt Block 3€N 
Read Preuious Block 3€P 
Read Specific Block 3€B 
Write Block sew 
Undo 3€Z 

..•.•.•.....•..•....•. _-_ ............................................ . 
lh~soun ~ fork :-;n 
On t.~ f (Hi:: :-:U 

This reads the next block from the disk or file. This is equivalent to 
clicking the right arrow of the scroll bar once or twice (since clicking the 
arrow will move by half a block). 

Read Previous Block 
Reads the previous block. 

Read Specific Block 
If you know exactly what block you want to read, then choose Read 
Specific Block. A small window will appear, with a field for entering a 
new block number. Type the number of the block you want to read, 
then click the OK box or press Return. That block will be read. 

Write Block 
To make a change to the disk itself, first read the block, make the 
changes to the block in the ViewEdit window, then choose Write Block. 
Write Block writes the displayed block back to the disk. Be careful in 
using Write Block; bad information written to the disk can make a file 
or the whole disk unusable. 

Undo 
The Undo option simply re-reads the current block from the disk, 
effectively removing any changes you might have made since you last 
read the block. 

Resource Fork and Data Fork 
These are available only if you've chosen ViewEdit from the File menu 
to look at a file on the disk. Some Macintosh files have two parts, 
called the resource fork and the data fork. Other files have a resource 
fork, but no data fork. If the file you're looking at does not have a data 
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fork, then the Data Fork option in the Misc menu will be dimmed. If 
the file has both a data fork and a resource fork, then both options will 
be available. 

When you first ViewEdit a file, MacTools shows you the resource fork. 
You can see a check beside the Resource Fork option. If the file 
contains both forks, you can view either fork by choosing Resource 
Fork or Data Fork from the ViewEdit menu. The check will show you 
which fork you are viewing at any time. As one example, the text of a 
MacWrite document is stored in the data fork of the file (as long as the 
document was stored as TEXT only). If you want to use ViewEdit to 
look at a MacWrite document, be sure to choose the Data Fork option. 
You can then see the text characters on the right as you read through 
blocks of the file. 
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Undeleting Files & Repairing Damaged Disks 

MacTools includes an Undelete Files option to help you recover "lost" 
information from disks. Undelete Files can often recover files that you 
have accidently deleted with MacTools or thrown in the trash from the 
Finder. 

Undelete Files can also recover files from some "damaged" disks. 
These are disks that the Macintosh cannot recognize as readable, giving 
you the "This diskette is unreadable. Do you wish to eject or initialize?" 
alert. 

Mac Tools provides three different undelete methods: 

• Delete Tracking Method. This works with any Macintosh 
HFS disk device, including hard disks. It requires the 
installation of the Delete Tracking INIT in the System Folder 
and running the MacTools "Install Delete-Info File" before it 
can offer undelete protection. 

• Tag Recovery Method. This works with 3.5 inch disks 
(both HFS and MFS), but is not supported by most hard disks. 
The CPS TagFix and the InfoEdit options provide additional 
support for this method. 

• Resource Forks Method. This works with both floppy and 
hard disk volumes. 

Whenever you choose Undelete Files, MacTools finds the most 
effective Undelete methods for that disk, then lets you choose the 
method. 

About the Delete Tracking Method 

Normally, when a file is deleted, the Macintosh destroys all record of 
what kind of file it was and where the file resides on the disk. Without 
this information, recovering an aCCidentally deleted file is usually 
impossible (if tags are not supported). The Delete Tracking method is 
designed to save this information as the file is being deleted, so that the 
file can later be recovered. 

The Delete Tracking approach must be set up before you delete any 
files, for those files to be recoverable later. This method, if it's in effect, 
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"watches over" all file deletes that take place. It saves the important 
information about the file being deleted into a special Delete-Info file 
on that disk. If the file was deleted aCcidentally and needs to be 
undeleted, MacTools can then use the information in the Delete-Info 
file to bring the deleted file back. 

The Delete Tracking method consists of three parts: 

• Delete Tracking INIT. 

• MacTools "Install Delete-Info File" option. 

• MacTools "Undelete Files" option. 

The "Delete Tracking" INIT is a special initialization program that 
provides the actual Delete Tracking capabilities. The Delete Tracking 
INIT only works in the System Folder of your hard disk volume (or any 
disk you use to start up your Macintosh). 

The MacTools "Install Delete-Info File" option, which can be found in 
the "Mise" menu, provides a place for the deleted-file information to be 
stored on a disk. Choosing this option actually places a new file (named 
"CPSDeleteInfo") on the disk. (This file is "inVisible," which means it 
can be seen from MacTools, but not from the Finder desktop.) 

Whenever any file is later deleted from that disk, the necessary 
information from the file is saved into the Delete-Info file. If you want 
to be able to recover files from more than one disk, you need to choose 
"Install Delete-Info File" for each disk. 

MacTools lets you decide how big the Delete-Info file will be, which 
determines how many deleted files it can keep track of. The Delete
Info file always remembers the most recently deleted files. 

Once both the Delete Tracking INIT and one or more Delete-Info files 
are set up, the disk or disks that have the Delete-Info files are protected 
against accidental file deleting. If you do aCCidentally delete one or 
more files and you want to recover them, you can start up MacTools, 
choose the Undelete Files option, see the names of the files that have 
been deleted, and select which of those files you want to recover. 

Using the information from the Delete-Info file, MacTools undeletes 
the selected files, placing them into a new folder called Recovered Files. 
You can then see the files from MacTools, or Quit to the Finder 
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desktop and access them from there. Bther way, you'll probably want 
to move the files out of the Recovered Files folder to a more 
appropriate place. 

Using the Delete Tracking Method 

InstaUation 
This procedure sets the size of the CPSDeleteInfo file. When this 
procedure is completed, all further deletions are tracked by the INIT 
program and saved into the CPSDeleteInfo file. MacTools can then 
use the CPSDeleteInfo file to undelete files. 

1. Make sure that the Delete Tracking program is in your System 
Folder of the disk you want to protect. If it isn't, copy it from 
the program disk. 

2. Start up MacTools. 

For every disk which you want protected with the Delete 
Tracking method, insert the disk if necessary, and click on the 
window for that disk to make it the frontmost (active) window. 
Choose the Install Delete-Info File option from the Mise 
menu. You'll see a dialog similar to the following: 

Please select the amount of disk storage space 
to use for your deleted file information. 

o 5k - room for approH 30 deleted files 
@ 10k - room for approH 60 deleted files 
o 20k - room for apprOH 120 deleted files 
o 40k - room for approH 240 deleted files 
o 60k - room for approH 360 deleted files 

Cancel Install ~) 

The bigger you make the Delete-Info file, the more deleted 
files it can keep track of. However, a bigger Delete-Info file 
also takes up more space on the disk, space which could have 
been used for other files. In most cases, you probably won't 
need a Delet~-Info file bigger than 20 K, unless you expect to 
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be deleting large numbers of files at a time. 

Select the size of Delete-Info file you want, then choose 
Install. A file named "CPSDeleteInfo," of the size you've 
chosen, will be added to the disk. 

3. Whenever you want the Delete Tracking method to be in effect, 
be sure to start up from a hard disk or disk that has the Delete 
Tracking INIT in its System Folder. Below the "Welcome to 
Macintosh" message, you'll see another message in its own 
box: "Delete Tracking installed." When you see this, the 
Delete Tracking method is in effect. 

Undeleting a iIle: 
This recovers a file that has been accidentally deleted. 

1. Start up MacTools. Insert the disk if necessary, and click on the 
disk's window to make it the frontmost (active) window. 
Choose Undelete, Files. You'll see a dialog similar to: 

Please select the undelete 
method to use. 

Delete Tracking Method 

Tag Recouery Method 

Resource Forks Method 

Cancel 

Note: If the "Delete Tracking Method" button is greyed out, 
which means it cannot be chosen, that means that there was 
no CPSDeleteInfo file on the disk, and the deleted files cannot 
be recovered by this method. 

2. Click on the Delete Tracking Method button. After a few 
seconds, another dialog will appear: 
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Delete Tracking Method 
Please select the files you wish to undelete. 

File Size Recoverable Date 
<$ I'/irror 1.2.51( NO Fri.. Sap!? / 90lf ~ 
<$ Mirror 12K Thu, Sep 8, 1988 
D 
<$ 
<$ 

Mi rror.A.perts OK Thu, Sep 8, 1988 
I'/irror 1.21( NO Thl~. Sap l(. 1988 
I'/irror 1.21( NO fJ/a~ Sap,~ / gelf 

Cancel ( (onUnu.~ Select nil ) 

This dialog shows all of the files that have been deleted while 
the Delete Tracking method was in place. Each line shows: 

• Whether the file was a document or an application 
• The name of the file 
• The size of the file. 
• The last modified date of the file before it was deleted 
• Whether or not the file is recoverable 

Note: If a deleted file is not recoverable, the entry is shown in 
italics and a NO appears in the Recoverable column. This 
means that other files have been saved on the disk (or have 
changed size) since this file was deleted, and the new files 
overwrote some or all of the contents of the deleted file. This 
deleted file cannot be recovered. 

If many files are listed, but not the one you wanted, it may be 
that the Delete Info file was not big enough to hold all the files 
you've deleted. The Delete Info file always keeps track of the 
most recently deleted files, for as many files as it can keep 
track of at anyone time. 

3. Using the mouse, select the files you want to recover, then 
click on the Recover button to proceed. MacTools will recover 
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these files, placing them in a new folder called Recovered 
Files. (If the Recovered Files folder already contains a file with 
the same name as one of the files you've selected, it will 
append a 001,002, etc. to the end of the name to make a 
unique name.) 

The Undelete is now complete. You can use MacTools to see the 
contents of the Recovered Files folder, to show that the files have been 
recovered. Using either MacTools or the Finder desktop, you can move 
these files into other folders if you want. If you've undeleted a large 
number of files, it may take the Finder a few seconds the first time to 
rearrange the desktop to accommodate all these new files. 

The next time you choose Undelete Files, you'll notice that the files 
you've already recovered are no longer listed in the Undelete Files 
display. Mac Tools always "cleans up" the Delete-Info file after every 
Undelete. 

About CPS TagFix 

A file on the program disk, named "CPS TagFix," fixes two problems 
with 3.5 inch disks on Macintosh computers: (1) unreliable tags which 
interfered with file recovery, and (2) slow disk access in the upper drive 
of the Macintosh SEe The CPS Tag Fix file should be copied to the 
System Folder of a hard disk or any startup disk. Whenever the 
Macintosh is started up, the system will "see" the CPS TagFix file in the 
System Folder and install its features, fixing the problems. 

Disk "tags" are a feature of the Macintosh which provide for more 
reliable recovery of aCcidentally deleted files and some damaged disks. 
Tags are a few bytes of information associated with each block on a 
disk, describing which part of which file this block belongs to. The 
MacTools Undelete Files option reads this tag information from each 
block on the disk to help recover deleted files. 

Unfortunately, tags written by a Macintosh 512E or Macintosh Plus 
(both with" 128K ROMs") are unreliable. This has prevented the 
MacTools Undelete Files option (and other disk recovery programs that 
rely on tags) from working correctly. 

CPS TagFix corrects this problem. When CPS TagFix is installed at 
system startup, it "patches" the Macintosh disk routines so that all files 
written to the disk have correct and reliable tags. If these files are later 
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accidentally deleted, the MacTools Undelete Files option can recover 
them. 

CPS TagHx also corrects a problem on a Macintosh SE with two 
internal drives. Without the fix, the upper drive on a Macintosh SE runs 
more slowly and more nOisily than it should. This difference can be 
noticed easily by starting up the Macintosh first from a disk in the lower 
drive, then restarting again with the same disk now in the upper drive. 
The upper drive makes about twice as many "noises" as the lower drive 
and it takes a few seconds longer to start up. This problem occurs 
during practically all disk accesses to the upper drive. 

CPS TagHx, when installed in a Macintosh SE, makes a patch to fix 
this problem, allowing the upper drive to work at a normal speed. 
(Apple might provide their own fix to the SE upper drive in a future 
release of system software. CPS TagHx is designed to "respect" other 
system patches. If it finds another patch already installed, it does not 
install its own patch, so there will be no conflict.) 

Using CPS TagFix 

To get the benefits of CPS TagFix (reliable disk tags on a MaCintosh 
Plus or enhanced 512K Macintosh so you can later recover accidentally 
deleted files, and faster disk access on the upper drive of a Macintosh 
SE), you should copy the file "CPS TagFix" from the program disk into 
the System Folder of any disk (or hard disk) you use for starting up your 
Macintosh. Then, anytime you start up with that disk, the CPS TagFix 
features will automatically be installed. On a Macintosh Plus or 
enhanced 512K MaCintosh, below the "Welcome to MacintoshU 

message you'll see another message in its own box: "CPS TagFix 
installed." If you're using a Mac SE with two internal drives, you'll 
instead see "CPS SE upper drive fix installed. U 

(Note: If your startup disk is an MFS disk, CPS TagHx does not have to 
be in the System Folder. It just needs to be copied onto the MFS disk. If 
your startup disk is an HFS disk, CPS TagHx must be in the System 
Folder in order to be installed at system startup.) 

(Another Note: On a Macintosh II, Macintosh SE, or unenhanced 512K 
MaCintosh, you won't see the message "CPS TagFix installed,U 
because the tag patches that CPS TagFix makes are not needed, and 
not made, on these computers. Disk tags are already correct.) 
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To fix the tags on your existing disks, make sure CPS TagFix has been 
installed, then copy all the files onto new initialized disks from the 
Finder desktop or use the Copy Files option in MacTools. (Don't use 
the Copy Disk option to make the copies.) The copies made will then 
have correct tags. 

About the Tag Method 

Whenever a file is deleted, the record of the file in the disk's directory is 
removed. Fortunately, the Macintosh marks each block with a tag, as 
described above. If CPS TagFix has been installed and the tags on a 
3.5 inch disk are correct and reliable, the MacTools Undelete Files 
option can be used to recover files that have been deleted from the 
disk. (Undelete Ales can also recover files from any hard disk that 
correctly supports tags. Unfortunately, tags are not supported on most 
hard disks.) 

For most kinds of files, the Macintosh also leaves behind a little 
additional "scavenging" information as part of the file itself. MacTools 
finds this scavenging information for every deleted file that has it, to 
provide the correct filename and other useful information about the file. 
A few kinds of data files do not have this scavenging information, and 
undeleting these files takes a little more work on your part. 

When you choose Undelete Files from the Disk menu then choose the 
Tag Method, MacTools reads all of the tags on the disk and pieces 
together information about all the deleted files. The names of all or 
most of the deleted files are then listed for you to choose from. (For the 
few types of data files that do not have "scavenging" information, the 
name of the deleted file is not available.) You can then select which of 
the deleted files you would like to recover. (Note: If you try to Undelete 
Files from a volume that does not support tags, MacTools will inform 
you that the volume doesn't support tags and an Undelete cannot be 
done.) 

MacTools will also ask you where you want to store the files it 
undeletes. MacTools does not undelete "in place"; it instead copies the 
files being recovered onto another volume. Nothing is written back to 
the original disk, which is especially helpful if you're having some 
problem with the disk and want to also try other methods for recovery. 

If the name of the deleted file was known, MacTools gives the new 
recovered file that same name. (If a file of the same name already exists 
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on the destination disk, MacTools adds a number to the recovered file, 
such as SAMENAMEALEOO 1.) If the scavenging information was not 
available for this deleted file, MacTools assigns a new filename to the 
recovered file, such as RECOVEREDFILE001, etc. This is done for 
each deleted file you've selected to recover. If the original disk has a 
large capacity or contains many deleted files, the entire process may 
take several minutes. 

Most recovered files will be ready to use at this point. Recovered files 
for which there was no scavenging information need a little more help 
before they can be used. MacTools includes an InfoEdit option for you 
to determine and fill in this miSSing information. 

Using the Tag Method 

To use the Tag Method of Undelete Files, make sure the disk or volume 
you want to undelete files from is the frontmost (active) window, then 
choose Undelete Files from the Disk menu. You'll see a dialog similar 
to: 

Please select the undelete 
method to use. 

Delete Tracking Method) 

Tag Recouery Method) 

Resource Forks Method) 

cancel) 

Choose the Tag Method. (If the "Tag Method" button is greyed out, 
which means it cannot be chosen, that means this disk device does not 
support tags, so the Tag Method will not work.) 

MacTools will begin looking on the disk for deleted files. This part will 
take less than a minute for 3.5 inch diskettes, and several minutes for a 
hard disk. (You can click on Cancel if you need to stop.) MacTools will 
then display a dialog asking you to select which files you wish to 
undelete: 
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Tag Recovery Method 
Please select the files you wish to undelete. 

File Size Recoverable Date 
Simple letter 3.5K 3.5K Wed, May 20, 1987 
Birthday 29K 29K Wed, May 20, 1 987 
Let ter to Mom 21.5K 21.5K Wed, May 20, 1987 
$00000014 4K 4K Inva11d Date 
$00000013 5.5K 5K Invalid I nva 11 d Date 
Simple and Quick ... 3K 3K Wed, May 20, 1 987 
$00000011 5K 5K I nva 11 d Date 
DeskTop lK 1K Wed, May 20. 1987 

Cancel Select nil ~ 

The information shown in the dialog helps you determine which file or 
files you want to undelete. For most files, the actual filename will be 
listed. (If you had ever renamed the file, be careful: The original name 
of the file, not the "renamed" name, will usually be listed here, simply 
because of the way the Macintosh recorded this scavenging 
information.) 

~ 

10 

If the name of the file could not be determined (scavenging information 
was not available for this type of data file), the file's hexadecimal file 
"number" is listed instead. This file number is helpful, for instance, if 
the file you want to undelete was created just recently. The Macintosh 
assigns a unique number to every file ever stored on the disk; the larger 
the number, the more recently the file was created. [[he Undelete 
display shows all of the deleted files sorted by file number, by how 
recently they were created, whether the filename or file number is 
listed. The most recently created files are at the beginning of the list.) 

The Size column shows how big the file was, and the Recoverable 
column shows how much of the file is still actually recoverable. (If other 
files have since been saved on the disk, a portion of the deleted file 
may have been overwritten with a new file.) If the Recoverable value 
does not equal the Size of the file, then the word "Invalid" will appear 
as an indication that not all of this file can be successfully recovered. 
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The actual date shown in the Date column depends on a couple of 
things. On MFS disks, the date the file was last modified is prOvided in 
the tag information which MacTools reads from the disk. On HFS 
disks, this date is not available in the tags. So ... if the tags contain a 
valid modified date for this file (if the disk is MFS), that date is listed in 
the Date column. Otherwise (the disk is HFS), if MacTools has listed 
the filename for this deleted file (which means the scavenging 
information is available), then the date this file was created is also 
known to MacTools, and that date is listed in the Date column. If 
neither date is available, then the phrase "Invalid Date" is shown 
instead, because no date is available for MacTools to list. 

Select the files you wish to undelete, or click in the Select All button to 
select all the deleted files. Then click on Continue. MacTools will read 
and organize the deleted file information from the original disk. (This 
may also take several minutes for a hard disk.) Another dialog will then 
appear, this time for you to select which disk/volume/folder you want 
to save the recovered files to. Follow the usual Mac methods to select 
the destination, then click on Continue. MacTools will write the 
recovered files onto the disk you've selected. 

For the recovered files that have the correct names (for which there 
was scavenging information), recovery is complete, and the files are 
ready to use. 

About InfoEdit 

For files named RECOVEREDFILEnnn (data files that didn't have the 
special "scavenging" information), MacTools needs a little help from 
you. The Macintosh system requires that two additional pieces of 
information be supplied about each file. These are called the file 
"TYPE" and the file "CREATOR." 

The Type and Creator are used by the Finder Desktop to help 
determine which icon to display, and to match a document file with the 
application that it belongs to. An application always has a Type of 
"APPL" and some other 4-letter Creator. The documents made with 
that application will have the same Creator as the application, and 
some other 4-letter Type. 

Whenever you open a document from the Finder desktop, the Finder 
actually looks for an application that has the same Creator value as the 
selected document and a Type of "APPL," and opens that! For 
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example, if you open a MacWrite document, which has a Creator of 
"MACA" and a Type of "WORD," the Finder actually opens the 
MacWrite application, which has a Creator of "MACA" and a Type of 
"APPL." 

The InfoEdit option in MacTools shows you the Type and Creator 
values for any file, and lets you change them if you want. You need to 
use InfoEdit to set the correct Type and Creator fot the recovered file, 
so that the Macintosh will recognize what kind of file it is. 

In order to set the correct Type and Creator for a 
RECOVEREDFILEnnn, you have to know, or guess, what kind of file it 
was. When you selected the file to be undeleted, the Undelete Files 
display gave you some helpful information about the file, such as file 
number (how recently the file was created), size, and date. Once you 
know what kind of file it was, then you can usually determine the file's 
Type and Creator simply by using InfoEdit to look at another file that is 
the same kind of file. (For example, if you know that 
RECOVEREDFILEnnn is a MacWrite document, its Type and Creator 
will be the same as any other MacWrite document you have.) 

Find (or make) another file of the same kind, then select it in MacTools 
and choose InfoEdit. InfoEdit will show you the Type and Creator 
values for that file. Write down the 4-letter values for each. Now cancel 
the InfoEdit, select the RECOVEREDFILEnnn now and choose InfoEdit 
again. Type in the Type and Creator values that you just wrote down 
for the same kind of file. You can also rename the recovered file within 
InfoEdit to something more meaningful. 

One helpful hint is to use InfoEdit to discover the Type and Creator for 
your various files before your data disks are damaged. By doing this, 
you'll be ready when disaster strikes. Here is a table of TYPE and 
CREATOR information for several popular applications: 

DOCUMENT TYPE CREATOR 

MacWrite WORD MACA 
FactFinder FACT NARU 
1st Base lSTD MIST 
Filevision PICB TELO 
MegaFiler MFIL MEGA 
Multiplan TEXT or MPBN PLAN 
ThinkTank TEXT TANK 
MacPaint PNTG MPNT 
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Using InfoEdit 

To use InfoEdit, select the appropriate file and choose InfoEdit from 
the Disk menu. You will see a display similar to the following: 

File Name 

File Type 

File Creator 

OK ) 

Uii4iUiJiji4.111 . miMI 
11111 

11111 

Cancel 

The file name is displayed on the first line. You can give this recovered 
file a new name if you like. This isn't absolutely necessary, but file 
names such as "RECOVEREDFILE001" aren't very informative. 
Undemeath this are two lines labeled "File Type" and "File Creator." 
To their right are the current values. If the file has just been recovered, 
you may see question marks as the current values. If the file has not 
been un deleted , the values shown are correct. If you are recovering a 
deleted file, type in the correct Type and Creator, using capital letters. 
When you are done, select the OK button, and you will be returned to 
the main MacTools display. 

Recovering using resource forks 

This is a new Mac Tools option for repairing damaged disks and 
undeleting files. This option helps you recover "lost" information from 
disks. It can also recover files from some damaged disks. These are 
the disks that the Macintosh cannot recognize as readable, giving you 
the "This diskette is unreadable. Do you wish to eject or initialize?" alert 
message. 

This method for recovering data is different from the "Tag Method" in 
that the Tag method reads the tag for the block and, using that 
information, reconstructs a file. The resource forks method reads a 
block of information and determines if the block is a resource fork. If it 
is a resource fork, this method uses the information inside that block to 
reconstruct a file. 
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The recover using resource forks option can recover files from a disk 
whose directory and/or bit map has been destroyed. It identifies 
resource information and then recovers the file name and deduces 
where the data is stored. The word deduce is used here because it is 
possible that a file's data is not stored in one section on the diskette. 
This new option can get the start of the data, but since the bit map has 
been lost, it must guess where the rest of the data is. In the event of 
such conflicts, recovering using resource forks will recover as much of 
your file as possible. . 

To recover information using resource forks: 

Note: When using this option, make sure the disk or volume 
you want to undelete files from is in the active window. 

1. Select the Undelete command from the Disk menu. 

2. Choose the Resource Forks Me~hod option. 

Mac Tools begins looking on the disk for deleted files. This 
takes less than a minute for 3.5 inch diskettes and several 
minutes for a hard disk. When it's finished, MacTools displays 
a dialog box asking you to select which files to undelete. 
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Resource Fork Method 
Please select the files you wish to undelete. 

File Size Recoverable Date 
~ Mi rror 12K 12K Mon. Aug 22. 1 988 ~ 

cancel) ( [t)nUnUt~ ( Select nil 

The information in the dialog box helps you determine which 
file or files to undelete. 

Note: If you've changed the name of some of your files, the 
new name may not appear in this dialog box. This is because, 
when you change a file name, the Macintosh doesn't always 
update the fork. Instead, the original file name may appear. 

Size: 
The size column shows how big the file was. 

Recoverable: 
The Recoverable column shows how much of the file is still 
recoverable. If other files have been saved on the disk, a 
portion of the deleted file may have been overwritten with a 
new file. If the recoverable value does not equal the size of 
the file value, the word "Incomplete" appears telling you that 
all of the file cannot be successfully recovered. 

Date: 
The date the file was created. The date shown in the display 
depends on a couple of things: 
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On MFS disks, the date the file was last modified is provided in 
the resource fork information which Mac Tools read from the 
disk. 

On HFS disks, the date is not available in the resource forks. 

3. Select the files to undelete, or click the Select All button to 
select all the deleted files. 

4. Click continue. 

MacTools reads and organizes the deleted file information from the 
original disk. When it's finished, another dialog box appears asking 
you to select which disk, volume, or folder you want to save the files to. 

Note: You must recover to a different diskette rather than to the 
original diskette. This protects your original diskette from further 
damage and gives you the option to try another undelete method. 

5. Use the normal Macintosh methods to select which disk, 
volume, or folder you want to save the files to. 

6. Click continue. 

MacTools writes the recovered files onto the disk you've selected. 

Repairing Damaged Disks 

MacTools can often successfully recover files from disks which have 
become damaged and produce the message "This disk is unreadable. 
Do you wish to eject or initialize?" Note: If you also have other software 
tools that might help you recover this damaged disk, you may want to 
use the Copy II Sector Copy option to copy the damaged disk, then use 
the MacTools Mount option on the copy rather than the original. That 
way, the original damaged disk is not changed in any way. 

The recovery process takes a few steps. To attempt recovery, first 
insert the damaged disk (or a copy) while in the MacTools application. 
MacTools will notice that there are problems with the disk, and provide 
a display similar to the follOWing: 
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This disk has problems. Please select 
the option to perform. 

I( Eject )) 

( Mount) 

( Initialize) 

Uiew 

MacTools is now telling you what you already have discovered: this disk 
is dead. But rather than just giving you the option to eject or initialize it, 
two additional options are available, Mount and View. 

The Mount option places a new, "clean" directory on the disk. This will 
make the disk usable but appear to be empty. You will see a window 
for this disk labeled "RECOVERED DISK" and no files. The files are 
still lurking out there on the disk, and can usually be recovered with 
Undelete Files. 

The View option will take you directly to the MacTools sector editor. 
This is for adventurous souls who wish to manually look around and see 
what happened to the diskette. 

You will normally want to choose the Mount option, then choose 
Undelete Files Tag Method as described above to recover the files from 
the disk, placing them onto another disk. {Note that the Undelete Files 
display will show you both the previously "active" files and the files that 
were already deleted on the disk. The information included in the 
display can help you determine which files you want to recover.} 

(If you use the Mount option with the original damaged disk, take note: 
Even after the Mount option is used, the damaged disk may still have 
other problems. We suggest that after you've recovered the files from 
the disk, you choose Format Disk from the Disk menu to re-initialize 
the disk, completely overwriting any old damage. If Format Disk fails, 
then the disk itself is probably permanently damaged and should be 
discarded.) 
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Checklist for Handling Disk Problems 

Trashed File 
You threw the file in the Trash or deleted the file from MacTools. If 
nothing else has been done to the disk, the file can usually be 
successfully recovered. (If other files have been added or changed on 
the disk, part of the file may have been overwritten with new files.) 

1. Choose Undelete Files, then either the Delete Tracking 
Method or the Tag Method. 

2. Select the file you threw away (using the information shown in 
the Undelete Files display to help you identify it). 

3. Click on Continue to undelete it. 

• If the original filename was not available (if it recovered as 
RECOVEREDFILEnnn), then use InfoEdit to set the Type and 
Creator and rename the undeleted file. 

Unreadable Disk 
Inserting the disk at the Finder desktop shows the message "This disk is 
unreadable" or "This is not a Macintosh disk." 

1. Start up MacTools and insert the problem disk. 

2. If a window for the disk correctly appears, then copy all files 
onto a new disk. However, MacTools might say that: 

• You're using an BOOK disk in a 400K drive. 
• You're using an HFS disk in an MFS Macintosh. 
• The disk has problems. If the disk has problems, choose 

Mount, then choose Undelete Files on the mounted disk. Use 
InfoEdit to set Type and Creator for any files named 
RECOVEREDFILEnnn. 

Can't find application 
You try to open a document from the Finder desktop and get the 
message "There is no application to open this document." 

1. Make sure the associated application is available. 
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2. If it is, then the Type and Creator for the document must be 
wrong. 

3. Use InfoEdit to check the Type and Creator for another 
document made by the same application, then set the same 
Type and Creator for the problem document. 

Application can't open iIle 
From within an application, you get a message similar to "Cannot open 
the selected file." 

1. This is usually not recoverable. Either there is a disk error (bad 
block) in some part of this file, or the file itself is okay but 
some information stored in the file is not correct for this 
application. 

2. Use the MacTools Verify Files option to verify the problem 
file. If it detects errors, then one or more blocks of the file are 
bad. 

3. In either case, call the publisher of the application to see if 
they have any helpful hints for recovering the file. 

4. If Verify Files shows any bad blocks for the file, here is a "last 
chance" rescue effort: Use the Copy II Sector Copy option to 
copy the entire disk. 

5. Try using the file from the copy. (This gives you a file that has 
no bad blocks, but may not contain the right information in 
the blocks that had been bad.) 

6. If that doesn't work, then go back to the problem disk. Check 
the size and date of the file and use InfoEdit to note its Type 
and Creator. 

7. Delete the file, then immediately undelete it using the Tag 
Method. If necessary, use InfoEdit to set Type and Creator on 
the recovered file. 

8. Try this recovered file. [fhis gives you a file in which the bad 
blocks were "extracted." The application may not be able to 
tolerate a document with large sections of information 
"missing.") 
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Notes 

The Macintosh is a powerful computer, and along with the power there 
are also a few interesting "quirks." It can be helpful to know what a few 
of these peculiarities are when working with MacTools. 

When running an application such as MacTools, the Macintosh system 
may sometimes discover that it needs some information it doesn't 
currently have, and will eject the disk in the drive and ask you to insert 
a different disk so that it can load this information. After the 
information is loaded, the application will continue running as before. 
The disk swap is done by the Macintosh system, not the application. 
The only drawback is that the application doesn't "know" that a 
different disk is now in the drive, unless it can second-guess when the 
Macintosh is going to want to switch disks. 

Because of this, MacTools may occasionally have one disk window on 
the screen (or no window at all) when a different disk is actually in the 
drive. If this happens, don't worry! If you choose one of the options, 
the Macin tosh is smart enough to ask you to reinsert the disk that 
appears in the window. If the difference between the window and the 
disk in the drive ever bothers you, just eject the current disk then insert 
the disk you want to work with. 

The invisible DeskTop file found on most Macintosh disks was 
discussed earlier. It contains information about the icons, folders, and 
windows that appear when you're in the Finder. If you're using the 
Copy Files option to copy files from one disk to another, don't copy 
the DeskTop file. If you do, you'll lose whatever folders you had on the 
copy disk (If you are using an MFS disk). Use the Copy Disk option 
when you want to copy all files and folders from one disk to another. 

Using Hard Disks 

MacTools can work with files on many hard disks as well as with floppy 
diskettes. To use MacTools with a hard disk, first start up your hard 
disk in its usual way (which with some earlier hard disks is often by 
starting up the Macintosh with a diskette that was supplied with your 
hard disk), then open the MacTools application. You can now copy 
files, rename files, etc., on the hard disk with MacTools. 

(Note: If you "eject" a hard disk volume from MacTools, you can't 
mount that volume again without quitting out of MacTools first.) 
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In some cases, you can use MacTools to back up copy-protected 
applications onto your hard disk. Start up the hard disk and open 
MacTools (as described above). Then insert the application disk in the 
floppy drive and use the Copy Files option to copy the individual files of 
the application onto the hard disk. Don't change the protected, locked, 
or invisible status of any of the files. 

Some protected applications will work just fine when running from a 
hard disk. Others "insist" that the original application disk remain in the 
floppy drive. This is an integral part of the protected program and 
cannot readily be changed. Other applications will simply not work 
correctly, as the methods they use exclude hard disks. The best test is 
to copy the application to the hard disk and give it a try. 
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Introduction to Mirror 

Mirror safeguards your disk from a number of potentially serious 
problems, such as: 

• Disk crashes 
• Disk initialized by mistake 
• Directory infected by virus 
• Files or Folders deleted by mistake 

If Mirror is installed when any of these problems happen, you can 
quickly recover right where you left off. Run the Rebuild portion of 
Mirror, and it faithfully reconstructs the damaged portion of the disk. 
When Rebuild finishes, your hard disk or floppy is back to normal, 
ready for use. 

If a file or folder is accidently deleted, you can use MacTools to recover 
them. (MacTools shares the Delete Tracking INIT program with 
Mirror.) 

How does ~{irror work? 
The Macintosh System uses hidden information to locate, open, and 
close files and applications. Normally, this information is placed on a 
reserved area of the disk. If this area is damaged or corrupted, the 
entire disk can become unusable, despite the files themselves being 
intact. 

This is why a virus can be so devasting; the files themselves are 
unaffected, but the vital links connecting them to the directory structure 
are corrupted or erased by the virus program. 

The same thing can happen if the disk is jostled during a file access; the 
reserved area of the disk can be physically damaged or the data 
corrupted. 

One of the Mirror programs, Delete Tracking, keeps an up-to-date 
reflection of the hidden information on a separate part of the disk. It 
copies everything required by the System, tags it with key bytes, and 
writes it all into an invisible storage file. This storage file is usually at 
least 300K for a 20MB hard disk. 

The Delete Tracking program automatically updates the storage file 
whenever you eject a disk or shut down the Macintosh. You can also 
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manually update by double-clicking on the Mirror icon and selecting 
Run Mirror. 

The storage file can be copied to a floppy disk, providing another layer 
of protection. No matter where you keep it, this file contains all the 
hidden information needed by the Macintosh System: 

• Boot blocks 
• Volume information 
• Bitmap 
• Extent B-Tree 
• Catalog B-Tree 

If your disk ever crashes, the Rebuild program finds the storage file 
amongst the scattered data on the crashed disk by looking for the key 
bytes. (Rebuild will ask for the floppy disk storage file if it can't find one 
on the hard disk.) 

Rebuild then uses the storage file to reconstruct the reserved area of 
the disk. When it finishes, your hard disk is fully restored. 

Note: Although Rebuild fully restores the disk, the files on the disk are 
no more current than the last Mirror update. If you don't use the 
Delete Tracking INIT program to automatically update Mirror, try 
running Mirror at least once a day. 

Recovering Files 
The Delete Tracking program automatically saves information about 
deleted files in a second invisible file. Mac Tools can use this file to 
recover deleted documents or applications. 

This second invisible file occupies about 20K of the hard disk and can 
recover about 120 deleted files. If you want to change the size of this 
file, refer to the MacTools documentation for the Install Delete-Info File 
option. 

System Requirements 

Mirror runs on any of the following machines with System Version 4.2 
or higher: 

• Macintosh 512KE 
• Macintosh Plus 
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• Macintosh SE 
• Macintosh II 

Safeguarding Floppies 
Although Mirror is primarily designed for safeguarding a hard disk, you 
can use it to protect an especially important floppy, provided you 
observe a few restrictions: 

• Mirror only supports the HFS file system, so it cannot be used 
for MFS 400K disks or MFS hard disk volumes. 

• The storage file created by Mirror requires proportionally 
more space on a floppy disk. See the space requirements 
below. 

Space Requirements 
The storage file created by Mirror is invisible; that is, you won't see it 
on the Macintosh desktop. It does require disk space, though: 

• Hard disks have about 1% of their capacity used by the Mirror 
storage file. 

• Floppy disks have about 6% of their capacity used by the 
Mirror storage file. 

MultiFinder ™ 

Mirror is compatible with MultiFinder. When the Start button is 
clicked, though, Mirror retains control of MultiFinder until it is finished. 
When Mirrror finishes, you can switch MultiFinder to other programs. 
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Installing Mirror 

Mirror has three parts: 

• The Mirror application. This should be installed on your hard 
disk, although it will run from a floppy. 

• The Delete Tracking INIT. This should be installed in the 
System Folder of your hard disk if you want Mirror to 
automatically guard your disk. 

• The Rebuild application. This _ should be copied onto a floppy 
with a current System and Finder. Since you'll only need 
Rebuild if your hard disk crashes, you should keep it on a 
bootable floppy (a disk that can start your Macintosh). 

To install Mirror on your system: 

1. Insert the program disk and click on its icon. 
This opens the program disk window. 

2. Drag the Mirror icon and the MacTools icon onto the hard 
drive window. 

3. Drag the Delete Tracking icon from the program disk into the 
System Folder of your hard disk. Do not copy the System 
Folder itself. 

4. Make a backup copy of Rebuild on a floppy disk with a 
System folder. Store the original program disk in a safe place. 
If you ever need to use Rebuild, use the copy, not the original 
disk. 
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Using Mirror 

This section describes how to set up Mirror, choosing a place to save 
the storage file, and using it on a day-to-day basis. 

To set up Mirror (automatic operation): 

1. Double-click on the Mirror icon to launch it from the desktop. 

Mirror 

After a moment, you11 see the main window for Mirror. It has 
three option buttons, a Start button, and a help message box 
at the bottom. 

0 Mirror® 

~ /~ / Please select option and click on Start. 
Mirror 
~ / ~/ 

@ Run Mirror 
o Saue storage file to diskette 

o Create storage file 

( Start ) 
Messages: 

"Run Mirror" will store uolume information 

for euery uolume that has a storage file. 

2. Select Create storage file. 

@ Create storage file 

Start ;J 
3. Click Start. 

You now see a prompt asking where you want the new 
storage file. 
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4. Choose the name of the hard disk you're using. 

Mirror creates a new storage file on your hard disk. This file is 
where the hidden information about the layout of your disk is 
going to be "mirrored. U In the follOwing step, you1110ad in 
this information for the first time. 

When Mirror finishes making the new storage file, it returns 
you to the main menu. 

5. Select Run Mirror. 

6. Click Start. 

Mirror is now saving, or mirroring, all of the hidden 
information into the storage file. If you ever have any trouble 
with your disk, the Rebuild part of Mirror can use this storage 
file to rebuild your disk. 

When Mirror is through saving all the hidden information, it 
returns you to the main menu. 

7. Choose Quit from the File menu. 

8. When you return to the Desktop, select Restart from the 
Special menu. This activates the Delete Tracking INIT. 

From now on, the Delete Tracking INIT keeps the storage file current 
with no further effort on your part. 

Note: As long as you have the Delete Tracking INIT in your System 
File, the storage file is automatically updated every time you eject a disk 
or shut down the Macintosh. 

Manual Updates 

The best time to do a manual update is when you've finished a major 
project. This is similar to doing frequent Saves within an application; if 
anything happens to your disk, there's that much less work to do if a 
failure happens. 

If you use an optimize or compress program on your disk, do a manual 
update after you finish .. 
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If you choose to remove the Delete Tracking INIT from your System 
Folder, you must manually update to get any benefit from Mirror. 
Removing the INIT does speed up the shutdown of the Macintosh; you 
must weigh that convenience against the possibility of forgetting to do 
an update. 

To update manually: 

1. Double-click on the Mirror icon to launch it from the desktop. 

Mirror 

2. Select Run Mirror. 

@ Run Mirror 
o Saue storage file to diskette 
o Create storage file 

Start 

3. Click Start. 
Wait for Run Mirror to finish. 

4. Choose Quit from the File menu, or press Command+Q. 

Copying the Storage File to a floppy disk 

This doubles the protection for your hard disk. If the hard disk is so 
badly disorganized that the storage file is unrecoverable, having the file 
duplicated on a floppy gives Rebuild a last-chance opportunity to 
reconstruct the disk. 

Copying the storage file to a floppy disk isn't something you need to do 
all the time; save it for those important milestones when you want to be 
extra sure that the data is recoverable. 

To copy the storage Iue: 

1. Insert a formatted floppy disk. Double-click on the disk to 
check if it has at least 300K of available space. 
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Storage File t!I 
1 item 474K in disk 311K available 

2. Return to the hard disk. Double-click on the Mirror icon to 
launch it from the desktop. 

Mirror 

3. Select Save storage file to diskette. 

o Run Mirror 
@ Saue storage file to diskette 
o Create storage file 

Messages: Start t\J 
" Sa u est 0 ra g e fil e" will cop y s t 0 ra g e fil e 

off selected uolume to another LJolume. 

4. Click Start. 

Mirror asks where it should look for the storage file. 

5. Select the name of your hard disk. 

Mirror asks where it should copy the storage file. 

6. Select the name of the floppy disk you inserted earlier. 

Mirror copies the storage file onto the floppy disk. When 
Mirror finishes, it returns you to the main window. 

7. Choose Quit from the File menu, or press Command+Q. 
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Rebuilding your hard disk 

Well, the worst has happened. Your Macintosh won't start from the 
hard disk. What now? With the Rebuild part of Mirror, you can quickly 
reconstruct your disk and be up and running. 

Before you start, you need a floppy disk with a System and a copy of 
Rebuild. A disk with a recently updated storage file may tum out to be 
useful, too. 

To rebuild a hard disk: 

1. Start your Macintosh from the floppy disk with Rebuild on it. 

2. Double-click on the Rebuild icon. 

,'\." 
Rebuild 
" \' 

Rebuild 

In a moment, you'll see the Rebuild window. 

Rebuild 

@ Search bad lJolume for storage file. 

o Use storage file on back:up disk:ette. 

@ SCSI uolume: o d(~t~~(.~ 0 o d(w~(.~ .. ~ 
o d(~t~~(.~ l o (hw~(.~ 5 
o d(wh.~ 2 @ Hard Disk: 
o d(wi(.~ ~~ o (hwi(.~ ·1 

@ l n1 (~nwJ touH~r [[j.~e1 ) o l ni (~nwJ Up~H~r 
o Floppy disk:: 

( Rebuild 

Messages: 

3. Select Search bad volume for storage file. 
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4. Select SCSI volume. If you have more than one hard disk, 
select the one where you created the storage volume. 

5. Click Rebuild. 

Rebuild starts to search your hard disk for the storage file. 
This may take a few minutes, since Rebuild has to scan every 
block on the disk for the key bytes. 

If Rebuild cannot find the storage file: 
This is when the floppy disk copy of the storage file becomes 
very important. Here's what to do if this happens: 

a. Click on Use storage file from backup diskette. 

b. Click Rebuild. 

Rebuild prompts for the disk that contains the storage file. 

c. Insert the floppy disk. 

Rebuild reconstructs your hard disk. The file structure may 
not be current since it reflects the state of the disk at the time 
you copied the storage file. 

6. Rebuild finishes reconstructing your disk. Choose Quit from 
the file menu. 

When you look at the desktop, you should see the hard disk 
icon and the name of the disk. Double-dick on the icon to see 
if all the folders are there, particularly the System Folder. 

7. Select Restart from the Special menu. Your Macintosh ejects 
the floppy disk and restarts from the hard disk. 

Your Macintosh and hard disk are ready for use. 

Undeleting Files 

Mirror and Mac Tools can recover files after they are thrown in the 
Trash and emptied out. The Macintosh System doesn't actually erase 
files; it just removes the directory links and frees up the disk space. 
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The Delete Tracking INIT keeps track of the old directory links and disk 
locations, writing this information into an invisible storage file. 

As long as the old files aren't overwritten by new files, they can be 
recovered. MacTools reads the storage file and puts the recovered files 
in a new folder called Recovered Ales. 

To undelete a group of iIles: 

1. Double-click on the MacTools icon. 

MacTools 

MacTools opens a window showing the contents of your hard 
disk. If you have a floppy inserted, you'll see a window for 
that also. If necessary, click on the hard disk window to bring 
it to the top. 

2. Choose UnDelete Files from the Disk menu. 

" Control I nh~ Mise 
Uerify Disk 
rorm~~t Otsk 
CO~~~J rHi-k 
H(~rWHH~ [Hi-k 

UiewEdit Disk 
UnDelete Files 

Create New Folder 
OJHHl r ohh~r ~J('O 

Tree Display 3CT 

This opens a window where you can select the undelete 
method. 
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Please select the undelete 
method to use. 

Delete Tracking Method 

Tag Recouery Method 

Resource Forks Method 

Cancel 

3. Select Delete Tracking Method. 

The files tracked by Delete Tracking appear in a new window. 
The files in normal lettering are recoverable; the files in italics 
are not recoverable. 

De1ete Tracking Method 
Please select the files you wish to unde1ete. 

File Size Recoverab1e Date 
~ /'IilTor 1251( IVO Fr/. Sap Po 19,,9li 
~ t'lirror 12K Thu, Sep 8, 1988 
[) t'lirror.A.parts OK Thu, Sep 8, 1988 
~ /'IilTor I:.:'"'/(' IVO TIJl~. Sap ~ 19,,98 
~ /'J/rror I:.:'"'/(' IVO ~Jlat1. Sap?: 19,,9,,9 

Cancel ( (onttntH~ Select All ) 

. 
4. Select the files you want to recover. 

5. Click Continue. This starts the recovery process. When the 
recovery is finished, MacTools returns to the main menu. 

6. Choose Quit from the Control menu. 
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The new Recovered Files folder on the desktop contains the recovered 
files. 

LJ 
Recovered Files 
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Introduction to Locate 

Locate is a fast and powerful information finder in a desk accessory. 

Even while you're using your favorite program, you can have Locate 
search for a keyword, a filename, or both. It scans your disk, shows 
you the file(s) it found, and the text within the file. You can then copy 
any part of that file to the Macintosh clipboard, search again and 
append more text, and paste all of the text right into your document. 

Locate-scans all of the documents on your disk, looking for a filename 
or keyword. 

System Requirements 

Locate runs on any of the follOwing machines: 

Macintosh 512KE 
Macintosh Plus 
Macintosh SE 
Macintosh II 

MultiFinder™ 

When you use Locate with MultiFinder, you can find a number of 
documents, select the one you want, and launch it. In effect, Locate 
lets you search, find, and double-click a document. 
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Installing Locate 

This procedure shows how to use the Apple FontlDA Mover to install 
the Locate desk accessory in your System file. Once Locate is 
installed, you can access it like any other desk accessory by pulling 
down the Apple menu and selecting it. 

To install the Locate DA: 

1. Double-click on the Locate "suitcase". 

LJjJ 
LocatetM 

This launches Font/DA Mover, an Apple utility program for 
installing or removing desk accessories. 

o Font 
@ Desk Rccessory Mouer 

Locate™ 
on PC Tools DeluHe Help 

12K free 
Close Quit Open ••• 

2. Insert your system disk. 

Note: If you are installing Locate on your hard disk, click 
Open instead of inserting a floppy disk. 
Next, click the Drive button. The name of your hard disk 
should appear on the right side of the screen. 
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3. Double-click on the system folder in the box on the right side 
of the screen. 

4. When the system folder opens, double-click on the System file. 
You should see a display like the one below. Your System file 
is now ready to receive Locate. 

o Font MOlJer 
@ Desk Rccessory 

Locate™ 
on PC Tools DeluHe 

12K free 
Close 

» Copy »~ Chooser 
Control Panel 

RemolJe Find File 
Key Caps 
Locate™ 

67555 bytes Scrapbook 
selected 

Help 

Quit 

System 
on Hard Disk 
1 0075K free 

( Close) 

5. Click on Locate in the left box, then click on »Copy» to 
install it in the System. 

When it appears on the right side of the screen, in the 
System, the installation is complete. 

6. Click on Quit to leave Font/DA Mover and return to the 
desktop. 
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7. Repeat this process for every system disk where you want to 
install Locate. 

Note: If you are using a hard disk, you only need to install 
Locate in the hard disk System. 

There is a maximum of 15 desk accessories in any System file. 
You may have to remove a desk accessory in order to install 
Locate. 
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Using Locate 

Using Locate is simple: enter a filename or one to three keywords, and 
click the Go button. To stop a search, click Stop. When Locate finds 
a file, it shows you the filename, size, type, and date. 

Clicking the filename shows the text within. You can copy or append 
any part of the displayed text to the clipboard. The text in the 
clipboard can then be pasted into any Macintosh document that 
accepts text. 

Finding and copYing text 

This procedure shows you how to locate text in a file, copy it to the 
clipboard, find another file, append the new text to the clipboard, and 
paste the clipboard text into a document. 

To find a file: 

1. Start a program that can accept text: a word processor, a 
page layout program, or even a drawing program. Find a 
place where you can insert a phrase of text. 

2. Choose the Locate command from the Apple menu. 
The Locate window opens. 
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File Name: 

Keywords to 
search for: 

Name Size Kind 

G::::) Hard Disk 

Modified Created 

3. Enter a filename, one to three keywords, or both. A single 
keyword can be any string of characters, including spaces. If 
you use two or three keywords, Locate selects files that 
contain anyone of them. 

Note: If you enter a filename and one or more keywords, the 
And/Or buttons are activated. 

• If you want to restrict the search to keywords found only in a 
certain file, click the And button. 

• If you want to find either a certain file, or certain keywords, 
click the Or button. 
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File Name: 

Keywords to 
search for: 

CJ Hard Disk 

Name Size Kind Modified Created 

D Backup of Locate 8K WDBN Thu, Aug 11 , 1988 Thu, Aug 11,1988 

D Backup of MacTool.. 99K WDBN Thu, Aug 11 , 1988 Tue, Ju112, 1988 

D HD 68K WDBN Tue, Aug 2,1988 Tue, Ju112, 1988 

D Locate 9K WDBN Fri, Aug 12, 1988 Thu, Aug 11, 1988 

4. Click the Go button (the running man icon) or the Return key. 

While it searches, Locate displays the following information on 
the bottom line of the display: 

• The name and size of the file being searched. 
• A running total of the files (by file icon) and folders (by folder 

icon) searched. 
• A thermometer that indicates the percentage of disk searched. 
• A blinking box that indicates a search in progress. 

Locate lists files as it finds them. Without stopping the search, 
you can view the contents of the files by selecting a filename. 
If you want Locate to continue searching while you do 
something else, click another window. This puts Locate in the 
background. Click the Locate window to put it in the 
foreground again. 

If you want to stop the search, click the Stop button or press 
Command+period. To restart the search from the beginning, 
click Go. 
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File Name: 

Keywords to 
search for: 

c::l Hard Disk 

Locate searches for the string and displays running total information (described above.) As 
it searches, Locate display s information about each file whose name contains the string 
that matches the search parameters (see the screen be low.) If the Mil'" is active, you 
can scro n the window containing the file names while the search continues, or after its 
completion. 

5. Select a filename by clicking on it. The text window now 
shows the text within the selected file. 

The first occurrence of the keyword is highlighted in the text 
window. You can scroll the window if the scroll bar is active. 

To copy and append text to the clipboard: 

Choosing Copy from the Edit menu replaces the current contents of 
the clipboard with the selected text. Choosing Copy More appends the 
selected text to the end of the text already on the clipboard. 

1. Select the text you want to copy. 

2. Choose Copy from the Edit menu, or press Command+C. 
This puts the selected text on the clipboard, where it can be 
pasted into nearly any Macintosh document. 

3. Choose Show Next Match from the Locate menu to find the 
next instance of the keyword. 
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4. Select the next text you want to copy and choose Copy More 
from the Edit menu. 
This appends the selected text to the clipboard. 

To paste text in a document: 

1. Click the document window, bringing it to the front. 

2. Click on a location in your document where you want to add 
the new text. 

3. Choose Paste from the Edit menu, or press Command+ V. 
The contents of the clipboard are pasted into your document. 

Finding the path to a file 

This procedure shows you how to find a file, then find the location of 
its folder. If you are using MultiFinder, you can then launch the file. 

To find a file: 

1. Choose the Locate command from the Apple menu. 
The Locate window opens. 

2. Enter a filename, one to three keywords, or both. 

3. Click the Go button (the running man icon). 
Locate displays the files it finds. 

4. Select a file by clicking on the filename. 
Locate shows text from the file in the bottom window. 

5. Choose Show Path from the Locate menu. 
When you make this selection, Locate displays the file path in 
the bottom window instead of text. The display starts with the 
current folder on the top, moves down through the folders, 
and ends with the volume name at the bottom. 
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File Name: Ifile eHchang~ 
@and Qor 

~:~~~r~::~ {E~~~~~~~~l = Hard Disk 

a Apple file EHchange folder 
a Apple Utilities 
c:::J Hard Disk 

6. Choose Show Path again. 
Making this selection a second time toggles Show Path off. 
The bottom window now displays text from the selected file. 

7. If you are running MultiFinder, choose Launch Document 
from the File menu. This starts the program that created the 
file. 
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Menu Commands 

Although many of Locate's features can be used by pointing and 
clicking in the main window, Locate gives you additional options in its 
four menus: File, Edit, Search, and Locate. Most of these commands 
can be accessed with function-key combinations, such as Command+C 
for Copy. 

File Menu 

The File menu creates a Match List document that contains a list of 
keyword matches, saves it, or prints it. You can also close the currently 
selected file, move it to the desktop, or launch applications under 
MultiFinder. 

" _ill • .- Edit Search Locate™ 

Close 

Close SCW 
Moue to Desktop SCM 
Launch Document SCL 

Saue Match List... SCS 

Page Setup ••• 
Print Match List .•• 

Quit SCQ 

Unselects the currently selected file. 

Move to Desktop 
Moves the selected file from its current folder onto the desktop. This 
pulls up deeply buried files and puts them where they are readily 
available. 
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Launch Document 
Starts the program that created the selected file. If Locate can't find 
the program, you are given a file dialog and asked to choose an 
application. Pressing the Option key while you choose Launch 
Document bypasses the program search and gives you the file dialog. 

This feature is only active with MultiFinder. 

Save Match List ..• 
Creates a text file listing all matched keywords. Each match shows the 
filename, its path, and several lines of text surrounding each occurrence 
of the keyword. 

If a file is selected, the match list is restricted to that file. If a file is not 
selected, the match list shows all of the files. 

Page Setup .•. 
Sets up the appearance of the match list file before it is printed. 

Print Match List •.• 
Prints a text file listing all matched keywords. Each match shows the 
filename, its path, and several lines of text surrounding each occurrence 
of the keyword. 

If a file is selected, the match list is restricted to that file. If a file is not 
selected, the match list shows all of the files. 
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Edit Menu 

The Edit menu copies and appends selected text to the clipboard, 
where it can be pasted into the current application. The other standard 
editing commands can be used for editing keywords. 

Copy 

" File .:IHI. Search Locate™ 
Undo :-:2 

[ ut :-:H 
Copy 3€C 
Pus1(~ :-:l~ 

[ h~~H' :-:H 

Copy More 
Select RII 3€R 

Copies the currently selected text to the clipboard. Any text previously 
in the clipboard is deleted. 

Copy More 
Appends the currently selected text to the text in the clipboard. Any 
text that is in the clipboard from previous operations is unaffected. 

If the existing contents of the clipboard are graphics, Copy More 
replaces the graphics with the selected text. 

Select All 
Selects all of the text in the current file. 
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Search Menu 

The Search menu controls the way that Locate searches for a file, a 
keyword, or both. 

" File Edit Locate™ 

Search Here ..• 

Search H-e-r-e-•• -. ----3€-H-r 

...... Search Sub-Folders 

...... Search By File Name 

...... Search By Keywords 3€K 

...... Search All Files 
Search Only TeRt Files 

Narrows the search to a folder. When this is selected, Locate asks you 
which folder you want to search. 

Search Sub-Folders 
Searches for sub-folders in the selected volume or folder. Unless you 
specify otherwise, Locate searches every sub-folder in the selected 
volume or folder. 

Unselecting this command noticeably shortens the search time in large 
folders, or in folders containing many sub-folders. 

Search By File Name 
Searches for the partial or full name of a file. Selecting this command 
activates the Filename box in the upper portion of the Locate screen. 

Unselecting this command automatically selects the Search By 
Keywords command and activates the first Keyword box. 

Any time you enter text in the Filename box, Search by File Name is 
automatically activated. If you unselect this command, the filename 
entry temporarily disappears from the box. If you reselect Search by 
File Name, the entry reappears. 

Search By Keywords 
Searches for one to three text strings within a file. This command is 
automatically selected when you unselect the Search By File Name 
command. 
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Search by Keywords is automatically activated by typing in any of the 
three Keywords boxes. If you unselect this command, the keyword 
entries temporarily disappear from the boxes. If you reselect Search by 
Keywords, the entries reappear. 

Search All Files 
Searches for document files, font files, applications, and DAs. Locate 
normally searches all files. 

Search Only Text Files 
Searches everything except applications, font files, and DA's. This 
increases the search speed of Locate. 
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Locate Menu 

The Locate menu controls the path display and skips forward to the 
next keyword match or next file. 

" File Edit Search 
Show Path 3€P 
Show Only Names 

Show NeHt File 3€F 
Show NeHt Match 3€G 
Show Match Number... 3€N 

Show Path 
Displays the folder path leading to the file. Locate displays the 
contents of the selected file when this command is turned off. 

Show Only Names 
Shows only the names of files matching the search parameters. The 
complete file names are displayed in the file window. 

Show Next File 
Selects the file to display next when more than one file is listed. Locate 
displays the file's matching string. 

If you don't select a file to display next, Locate automatically selects the 
first file in the list. If there are no more files, Locate notifies you with a 
beep. 

Show Next Match 
Finds the next match of the keyword within a file. 

If the file contains no more instances of the keyword, Locate jumps to 
the first instance of the string in the next file. If there are no more files, 
Locate notifies you with a beep. 

Show Match Number •.• 
Finds successive uses of the same keyword within the current file. If 
you want to find where a keyword is used for the third time in a file, 
choose Show Match Number ... from the Locate menu, and enter 3 
in the dialog box. Locate skips to the correct place in the file. 
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Appendices 





Appendix A - Track Sector Lookup 

To use this chart, find the block number in the chart. Look to the left 
for the track number and to the top for the sector number. 

400K DISK 

Sector 
Track 0 1 2 3 4 5 6 7 8 9 10 11 

0 0 1 2 3 4 5 6 7 8 9 10 11 
1 12 13 14 15 16 17 18 19 20 21 22 23 
2 24 25 26 27 28 29 30 31 32 33 34 35 
3 36 37 38 39 40 41 42 43 44 45 46 47 
4 48 49 50 51 52 53 54 55 56 57 58 59 
5 60 61 62 63 64 65 66 67 68 69 70 71 
6 72 73 74 75 76 77 78 79 80 81 82 83 
7 84 85 86 87 88 89 90 91 92 93 94 95 

8 96 97 98 99 100 101 102 103 104 105 106 107 
9 108 109 110 111 112 113 114 115 116 117 118 119 
10 120 121 122 123 124 125 126 127 128 129 130 131 
11 132 133 134 135 136 137 138 139 140 141 142 143 
12 144 145 146 147 148 149 150 151 152 153 154 155 
13 156 157 158 159 160 161 162 163 164 165 166 167 
14 168 169 170 171 172 173 174 175 176 177 178 179 
15 180 181 182 183 184 185 186 187 188 189 190 191 

16 192 193 194 195 196 197 198 199 200 201 202 
17 203 204 205 206 207 208 209 210 211 212 213 
18 214 215 216 217 218 219 220 221 222 223 224 
19 225 226 227 228 229 230 231 232 233 234 235 
20 236 237 238 239 240 241 242 243 244 245 246 
21 247 248 249 250 251 252 253 254 255 256 257 
22 258 259 260 261 262 263 264 265 266 267 268 
23 269 270 271 272 273 274 275 276 277 278 279 

24 280 281 282 283 284 285 286 287 288 289 290 
25 291 292 293 294 295 296 297 298 299 300 301 
26 302 303 304 305 306 307 308 309 310 311 312 
27 313 314 315 316 317 318 319 320 321 322 323 
28 324 325 326 327 328 329 330 331 332 333 334 
29 335 336 337 338 339 340 341 342 343 344 345 
30 346 347 348 349 350 351 352 353 354 355 356 
31 357 358 359 360 361 362 363 364 365 366 367 
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400K DISK 

Sector 
Track 0 1 2 3 4 5 6 7 8 9 

32 368 369 370 371 372 373 374 375 376 377 
33 378 379 380 381 382 383 384 385 386 387 
34 388 389 390 391 392 393 394 395 396 397 
35 398 399 400 401 402 403 404 405 406 407 
36 408 409 410 411 412 413 414 415 416 417 
37 418 419 420 421 422 423 424 425 426 427 
38 428 429 430 431 432 433 434 435 436 437 
39 438 439 440 441 442 443 444 445 446 447 

40 448 449 450 451 452 453 454 455 456 457 
41 458 459 460 461 462 463 464 465 466 467 
42 468 469 470 471 472 473 474 475 476 477 
43 478 479 480 481 482 483 484 485 486 487 
44 488 489 490 491 492 493 494 495 496 497 
45 498 499 500 501 502 503 504 505 506 507 
46 508 509 510 511 512 513 514 515 516 517 
47 518 519 520 521 522 523 524 525 526 527 

48 528 529 530 531 532 533 534 535 536 
49 537 538 539 540 541 542 543 544 545 
50 546 547 548 549 550 551 552 553 554 
51 555 556 557 558 559 560 561 562 563 
52 564 565 566 567 568 569 570 571 572 
53 573 574 575 576 577 578 579 580 581 
54 582 583 584 585 586 587 588 589 590 
55 591 592 593 594 595 596 597 598 599 

56 600 601 602 603 604 605 606 607 608 
57 609 610 611 612 613 614 615 616 617 
58 618 619 620 621 622 623 624 625 626 
59 627 628 629 630 631 632 633 634 635 
60 636 637 638 639 640 641 642 643 644 
61 645 646 647 648 649 650 651 652 653 
62 654 655 656 657 658 659 660 661 662 
63 663 664 665 666 667 668 669 670 671 

64 672 673 674 675 676 677 678 679 
65 680 681 682 683 684 685 686 687 
66 688 689 690 691 692 693 694 695 
67 696 697 698 699 700 701 702 703 
68 704 705 706 707 708 709 710 711 
69 712 713 714 715 716 717 718 719 
70 720 721 722 723 724 725 726 727 
71 728 729 730 731 732 733 734 735 

72 736 737 738 739 740 741 742 743 
73 744 745 746 747 748 749 750 751 
74 752 753 754 755 756 757 758 759 
75 760 761 762 763 764 765 766 767 
76 768 769 7.70 771 772 773 774 775 
77 776 777 778 779 780 781 782 783 
78 784 785 786 787 788 789 790 791 
79 792 793 794 795 796 797 798 799 
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To use this chart, find the block number in the chart. Look to the left 
for the track number and to the top for the sector number. 

Note: On 800 K disks, every track has two sides. The first line of the 
track is side A and the second line of a track is side B (see examples on 
tracks 0 through 3). 

800K DISK 

Sector 
Track 0 1 2 3 4 5 6 7 8 9 10 11 
o A 0 1 2 3 4 5 6 7 8 9 10 11 

B 12 13 14 15 16 17 18 19 20 21 22 23 
1 A 24 25 26 27 28 29 30 31 32 33 34 35 

B 36 37 38 39 40 41 42 43 44 45 46 47 
2 A 48 49 50 51 52 53 54 55 56 57 58 59 

B 60 61 62 63 64 65 66 67 68 69 70 71 
3 A 72 73 74 75 76 77 78 79 80 81 82 83 

B 84 85 86 87 88 89 90 91 92 93 94 95 

4 96 97 98 99 100 101 102 103 104 105 106 107 
108 109 110 111 112 113 114 115 116 117 118 119 

5 120 121 122 123 124 125 126 127 128 129 130 131 
132 133 134 135 136 137 138 139 140 141 142 143 

6 144 145 146 147 148 149 150 151 152 153 154 155 
156 157 158 159 160 161 162 163 164 165 166 167 

7 168 169 170 171 172 173 174 175 176 177 178 179 
180 181 182 183 184 185 186 187 188 189 190 191 

8 192 193 194 195 196 197 198 199 200 201 202 203 
204 205 206 207 208 209 210 211 212 213 214 215 

9 216 217 218 219 220 221 222 223 224 225 226 227 
228 229 230 231 232 233 234 235 236 237 238 239 

10 240 241 242 243 244 245 246 247 248 249 250 251 
252 253 254 255 256 257 258 259 260 261 262 263 

11 264 265 266 267 268 269 270 271 272 273 274 275 
276 277 278 279 280 281 282 283 284 285 286 287 

12 288 289 290 291 292 293 294 295 296 297 298 299 
300 301 302 303 304 305 306 307 308 309 310 311 

13 312 313 314 315 316 317 318 319 320 321 322 323 
324 325 326 327 328 329 330 331 332 333 334 335 

14 336 337 338 339 340 341 342 343 344 345 346 347 
348 349 350 351 352 353 354 355 356 357 358 359 

15 360 361 362 363 364 365 366 367 368 369 370 371 
372 373 374 375 376 377 378 379 380 381 382 383 
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800KDISK 

Sector 
Track 0 1 2 3 4 5 6 7 8 9 10 

16 384 385 386 387 388 389 390 391 392 393 394 
395 396 397 398 399 400 401 402 403 404 405 

17 406 407 408 409 410 411 412 413 414 415 416 
417 418 419 420 421 422 423 424 425 426 427 

18 428 429 430 431 432 433 434 435 436 437 438 
439 440 441 442 443 444 445 446 447 448 449 

19 450 451 452 453 454 455 456 457 458 459 460 
461 462 463 464 465 466 467 468 469 470 471 

20 472 473 474 475 476 477 478 479 480 481 482 
483 484 485 486 487 .488 489 490 491 492 493 

21 494 495 496 497 498 499 500 501 502 503 504 
505 506 507 508 509 510 511 512 513 514 515 

22 516 517 518 519 520 521 522 523 524 525 526 
527 528 529 530 531 532 533 534 535 536 537 

23 538 539 540 541 542 543 544 545 546 547 548 
549 550 551 552 553 554 555 556 557 558 559 

24 560 561 562 563 564 565 566 567 568 569 570 
571 572 573 574 575 576 577 578 579 580 581 

25 582 583 584 585 586 587 588 589 590 591 592 
593 594 595 596 597 598 599 600 601 602 603 

26 604 605 606 607 608 609 610 611 612 613 614 
615 616 617 618 619 620 621 622 623 624 625 

27 626 627 628 629 630 631 632 633 634 635 636 
637 638 639 640 641 642 643 644 645 646 647 

28 648 649 650 651 652 653 654 655 656 657 658 
659 660 661 662 663 664 665 666 667 668 669 

29 670 671 672 673 674 675 676 677 678 679 680 
681 682 683 684 685 686 687 688 689 690 691 

30 692 693 694 695 696 697 698 699 700 701 702 
703 704 705 706 707 708 709 710 711 712 713 

31 714 715 716 717 718 719 720 721 722 723 724 
725 726 727 728 729 730 731 732 733 734 735 
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800KDISK 

Sector 
Track 0 1 2 3 4 5 6 7 8 9 

32 736 737 738 739 740 741 742 743 744 745 
746 747 748 749 750 751 752 753 754 755 

33 756 757 758 759 760 761 762 763 764 765 
766 767 768 769 770 771 772 773 774 775 

34 776 777 778 779 780 781 782 783 784 785 
786 787 788 789 790 791 792 793 794 795 

35 796 797 798 799 800 801 802 803 804 805 
806 807 808 809 810 811 812 813 814 815 

36 816 817 818 819 820 821 822 823 824 825 
826 827 828 829 830 831 832 833 834 835 

37 836 837 838 839 840 841 842 843 844 845 
846 847 848 849 850 851 852 853 854 855 

38 856 857 858 859 860 861 862 863 864 865 
866 867 868 869 870 871 872 873 874 875 

39 876 877 878 879 880 881 882 883 884 885 
886 887 888 889 890 891 892 893 894 895 

40 896 897 898 899 900 901 902 903 904 905 
906 907 908 909 910 911 912 913 914 915 

41 916 917 918 919 920 921 922 923 924 925 
926 927 928 929 930 931 932 933 934 935 

42 936 937 938 939 940 941 942 943 944 945 
946 947 948 949 950 951 952 953 954 955 

43 956 957 958 959 960 961 962 963 964 965 
966 967 968 969 970 971 972 973 974 975 

44 976 977 978 979 980 981 982 983 984 985 
986 987 988 989 990 991 992 993 994 995 

45 996 997 998 999 1000 1001 1002 1003 1004 1005 
1006 1007 1008 1009 1010 1011 1012 1013 1014 1015 

46 1016 1017 1018 1019 1020 1021 1022 1023 1024 1025 
1026 1027 1028 1029 1030 1031 1032 1033 1034 1035 

47 1036 1037 1038 1039 1040 1041 1042 1043 1044 1045 
1046 1047 1048 1049 1050 1051 1052 1053 1054 1055 
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800K DISK 

Sector 
Track 0 1 2 3 5 6 7 8 

48 1056 1057 1058 1059 1060 1061 1062 1063 1064 
1065 1066 1067 1068 1069 1070 1071 1072 1073 

49 1074 1075 1076 1077 1078 1079 1080 1081 1082 
1083 1084 1085 1086 1087 1088 1089 1090 1091 

50 1092 1093 1094 1095 1096 1097 1098 1099 1100 
1101 1102 1103 1104 1105 1106 1107 1108 1109 

51 1110 1111 1112 1113 1114 1115 1116 1117 1118 
1119 1120 1121 1122 1123 1124 1125 1126 1127 

52 1128 1129 1130 1131 1132 1133 1134 1135 1136 
1137 1138 1139 1140 1141 1142 1143 1144 1145 

53 1146 1147 1148 1149 1150 1151 1152 1153 1154 
1155 1156 1157 1158 1159 1160 1161 1162 1163 

54 1164 1165 1166 1167 1168 1169 1170 1171 1172 
1173 1174 1175 1176 1177 1178 1179 1180 1181 

55 1182 1183 1184 1185 1186 1187 1188 1189 1190 
1191 1192 1193 1194 1195 1196 1197 1198 1199 

56 1200 1201 1202 1203 1204 1205 1206 1207 1208 
1209 1210 1211 1212 1213 1214 1215 1216 1217 

57 1218 1219 1220 1221 1222 1223 1224 1225 1226 
1227 1228 1229 1230 1231 1232 1233 1234 1235 

58 1236 1237 1238 1239 1240 1241 1242 1243 1244 
1245 1246 1247 1248 1249 1250 1251 1252 1253 

59 1254 1255 1256 1257 1258 1259 1260 1261 1262 
1263 1264 1265 1266 1267 1268 1269 1270 1271 

60 1272 1273 1274 1275 1276 1277 1278 1279 1280 
1281 1282 1283 1284 1285 1286 1287 1288 1289 

61 1290 1291 1292 1293 1294 1295 1296 1297 1298 
1299 1300 1301 1302 1303 1304 1305 1306 1307 

62 1308 1309 1310 1311 1312 1313 1314 1315 1316 
1317 1318 1319 1320 1321 1322 1323 1324 1325 

63 1326 1327 1328 1329 1330 1331 1332 1333 1334 
1335 1336 1337 1338 1339 1340 1341 1342 1343 
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800K DISK 

Sector 
Track 0 1 2 3 4 5 6 7 

64 1344 1345 1346 1347 1348 1349 1350 1351 
1352 1353 1354 1355 1356 1357 1358 1359 

65 1360 1361 1362 1363 1364 1365 1366 1367 
1368 1369 1370 1371 1372 1373 1374 1375 

66 1376 1377 1378 1379 1380 1381 1382 1383 
1384 1385 1386 1387 1388 1389 1390 1391 

67 1392 1393 1394 1395 1396 1397 1398 1399 
1400 1401 1402 1403 1404 1405 1406 1407 

68 1408 1409 1410 1411 1412 1413 1414 1415 
1416 1417 1418 1419 1420 1421 1422 1423 

69 1424 1425 1426 1427 1428 1429 1430 1431 
1432 1433 1434 1435 1436 1437 1438 1439 

70 1440 1441 1442 1443 1444 1445 1446 1447 
1448 1449 1450 1451 1452 1453 1454 1455 

71 1456 1457 1458 1459 1460 1461 1462 1463 
1464 1465 1466 1467 1468 1469 1470 1471 

72 1472 1473 1474 1475 1476 1477 1478 1479 
1480 1481 1482 1483 1484 1485 1486 1487 

73 1488 1489 1490 1491 1492 1493 1494 1495 
1496 1497 1498 1499 1500 1501 1502 1503 

74 1504 1505 1506 1507 1508 1509 1510 1511 
1512 1513 1514 1515 1516 1517 1518 1519 

75 1520 1521 1522 1523 1524 1525 1526 1527 
1528 1529 1530 1531 1532 1533 1534 1535 

76 1536 1537 1538 1539 1540 1541 1542 1543 
1544 1545 1546 1547 1548 1549 1550 1551 

77 1552 1553 1554 1555 1556 1557 1558 1559 
1560 1561 1562 1563 1564 1565 1566 1567 

78 1568 1569 1570 1571 1572 1573 1574 1575 
1576 1577 1578 1579 1580 1581 1582 1583 

79 1584 1585 1586 1587 1588 1589 1590 1591 
1592 1593 1594 1595 1596 1597 1598 1599 
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Appendix B - Byte Encoding Methods 

6&2 encoded bytes 

In this encoding scheme, three normal bytes become four encoded 
bytes. The encoder takes the low six bits of every number and 
performs a lookup in the write translate table to get the byte value to 
write to the diskette. 

The top two bits of every number are rotated into the fourth byte and 
then that fourth 6-bit byte is used to do a lookup in the write translate 
table. 

"c D E" (What you type in.) 

$434445 (The Hexademical value that 
represents those characters.) 

4 3 4 4 4 5 
~ 0011 0 00 0100 0 00 0101 (Same values written 

out at the bit level. ) 

~~~~ 
000011 000100 000101 010101 (After the bytes are 
o 3 0 4 05 $15 re~rouped.) 

These new numbers (all in the range of 0-$3F) are put through the 
write translate table to get the number to store on the diskette. So, in 
our example: 

$03 -> $9B 
$04 $9D 
$05 $9E 
$15 $BA 
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00 96 
01 97 
02 9A 
03 9B 
04 90 
05 9E 
06 9F 
07 = A6 
08 = A7 
09 = AB 
OA = AC 
OB = AO 
OC = AE 
00 = AF 
OE = B2 
OF = B3 

10 
11 
12 
13 
14 
15 
16 
17 
18 
19 

Write Translate Table 
6 and 2 

B4 20 06 
B5 21 = 07 
B6 22 = 09 
B7 23 = OA 
B9 24 = OB 
BA 25 = OC 
BB 26 = 00 
BC 27 = OE 
BO 28 = OF 
BE 29 = E5 

1A = BF 2A = E6 
1B CB 2B = E7 
1C = CO 2C = E9 
10 = CE 20 = EA 
1E = CF 2E = EB 
1F = 03 2F = EC 

30 = EO 
31 = EE 
32 = EF 
33 = F2 
34 = F3 
35 = F4 
36 = F5 
37 = F6 
38 = F7 
39 = F9 
3A = FA 
3B = FB 
3C = FC 
30 = FO 
3E = FE 
3F = FF 

The bytes M and 05 are reserved bytes and should never appear 
inside of the sector data. ([hey are used in address and data prologs 
and epilogs.) 
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Appendix C - Disk Error ID Numbers 

These are the possible Macintosh disk error numbers that can appear 
when using MacTools (usually with the Verify Disk option). These disk 
error numbers are of use only to programmers, and the errors usually 
can only be fixed by reformatting the disk. 

-67 couldn't find valid address mark 
-69 address mark checksum didn't check 
-70 bad address mark bit slip nibbles 
-71 couldn't find a data mark header 
-72 bad data mark checksum 
-73 bad data bit slip nibbles 
-74 write underrun occurred 
-78 tried to read 2nd side on a l-sided disk 
-80 track number wrong on address mark 
-81 sector number never found on a track 
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Appendix D - Number Conversion Tables 

The table below lets you convert between decimal and 
hexadecimal numbers. 

l&.Q ~ ~ ~ ~ Hex 

0 $00 32 $20 64 $40 
1 $01 33 $21 65 $41 
2 $02 34 $22 66 $42 
3 $03 35 $23 67 $43 
4 $04 36 $24 68 $44 
5 $05 37 $25 69 $45 
6 $06 38 $26 70 $46 
7 $07 39 $27 71 $47 
8 $08 40 $28 72 $48 
9 $09 41 $29 73 $49 

10 $OA 42 $2A 74 $4A 
11 SOB 43 $2B 75 $4B 
12 SOC 44 $2C 76 $4C 
13 $00 45 $20 77 $40 
14 $OE 46 $2E 78 $4E 
15 $OF 47 $2F 79 $4F 

16 $10 48 $30 80 $50 
17 $11 49 $31 81 $51 
18 $12 50 $32 82 $52 
19 $13 51 $33 83 $53 
20 $14 52 $34 84 $54 
21 $15 53 $35 85 $55 
22 $16 54 $36 86 $56 
23 $17 55 $37 87 $57 
24 $18 56 $38 88 $58 
25 $19 57 $39 89 $59 
26 $lA 58 $3A 90 $5A 
27 $lB 59 $3B 91 $5B 
28 $lC 60 $3C 92 $5C 
29 $10 61 $30 93 $50 
30 $lE 62 $3E 94 $5E 
31 $lF 63 $3F 95 $5F 
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~ .Hex ~ Hrui ~ H.e.x 

96 $60 128 $80 160 $AO 
97 $61 129 $81 161 $A1 
98 $62 130 $82 162 $A2 
99 $63 131 $83 163 $A3 

100 $64 132 $84 164 $A4 
101 $65 133 $85 165 $A5 
102 $66 134 $86 166 $A6 
103 $67 135 $87 167 $A7 
104 $68 136 $88 168 $A8 
105 $69 137 $89 169 $A9 
106 $6A 138 $8A 170 $AA 
107 $6B 139 $8B 171 $AB 
108 $6C 140 $8C 172 $AC 
109 $6D 141 $8D 173 $AD 
110 $6E 142 $8E 174 $AE 
111 $6F 143 $8F 175 $AF 

112 $70 144 $90 176 $BO 
113 $71 145 $91 177 $B1 
114 $72 146 $92 178 $B2 
115 $73 147 $93 179 $B3 
116 $74 148 $94 180 $B4 
117 $75 149 $95 181 $B5 
118 $76 150 $96 182 $B6 
119 $77 151 $97 183 $B7 
120 $78 152 $98 184 $B8 
121 $79 153 $99 185 $B9 
122 $7A 154 $9A 186 $BA 
123 $7B 155 $9B 187 $BB 
124 $7C 156 $9C 188 $BC 
125 $7D 157 $9D 189 $BD 
126 $7E 158 $9E 190 $BE 
127 $7F 159 $9F 191 $BF 
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Dec Hex ~ .H§x 

192 $CO 224 $EO 
193 $C1 225 $E1 
194 $C2 226 $E2 
195 $C3 227 $E3 
196 $C4 228 $E4 
197 $C5 229 $E5 
198 $C6 230 $E6 
199 $C7 231 $E7 
200 $C8 232 $E8 
201 $C9 233 $E9 
202 $CA 234 $EA 
203 $CB 235 $EB 
204 $CC 236 $EC 
205 $CO 237 $EO 
206 $CE 238 $EE 
207 $CF 239 $EF 

208 $00 240 $FO 
209 $01 241 $F1 
210 $02 242 $F2 
211 $03 243 $F3 
212 $04 244 $F4 
213 $05 245 $F5 
214 $06 246 $F6 
215 $07 247 $F7 
216 $08 248 $F8 
217 $09 249 $F9 
218 $OA 250 $FA 
219 $OB 251 $FB 
220 $OC 252 $FC 
221 $00 253 $FO 
222 $OE 254 $FE 
223 $OF 255 $FF 
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Index 

400K: 
disk: 16, 30-31, 53, 69, 
84 
drive: 70 

6&2encoding format: 148 
800K: 

A 

disk: 3, 9, 16, 30-31, 53, 
69,84 
drive: 11, 15, 69, 70 

accidental file deleting: 111 
And/Or buttons: 130 

B 
block number: 23, 31, 68, 

76, 85-86, 141, 143 
bootable floppy: 114 

C 
clear status: 6 
clipboard: 125, 129, 

132-133, 137 
copy: 4, 6, 11, 13, 15, 

65, 69-70, 77, 80, 108, 
117-118, 125, 129, 133, 
137 

copy protection: 
disks: 53, 69, 109 
files: 60 

Copy Status: 9, 15 
copying: 2, 57, 59 
Creator: 99, 100-101, 

106-107 

D 
damaged disks: 21, 59, 

60, 68-69, 82, 88, 93, 
100-101, 104-105, 111 

data fork: 83, 87 
DeskTop: 60, 65, 108 
Disk Copy: 65 
diskette encoding, 6&2 format: 

32, 148 
double-sided disks: 

(See 800K disk) 
duplicate disk: 1, 6, 15 
duplicate drive: 12 

E 
error ID number: 150 

FG 
filename: 125, 129, 

130-132, 136, 138 
folder path: 140 
Font/DA Mover: 126 

H 
Hard disk installation: iii, 4, 

54, 62, 114, 126 
hexadecimal numbering: 34, 

98, 151 
HFS file system: 60 
HFS volume: 73 

IJ 
invisible file: 59-60, 64-65, 

89, 112 
IWM: 42 
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K 
Keep Track Length: 6, 14 
key bytes: 111-112, 120 
keyword: 125, 129-130, 

132-133, 135-140 

L 
launch: 117, 134, 136 
locked: 64-65 

MN 
MFS file system: 60 
MFS volume: 77 
MultiFinder: ii 3 6 53 61 , " , , 

113, 125, 133-136 
multiple copies: 4, 6-7, 15 

o 
original disk: 2 6 8-9 17 " , , 

22, 29, 56, 69-70 96 
103 ' , 

original drive: 12 

PQ 
paste: 125, 133 

R 
RAM cache: 6,53 
RAM disk: 53 
recovering data: 59, 

88-96, 98-99, 101-107, 
111-112, 121-123 

repairing damaged disks: 59, 
82, 88, 101, 104 

repairing damaged sectors: 21 
105, 107 ' 

resource fork: 83, 87, 88, 
101-103 

S 
sector number: 21, 23, 26, 

31, 37-38, 141, 143, 150 
single-sided disks: 

(See 400K disk) 
storage file: 111-113 

115-121 ' 
sync bytes: 32, 37, 41-43 
Synchronize Tracks: 6, 14 
System: 128 

T 
tag bytes: 30 
text file contents: 136, 139 
track number: 9 13 23-24 

30, 36, 38, i41,' 143, 150 
trash: 121 
~pe: 99-101, 106-107 

U 
undelete: 60, 71, 88-91, 

93-99, 101-106, 121-122 
used space: 64, 73, 91, 113 

V 
virus: 111 
volume information: 112, 119, 

120 

WXYZ 
write-protected: 6, 32, 64, 73 
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COPY II. forlhe Rpple MaC'nlolh. 

~~ 
Or.g.nal Drlva : @Int.rnal 

O bl.rnal 

Oupllcata Or ..... : O lnterna' 

@bternal 

@81ICopy 

O SeclorCopywilhrormat 

O SeclorCopyno rormat 

O 'nct£ditor 

S tart Track :[~J @R 0 B 

End Track : [Z!]O R @B 
Mungu: 1818001( Copy 

I I 
Copy Status 

1 
0 ' 2 J 4 5,"7.' 0' 2 J 4 5. ,. 'I 

~IIIIIIIIIIIIIIIIIIII 

com puter. 5 121'. 
SE or Mac II. Needs a t 
least one SOOK floppy 
d ri ve. supports hard disks. 

• "The program is simple, foolproof, crashproof, idiotproof and most 
importantly, effective~ 
Mac User . 

• "Copy II Hard Disk is extremely easy to use~ 
Mac User. 

• "It may be the copying function that gets you interested in Copy II in 
the first place, but MacTools itself is worth the cost of the software~ 
Compuserve. 

• Fully supports both HFS and MFS! 

• Everything you wanted to know. but were(n't) afraid to ask ... 
Whether you're a novice or an experienced computer buff, you'll find 
your COPY II ' manual easy to read, easy to follow and, most of all, 
easy to understand. 

Important Licens .. Provision : Under the Federal Copyright Act an oW,1('r of a copy of a comput .. r 
program is .. ntitl .. d to make a n .. w copy for archival purr""es only. This product is suppli .. d for la\,\·ful 
purposes only and you are not permitted to use it in violation of Federal Copyright Law or State Soft· 
ware Lic .. nse Enforcement Laws . By breaking this seal and or using this product. you agre .. to lw 
bound by th .. terms of this notice. If you are not willing to comply with this notice. do not break the 
seal. Please imnlediately return this product to us and u:e u.'ill promptly refund your purchase pric{-' . 

Central Point Software. Inc. 
publisher of the bestselling 
COPY II PC for IB M PC and compatibles 
COpy II PLUS for Apple II series 
COpy II for Apple Macintosh ' 
COPY II 64 128forCommodore64 128 

Central Point Soft,,:are. Inc. 
15220 N. W. Greenbrier Pkwy .. " 200 

Beaverton. Oregon 97006 
(503) 690·8090 Sales - Information 

MacTools and Copy II ar .. registered trademarks of Central Point Softwar ... Inc. Appl .. II. Mac dnd 
Macintosh . Commodore 64 128 and IBM PC are trademarks of Appl". Commodore. and IBM. 
respectiwly. 
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